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1

Pathfinder System Overview

The basic Thermo Scientific™ Pathfinder system is a high-performance X-ray energy 
dispersive spectroscopy (EDS) detector with supporting electronics and controlling/analysis 
software installed on a dedicated computer. The optional MagnaRay add-on system is a 
wavelength dispersive spectrometer (WDS) that is fully integrated into the Pathfinder 
software. All Pathfinder detectors can be mounted on a variety of scanning electron 
microscopes. In addition, the EDS detectors can be mounted on transmission (TEM) and 
scanning transmission (STEM) electron microscopes.

Thermo Scientific EDS detectors are available with various crystal sizes. Here are some 
examples:

• UltraDry. Silicon drift detector (10, 30, 60 & 100 square millimeter crystals)

• NORVAR. Ultra-thin windows

• MagnaRay (WDS). Parallel beam wavelength spectrometer with supporting electronics

The Pathfinder software lets you acquire, analyze and quantify X-ray microanalysis data and 
create reports showing the results of your work.

Several advanced options are available, including Stage Control, Beam Current Measurement, 
Analysis Automation, Compass statistical analysis, Drift Compensation, Feature Sizing with 
Chemical Typing, Direct-to-Phase, Phase Analysis, XPhase and Spectral Match.

These hardware options are also available: Synergy mouse and keyboard, Multiple Detectors 
and WDS Automation and Analysis.

For purchasing information, contact your sales representative.

Note  The sections that follow provide a complete list of the optional software and 
hardware available for Pathfinder systems.
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Optional Software
The Pathfinder software includes optional features to enable advanced operations. These 
features will not appear in the software unless they have been purchased and installed.

To obtain any of these software options, please contact your sales representative.

Software Options

• Beam Current Measurement (PF-Beam). Software option for measuring beam current 
automatically and entering the measurement into the microscope parameters. (Can 
include associated hardware if not included with your microscope.)

• Image Filters (PF-Filters). Provides a range of filters that can be applied to an X-ray 
image.

• Spectrum Match (PF-Match). Allows you to identify a spectrum from an unknown 
material by comparing it to a database of previously acquired spectra from known 
materials.

• Quant (PF-Quant). Full standards quantitative analysis. Allows you to use your own 
standards to quantify X-ray data. (Standardless quant, which uses standards stored with 
the software, is always included).

• Quantitative Mapping (PF-Extr-Elem). Allows you to generate maps using quantified 
data, for example in Atomic % or Weight % or K-ratio %. (The ability to generate X-ray 
count maps is always included.)

• Topographical maps (PF-Topo). Allows topographical representation of X-ray maps.

• 3D (PF-Jeol-3D). Ability to collect and process image stacks for 3D analysis.

• Compass (PF-Compass). Allows statistical (principle component) analysis of a spectral 
imaging data set. Includes Direct-To-Phase extraction of phases during acquisitions.

• Phase Analysis (PF-XPhase). Creates phase maps from conventional X-ray maps.

• Drift Compensation (PF-Drift). Automatically corrects for image movement during 
acquisitions.

• Analysis Automation (PF-Auto). Lets you automatically perform repetitive acquisitions 
on large scale analyses without the need for user intervention or input (requires stage 
control).

• Feature Sizing and Chemical Typing software (PF-Particle). Measures morphological 
parameters of particles or features in a sample and determines their chemical makeup.

• WDS Automation and Analysis (PF-WDS). Allows wavelength dispersive spectrometer 
acquisitions and analysis with Pathfinder EDS acquisitions (requires MagnaRay 
spectrometer). WDS software is fully integrated with Pathfinder software.

• 3rd Party Remote (PF-Portal). Remove control from 3rd party software packages.
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Optional Hardware
The Pathfinder system includes optional hardware for enhanced integration or operation. 
These features will not be available unless they have been purchased and installed.

To obtain any of these hardware options, please contact your sales representative.

Hardware Options

• Synergy. Allows control of microscope and Pathfinder software from a single mouse and 
keyboard.

• Multiple Detectors. Two or more detectors controlled by one front end.

• MagnaRay. Allows wavelength dispersive spectrometer acquisitions and analysis with 
Pathfinder EDS acquisitions (requires WDS Automation and Analysis software).

Contact Us

For U.S./Canada technical support, please contact:

For U.S. Technical Support, please contact:

Unity Lab Services
Part of Thermo Fisher Scientific
5225 Verona Road
Madison, WI 53711-4495 U.S.A.
Telephone: 1 800 532 4752
E-mail: us.techsupport.analyze@thermofisher.com

For International Support, please contact:

Thermo Fisher Scientific
Telephone: +1 608 273 5017
E-mail: support.madison@thermofisher.com

© 2002 - 2016 Thermo Fisher Scientific Inc. All rights reserved.
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Software Overview
The Pathfinder software lets you acquire, analyze and quantify X-ray microanalysis data and 
create reports showing the results of your work.

Pathfinder features a common, multi-pane user interface containing a wide assortment of 
analytical views and controls. As you switch analytical modes, the software provides tools to 
assist in your analysis. Data is saved within projects, and the current project’s files for the 
mode you are using are displayed in the file list pane. Data files are easily transportable to 
other microanalysis systems and to graphics, word processing and spreadsheet programs.

Most operations are performed by clicking toolbar buttons. Each analytical mode has an 
associated toolbar that provides the various functions performed in that mode. Some toolbars, 
such as the acquisitions toolbar, are common to all modes.

General, program-wide operations are performed through menu commands or message boxes. 
Menu and submenu entries may be different for each analytical mode.

One Controls Panel provides access to all the setup parameters for each analytical mode.

Depending on the selected analytical mode, other panes may contain an electron image, map, 
spectrum or periodic table to show associations with specific chemical elements.

Figure 1. Pathfinder Spectral Imaging Mode Interface

Image pane Maps pane Controls panel

Element Setup pane Spectrum pane file list pane
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Data are saved and managed within Projects. As you switch analytical modes, the project’s 
files for that mode are displayed in the file list pane in the Controls Panel. Data files are in 
industry standard formats (TIF for images, EMSA (CSV format) for spectra). X-ray maps can 
be saved individually in TIF format.

Start Pathfinder Software
 To run Pathfinder from the Windows™ Start menu

1. Choose Start > All Programs > Thermo Scientific > Pathfinder > Pathfinder.

The Project Explorer window is displayed.

2. Create or select a project folder and choose OK.

The Pathfinder Home screen is displayed in the last analytical mode used.

 To run Pathfinder from the Windows desktop

1. Double-click the Pathfinder icon  on the Windows desktop.

The Project Explorer window is displayed.

2. Create or select a project folder and choose OK.

Toolbars, Status Bar and Buttons
The toolbars, status bar features and buttons available in each analytical mode vary depending 
on that mode's functions. Some toolbars are available only when optional software or 
hardware is installed.

To view a button’s name or function, hover the mouse pointer over the button.

Main Toolbar

The main toolbar is common to all the analytical modes. It contains buttons for general 
functions such as opening and saving projects (through Project Explorer), copying, printing, 
and exporting. You can add and remove the standard buttons on this toolbar and hide or show 
the tool tips.
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Figure 2. Pathfinder Main Toolbar

The main toolbar may be docked or displayed in a floating palette.

• To dock the main toolbar, grab the toolbar by its title bar and drag it to an edge of the 
Pathfinder window. When the toolbar flattens and adheres to the window, release the 
mouse button and the toolbar will dock to the pane.

• To use the main toolbar from a floating palette, drag the toolbar by its edge into any 
visible pane and drop it.

• To close the floating main toolbar, click the X in the title bar.

• To reopen the main toolbar, choose View (menu) > Restore Toolbars.

Status Bar

The status bar along the bottom of the Pathfinder window appears in all analytical modes. It 
provides information about the current acquisition or idle condition and a variety of data 
acquisition settings. The status bar can also include microscope settings if those settings are 
selected for display in the Microscope Parameters and Status Bar Selection box.

Figure 3. Pathfinder status bar

• To display or hide the status bar, from the Home screen, choose View (menu) > 
Status Bar.

• To change the status bar information, choose Edit (menu) > Microscope 
Parameters. The Microscope Parameters And Status Bar Selection box appears. 
Select the features to be displayed in the status bar and choose Close.

Open
Project Explorer Copy

Export to PowerPoint

Save file Print Export to Word

Print 
Preview Close main toolbar

Toolbar options

Export to PowerPoint
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Controls Panel
The Controls Panel contains the tabs, buttons, slider bars and icons to control all integrated 
analytical modes associated with Pathfinder software. The Controls Panel can be hidden or 
displayed using the hide/show button.

Figure 4. Pathfinder Controls Panel

The Controls Panel includes these main features:

• Analytical Mode Toolbar

• Acquisitions Toolbar

• Analytical Mode Setup Pane

• File List Pane

Show/hide Analytical mode 
toolbar

Analytical mode toolbar

Acquisitions toolbar

Analytical Mode Setup pane

file list pane

Setup pane toolbar

Show/hide Advanced View
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Analytical Mode Toolbar

Use the large toolbar at the top of the Controls Panel to select the analytical mode.

Figure 5. Analytical Mode Toolbar

The toolbar is divided into two groups of analyses, Microanalysis and Feature Sizing. 
Microanalysis contains the modes for X-ray data acquisition and analysis. Feature Sizing 
contains modes for measuring, counting and identifying particles.

Microanalysis Modes

There are five analytical modes for the microanalysis technique:

• Spectrum. Performs an X-ray analysis of an area of interest on a sample, including 
element identification and quantification if desired, using a selected detector.

• Point ID. Acquires an electron image. Then lets you specify numbered points and 
areas on the image, and then acquire spectra at those points and areas. Each spectrum 
is stored along with its x, y location on its associated electron image.

• Spectral Imaging. Acquires an electron image. Then lets you acquire a spectrum at 
every pixel in the electron image (The spectra may be acquired at a different 
resolution than the electron image).

These optional features may also be also available:

– Acquire SEM image at same resolution as spectral image

– Acquire WDS image

• Linescan. Acquires an electron image. Then lets you acquire a series of spectra along 
a linescan (vector).

• WDS. Lets you acquire WDS data (quantitative, qualitative and images) using an 
image using an installed parallel beam wavelength spectrometer.

Feature Sizing Mode

Feature Sizing is an optional software module (PF-Particle) that lets you measure, count, and 
identify particles and subparticles (particles touching or surrounded by another particle) of 
interest in a sample.

Show/hide 
Analytical mode 
toolbar
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Acquisitions Toolbar

The acquisitions toolbar is common to all the microanalysis analytical modes. This toolbar 
contains buttons for starting, stopping, and pausing data acquisition for images, spectra, maps 
and line scans. It also includes buttons for editing acquisition settings.

The Drift Compensation. Beam Current, and Automation Analysis controls appear only 
when the optional Drift Compensation, Beam Current measurement and/or Automation 
Analysis software are installed.

Figure 6. Acquisitions Toolbar

Enter
experiment name Setting presets

Set image 
parameters

Select spectrum, 
map or linescan 
parameter set

Automation 
Analysis

Acquire
electron image

Drift 
compensation

Acquire spectrum,
map or linescan

Measure
beam current

Set spectrum, 
map or linescan 
parameters

Stop image 
acquisition

Stop spectrum, map or 
linescan acquisition

Pause
acquisition

Pause 
acquisition

Abort 
acquisition

Abort 
acquisition
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Analytical Mode Setup Pane

The analytical mode setup panel changes with the selected analytical mode. The setup panels 
include all the available processing and display settings for the selected analytical mode.

Use the icons in the toolbar at the bottom of the Setup panel to select a setup tab. The settings 
on that tab are displayed in the space above. The example below shows the settings on the 
Spectrum Settings tab.

Figure 7. Analytical Mode Setup Panel, Spectral Imaging Mode, Spectrum Settings, Typical View

The toggle button in the upper right switches between typical settings and advanced settings. 

The Step Notes button displays step-by-step instructions for the selected analytical mode.

Typical/Advanced 
View toggle

Click to display step-by-step instructions for Spectrum Settings

Click a tab to
display its settings

Spectrum 
Settings
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File List Pane

The file list pane at the bottom of the Controls Panel lists all files in the open project. The file 
types listed depend on the selected analytical mode. Click a filename to view its data.

Figure 8. file list pane

The file list pane includes a panel of file management options described in the table below.

Spectrum Pane
The spectrum pane appears in all the analytical modes except Linescan and shows the most 
recently acquired spectrum. The pane size and location depend on the selected analytical 
mode. If you change the analytical mode, the displayed spectrum remains in the spectrum 
pane until you select a new sample file.

Table 1. file list pane, file management panel

Icon Feature Description

Rename Enables editing of a selected filename

Delete Permanently deletes the selected file

Compare Overlays the selected spectrum with other spectra in the folder 
for visual comparison

Match After running a spectral Match, overlays the original spectrum 
with the best matched spectra from the spectral library for 
visual comparison

Spectra Check Overlays primary spectra with spectral check results (synthetic 
spectrum/background spectrum/residual spectrum) for visual 
comparison)

Information Displays basic information about the selected spectrum, such 
as acquisition date/time, voltage, etc. Click Details to show 
all file attributes for the selected file.

File 
management 
panel
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Use Spectrum Settings on the Controls panel to adjust the appearance of the spectrum pane 
or displayed spectra.

Figure 9. Pathfinder Spectrum Pane Showing Extracted Spectrum in Spectral Imaging Mode

Image Pane
The image pane shows the acquired electron image of the microscope field of view for the 
selected analytical mode and sample. The image pane appears in the upper left portion of all 
the analytical modes except Spectrum mode, which does not use an electron image. It also 
appears in the Feature Sizing Analysis mode. In Spectral Imaging mode, you can perform 
extractions on images for further analysis.

Use Image Settings on the Controls panel to adjust the appearance of the image pane or the 
displayed electron image.
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The features on the image pane toolbar are different for each analytical mode.

Figure 10. Pathfinder Image Pane Showing Electron Image in Spectral Imaging Mode

Maps Pane
The maps pane appears in the upper middle portion of the screen in Spectral Imaging mode 
only. It shows any X-ray maps, COMPASS components, or phase data that have been 
extracted from the electron image.

Use the Element Setup pane to specify which elements will be mapped and assign them 
colors. Use the tools on the image pane toolbar to create the maps.

Micron bar

Image pane toolbar 
for Spectral Imaging 
mode
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Below is an example of the maps for seventeen elements. Each map shows the distribution of 
the associated element over the analyzed region. The map labeled “Grey” in the upper left 
corner of the map pane shows a low-resolution black and white version of the image displayed 
in the image pane. The low-resolution image is acquired simultaneously with the spectral 
imaging data.

Figure 11. Pathfinder Maps Pane Showing Two Overlaid Maps

Element Setup Pane
The Element Setup pane allows you to select elements for automatic analysis in all the 
analytical modes. (Right-click an element to see the available options, or left-click to scroll 
through them.) You can also manually identify elements in a spectrum.

Image pane with two overlaid maps Maps selected for overlay

Mapped element

Low-res grey image
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The Element Setup pane appears in the lower left portion of all the analytical modes. The 
elements are presented in the format of a standard periodic table for easy identification.

Figure 12. Pathfinder Element Setup Pane Showing Periodic Table of Selectable Elements

Adjust the Sizes of the Panes
The Pathfinder Home screen can be customized to suit your preferences by resizing the panes.

To resize a pane, drag its border up, down, right or left.

Hover the mouse cursor over the upper right corner of each pane for additional sizing options. 
For example, the maps pane has these options:

Note  

• Pathfinder software is designed for a wide screen (16/9) monitor. For best viewing, 
maximize the Pathfinder application window.

• Each analytical mode has a different display configuration.

Expand vertically

Expand horizontally

Expand pane to full screen
To reset, click the 
same button a 
second time
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Overview of the Menus
Menu and submenus may change when you select a different analytical mode, or change the 
active pane within a mode. For example, in Point ID, Spectral Image, or Linescan mode, click 
the image pane to show the Image menu on the menu bar. Then click the spectrum pane and 
the Image menu switches to the Spectrum menu.

Menu entries are active (selectable) only when applicable.

Figure 13. Changing Menus Example

Table 2. Overview of Menus

Menu Name Option Function

File Project Explorer... Used to open, create or edit a project and its 
associated files

Close Project Closes the current project

Create Template 
From Project...

Creates a new template from the current project

System Security Password protects project settings and service 
screens from unauthorized changes

Open... Allows you to select a file to open (not a project)

Close Closes the current file

Save Saves the current file under its current name

Save Map File Available for Spectral Imaging mode only. Can be 
used to save an extracted set of maps and their 
element IDs along with the electron image but not 
the associated spectra. Map information is saved 
with the same filename as the original data and a 
.map extension.
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Import/Export Export Image as CSV
Exports an electron image as a Comma Separated 
Values file

Export Image as Bitmap
Exports the electron image as a bitmap file. The 
image is exported exactly as displayed in the image 
pane and at the same resolution.

Export Image as Full-Res TIF
Exports an electron image as a full-resolution TIF 
image

Export Linescan as CSV
Exports the selected linescan image as a Comma 
Separated Values file

Import Gatan File
Allows you to import a Gatan spectral image file. 
Appears in the Import/Export menu only when 
the optional 3rd Party Remote (portal) software is 
installed.

Page Setup... Opens a tabbed series of boxes to define how data 
will be printed for each analytical mode

Compress SI File... Allows you to select a folder of acquired data for 
additional compression, resulting in file sizes that 
are reduced by a factor of 10. (All acquired data 
are partially compressed during acquisition.)

Exit Closes Pathfinder software

Edit Copy Copies image in selected Image, Map or Spectrum 
pane to the Windows Clipboard so it can be 
pasted into other applications. (To select the 
Image, Map or Spectrum pane, click once just 
inside the pane border so that the pane is 
temporarily highlighted.)

Copy To... Used to save image in selected Image, Map or 
Spectrum pane in jPEG (*jpg) format to selected 
folder

Erase All Points In Point ID mode, erases all points on the image 
(before acquisition)

Table 2. Overview of Menus

Menu Name Option Function
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Microscope 
Parameters...

Displays the Microscope Parameters and Status 
Bar Selection box, which lets you set microscope 
parameters and select which settings will appear on 
the Pathfinder status bar

Properties... Opens a tabbed box that contains all the available 
properties for the selected Microanalysis or Feature 
Sizing mode. These are the same property settings 
available in the Controls Panel setup panes.

Language... Allows you to select an available display language 
for Pathfinder software. The default setting 
(Default Operating System Language) displays the 
software in the same language as the Windows 
Operating System software, if that language is 
available.

Set Faraday Cup 
Stage Position...

Sets x, y stage position for the Faraday cup when it 
is on the stage (requires stage automation)

View Restore Toolbars Redisplays the (floating) main toolbar after it has 
been closed

Status Bar Shows or hides the Pathfinder status bar

Drift Diagnostics Displays drift compensation diagnostics window

Attributes Available for Microanalysis Spectral Imaging mode 
only. Displays attributes of the microscope and 
maps of displayed SI data.

Application Look Sets overall color scheme for Pathfinder Home 
screen

Customize Allows you to customize Pathfinder menus and 
toolbars and specify display options for tool tips 
and shortcut keys

Service Mode Allows accesses to user service functions including 
System Configuration, EDS energy calibration, 
and image calibration.

Electron Imaging 
Mode

Used to acquire, save, and load electron image files

Preferences Lets you set user preferences for panels and display 
panes. User preference settings are maintained 
even after Pathfinder software is reinstalled.

Table 2. Overview of Menus

Menu Name Option Function
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Image Return To Stage 
Position

Image menu appears on menu bar when image 
pane is selected in Point ID, Spectral Image, or 
Linescan mode.

Return To Stage Position option moves stage to 
sample location where the currently displayed 
spectrum was acquired (requires stage 
automation). Assumes the sample is still mounted 
on the microscope stage.

Spectrum Remove Escape Peaks Spectrum menu always appears on menu bar in 
Spectrum mode and when spectrum pane is 
selected in Point ID, Spectral Image, or Linescan 
mode.

Use Remove Escape Peaks to toggle any found 
escape peaks on and off for the displayed 
spectrum.

Remove Sum Peaks Toggles any found sum peaks on and off for the 
displayed spectrum

Append Notes To 
Spectrum Label

Adds first line of spectrum notes to spectrum label 
when it is displayed

Element X-Ray 
Lines...

Lets you add or adjust X-ray line energies for 
elements and their relative intensity values for 
known KLM lines

Reference 
Subtract/Add...

Allows peaks in an unknown spectrum to be 
added or removed after performing quantitative 
analysis. Used to ensure all elements have been 
accounted for in the quantification.

Spectrum Math... Lets you perform mathematical operations on 
spectra

 Region Tool... Used to calculate gross, net and ratio values for 
selected elements in a spectrum

Return to Stage 
Position

Moves stage to sample location where previous 
spectrum was acquired (requires stage 
automation). Assumes sample is still mounted on 
microscope stage.

Batch 
Processing

Create Montage Stitches a selection of images, X-ray maps or 
COMPASS components acquired using the 
optional Analysis Automation software so they can 
be viewed together

Table 2. Overview of Menus

Menu Name Option Function
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Spectrum Analysis... Available in Spectrum mode only. Used to perform 
spectral analyses (qualitative, quantitative and 
spectrum match) on a series of selected spectra. 
Results are saved in user-defined file with .csv 
extension.

Linescan Analysis... Available in Linescan mode only. Allows you to 
reanalyze a Linescan data set using the current 
Linescan mode processing settings.

Point ID Analysis... Available in Point ID mode only. Allows you to 
reanalyze a Point ID data set using the current 
Point ID processing settings.

Extract Quant 
Maps...

Available in Spectral Imaging mode only. Allows 
you to automatically extract quantitative maps, 
compass components, or phases from a series of 
spectral imaging files in the current project as 
defined in the Batch Extract Quant Maps settings 
box. Can also be used process a series of files and 
associate them into a tomography data set.

Process Tomography 
Dataset...

Provides a method to combine component or 
phase images into one image. The processing is on 
all slices of a tomography data set.

Specials Displayed menu 
options depend on 
the application

Specials menu appears only when special versions 
of Pathfinder hardware and/or software are 
installed. See the documentation that came with 
your specialized system for details on Specials 
menu commands.

Help Help Topics Displays this Help system for learning Pathfinder 
software

What’s This Displays Help information in the Analytical Mode 
Setup panel. Information is relevant to the selected 
analytical mode.

About Pathfinder... Displays version numbers for Pathfinder software

Table 2. Overview of Menus

Menu Name Option Function
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System Security
Use System Security in the File menu to protect selected Pathfinder features (including data 
acquisition) with an administrator password. This is helpful in a multi-user environment with 
established protocols to ensure that all EDS acquisitions are performed under the same 
conditions. When project templates, acquisition properties and/or service views are protected 
and locked, those system parameters are displayed but cannot be changed by the user.

 To specify a password and select which Pathfinder features to lock

1. Choose File > System Security.

A message prompts for the administrator password.

2. Enter the administrator password (or choose OK for the default password).

In the Security Setup box, select the features to protect, enter and confirm your password 
and choose OK.

Protection options:

• Lock templates. Locks the current project templates for all the analytical modes. 
Project templates remain available for use but they cannot be changed or reset.

Note  Pathfinder software is installed with one user name and no administrator 
password, and all security settings are off. Additional users and passwords may be 
added at your discretion—consult your Windows documentation for more 
information.
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• Lock acquisition properties. Locks the acquisition settings for all the analytical 
modes. Users can view acquisition settings defined in project templates but not 
change them.

• Lock service views. Locks the user service mode (View > Service Mode). Users 
cannot display or change the user service mode settings, which include System 
Configuration, EDS energy calibration, and image calibration)

 To lock the system

1. Choose File > System Security > Lock System.

2. Enter the administrator password and choose OK.

A message indicates the system features that are selected for protection (i.e., templates, 
acquisition settings and service views in the previous example) are locked. (If templates 
and acquisition properties are selected in the System Security Setup box, these features are 
locked for all projects.)

 To unlock the system

1. Choose File > System Security > Unlock System.

2. Enter the administrator password and choose OK.

The system features selected for protection are unlocked. (If templates and acquisition 
properties are selected in the System Security Setup box, these features are unlocked for all 
projects.)

 To remove password protection

1. Choose File > System Security > Unlock System, enter the administrator password and 
choose OK.

2. Choose File > System Security > Security Setup, enter the administrator password and 
choose OK.

3. In the System Security Setup box, clear all the check boxes, delete the passwords and 
choose OK.
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Customize the Pathfinder Interface
The Pathfinder color scheme, toolbars, buttons and background colors can be customized to 
suit your preferences.

Choose Theme

 To change the overall color scheme of the Pathfinder Home screen

1. From the Home screen, choose View > Application Look.

2. Select a color scheme from the submenu.

Customize Toolbars and Menus

 To customize Pathfinder toolbars and menus

1. From the Home screen, choose View > Customize.

The Customize box is displayed.

2. Customize Commands, Toolbars, Menus and Options as needed.
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Set User Preferences

You can select specific colors for borders and backgrounds, border widths and styles and 
whether tool tips are displayed. These settings are maintained even after you reinstall the 
software.

 To set user preferences for the Pathfinder interface

1. From the Home screen, select View > Preferences.

The Preferences box is displayed.

Available options:

• Background. Sets the background color for the Image, Maps, Element Setup and 
Spectrum panes on the Pathfinder Home screen.

– Solid fill. Lets you choose the background color.

– Themed Fill. Uses the selected theme (View > Application Look) for the 
background color.

– Themed Gradient. Uses a gradient version of the selected theme for the 
background color.

• Border. These options affect the color and width of the selection box that shows up 
briefly when you click inside a selectable pane, such as the image, map or spectrum 
pane. Click just inside a pane border to select the pane, for example, to copy the 
pane’s contents to the Clipboard.

– Color. Allows you to define a color for the selection box.
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– Width. Allows you to specify the width of the selection box.

– Show Shadow. Adds a shadow to the displayed image in the image pane and to 
the displayed spectrum in the spectrum pane. 

• controls panel. These options affect only the controls panel at the right side of the 
Pathfinder interface.

– Show text labels on toolbars. Displays or hides text labels below button icons 
on the toolbar in the Analytical Mode Setup pane.

• Periodic Table Options. These options affect only the Element Setup pane in the 
lower left portion of the Pathfinder interface.

– Show Legend. Displays or hides the current color assignments for selecting 
elements for analysis in the periodic table.
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2

Project Management

All Pathfinder data is stored within projects. Each project can consist of several sub-projects. A 
project includes the element lists, identification parameters and acquisition properties from 
the project’s previous use.

When you start the Pathfinder software, Project Explorer appears allowing you to select or 
create a project. When you create a new project, the software automatically creates a new 
project folder.

Figure 14. New project folder

Project settings are stored in a template file in the project folder. The template consists of the 
acquisition properties, periodic table settings (including the history), and the spectrum 
processing setup. Templates are stored with a .tnp extension. A template can be applied to 
other projects.

Temporary data folder

Template file
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When you acquire new data (or process existing data), the data and its associated parameter 
settings are saved in a temporary folder using a base filename and inherit the project’s settings. 
When you create a child project under a parent project, the child project inherits all of the 
parent project's settings.

When you close a project or exit the software, you are asked whether to permanently save any 
unsaved data with the current project. If you choose to save a file with the project, the file is 
moved from the project's temporary folder to the main project folder. The temporary folder is 
then removed along with any non-selected data.

Figure 15. Software message to permanently save data when you close a project

Project Explorer
Similar to Windows Explorer, Project Explorer lets you manage projects and their data files. 
You can create new projects and folders and move (drag) or copy (drag + Ctrl) data files from 
one project to another.

When you start the Pathfinder software, Project Explorer appears allowing you to select or 
create a project.

Use the Properties pane to enter information about the project. Use the Explorer pane for 
project manipulations.

Note  If you are working with data stored in the temporary folder (not yet saved in a 
project) and experience a power failure, the data will be in the temporary folder when you 
restart Pathfinder software.

NOTICE    Always perform data and file manipulations using Pathfinder Project Explorer. 
(Do not use the Windows Explorer.)
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Figure 16. Pathfinder Project Explorer Window

Project Explorer Properties

Use the Reset button to restore the project to the settings used when the project was created.

Note  Right-clicking a folder in the Project Explorer pane brings up a menu containing all 
the Project Explorer File menu and Edit menu commands.

Table 3. Project Explorer Properties Panel Entry Descriptions

Field Name Description

Author Enter your name

Key words Enter any key words to associated with this project to help you 
identify this project using Project Search

Client Enter client’s or recipient’s name if applicable

Due Date Enter a date (typically the project creation date)

Project Template Select an existing project settings template (*.tnp) file, or the 
default template file (default.tnp)

Notes Enter any relevant notes about the project

Project Explorer pane Properties pane
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Project Explorer Menus

You can access the following commands through the File and Edit menus within Project 
Explorer:

File
• New Project (creates a new project folder)
• New Folder (creates a new folder that is not considered a project)
• Open in Windows Explorer (displays project or folder contents in Windows Explorer)

Edit
• Project Search (search all projects for entered key words)
• Remove Project Lock (unlock a project folder)
• Copy (a project or folder)
• Paste (a project or folder)
• Rename (a project or folder)
• Delete (a project or folder)

Project Explorer Toolbar Buttons

You can access the menu commands by clicking these Project Explorer toolbar buttons:
Create a
new project

Create a
new folder

Paste
a project

Copy
a project

Rename
a project

Delete
a project
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Create a New Project
 To create a new project

1. Open the Project Explorer window.

From the Home screen, do one of the following:

• Click the Project Explorer button  on the main toolbar.

• Choose File (menu) >Project Explorer.

2. Select the folder where you want to create the project folder (typically the Documents 
library).

3. Create a new folder by right-clicking the parent folder and choosing New Project from 
the shortcut menu.

A folder named New Project is added to the parent folder.

4. Rename the folder by doing one of the following:

• Click the folder name to enable editing (as in Windows Explorer) and enter a new 
project name.

• Right-click the folder, choose Rename from the shortcut menu and enter a project 
name.

5. Enter the project information in the Properties pane.

6. Choose OK.

The project folder is created under the folder you selected. The name of the new (active) 
project appears in the Pathfinder title bar.

Change to a Different Project
There are two ways to change projects:

• Open Project Explorer (click Project Explorer button  on main toolbar or choose 
File (menu) > Project Explorer).

Locate and select the project you want to open (project folders are green):

• If you know the project folder’s location, navigate to the folder, click it and choose 
OK.

Note  You can also use New Folder in the Project Explorer File menu to create new folders 
that are not considered projects.
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• If you do not know the project’s location, right-click the parent folder and choose 
Project Search. Enter a keyword or select one from the drop-down list and choose 
OK. The project folders that include that keyword are displayed in bright pink. Click 
the desired folder and choose OK.

If there is unsaved data from the previous project, a message asks whether you want to 
save or discard the data. After you respond, the previous project closes and the new 
one opens.

When the new project opens, its name appears in the Pathfinder title bar.

• From the Pathfinder Home screen, choose File > Close Project. If there is unsaved data, a 
message asks whether you want to save or discard the data. After you respond, the 
previous project closes and the software opens Project Explorer. Locate and select a new 
project and choose OK.

Create a New Project Template
You can save the current project settings, including acquisition, processing and quant settings, 
as a template that can be applied to a new project for the same sample type. This saves time 
and ensures consistent experiment setup and analysis.

 To save the current project settings as a new template

1. From the Pathfinder Home screen, choose File (menu) > Create Template From Project.

2. Navigate to the Pathfinder Project Templates folder (default).

3. Enter a name for the new template and choose Save.

The acquisition properties, quant settings, periodic table settings with the history, 
spectrum processing setup, and Feature Sizing parameters are saved in the template. The 
new template is stored with a .tnp extension.

Protect Project Templates
Use System Security in the File menu to prevent unauthorized modification of project 
templates. 

 To protect project templates with a password

1. From the Pathfinder Home screen, choose File > System Security, enter the 
administrator password (or leave the Password box blank for the default password) and 
choose OK.

Note  You can save templates in other folders. However, only those templates stored in 
the Pathfinder Project Templates folder will be visible when you create a new project.
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2. In the Security Setup box, select Lock Templates, enter and confirm your password and 
choose OK.

3. From the Pathfinder Home screen, choose File > System Security > Lock System.

4. Enter the administrator password and choose OK.

A message indicates that the project templates are locked.

5. Choose OK to close the message box.

Reset a Project Template
Resetting a project restores the template settings for that project.

 To reset a project

1. Open the Project Explorer window.

From the Home screen, do one of the following:

• Click the Project Explorer button  on the main toolbar.

• Choose File (menu) >Project Explorer.

2. Select the project in the left pane.

3. Click the Reset button in the right pane.

The project settings are returned to the settings from the template file used to create the 
project.

Pathfinder Files
Most Pathfinder files are stored in industry standard formats, such as EMSA for spectra files, 
TIFF for image files, etc. Due to their unique nature, Spectral Imaging files are stored in a 
Thermo Fisher Scientific proprietary format. You can save data in an industry standard format 
by switching to a mode that supports the file format. For example, switch from Spectral 
Imaging to Spectrum mode to save an EMSA spectrum file.

You can open many of the files by using a text editor like Notepad.
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You can save a file at any time by clicking the Save button on the main toolbar or choosing 
Save from the File menu. To change the file's name, select the file in the file list pane, click 

 on the file management panel and type the new name. You can also select a pane and use 
Copy To in the Edit menu to save the pane in a JPEG file.

The table below describes the Pathfinder file types.

Note  All TIFF files contain both an 8-bit image and a 16-bit image. The 8-bit image is 
used by third-party programs such as Microsoft Word. The 16-bit image is used within 
Pathfinder software.

Table 4. Pathfinder File Types

File Type (Extension) Description

.apf Automation points file

.chem Feature sizing chemical type file

.clib Feature sizing chemical library file

.csi Spectral Imaging control file. Contains the names of files used for 
the Spectral Imaging acquisition.

.em Element map if phase data came from map input in TIFF format

.emsa Spectrum files stored in industry-standard EMSA format

.fss Feature Sizing setup file

.fzm, .fzma or .fzme Map from optional XPhase processing in TIFF format

.fzs, .fzsa or .fzse Spectrum from optional XPhase processing in EMSA format

.grid Automation grid file

.jpg Image file saved in JPEG format (Edit > Copy To)

.lscan Linescan file

.lsctl Linescan control file

.lsmsa Spectrum files for each pixel in a linescan stored in 
industry-standard EMSA format

.lsref Linescan reference image in TIFF format

.map Element maps control file

_map.tif X-ray map file in TIFF format

.mtdb Spectral match database

.p_s Point ID control file

.pcm or .pcma Compass image file in TIFF format

.pcs or .pcsa Compass spectrum file in EMSA format

.psmsa Point ID spectral file in EMSA format
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Import Files into the Current Project
 To import a file into the current project

1. Select the analytical mode that corresponds with the file type you want to import.

2. From the Pathfinder Home screen, choose File > Open.

3. Navigate to the project folder that contains the file.

4. Select the file and choose Open.

The data is copied to the current project's temporary folder and inherits the current project's 
settings. To permanently save the file in the project, click the Save button on the main toolbar 
or choose File > Save.

Save a File in a Project
When you close a project, Pathfinder displays a list of files that have been acquired or 
modified in the current session. Deselect those files you do NOT want saved. Choose OK to 
save the changes, or choose Cancel to close the Save dialog box and return to the project 
without saving any changes.

.psref Point ID reference image in TIFF format

.ref EMSA-compliant file containing standardless references

.si Spectral Imaging data file

.simcs Spectral Imaging concurrent external input map file in TIFF 
format

.siref Spectral Imaging reference image file in TIFF format

.sitif Spectral Imaging concurrent video image file in TIFF format

.std EDS standards spectral data file stored in EMSA format

.stn Standards reference file in EMSA format

.tif Image file in TIFF format

.tnp Project template file

.wstd WDS standards spectral data file stored in EMSA format

Table 4. Pathfinder File Types

File Type (Extension) Description



2 Project Management
Export Image or Map Data

36 Pathfinder User Guide Thermo Scientific

 To save a file without closing the project

Click the Save button  on the Main toolbar to save the file in the currently open project.

Or:

From the Pathfinder Home screen, choose File > Save.

The file is moved from the temporary folder to the project folder.

Export Image or Map Data
Use one of these options in the File menu to save an electron image or map to a different file 
format:

• Export Image as CSV. Saves the currently displayed or extracted image or maps 
(component, phase or X-ray) as a a series of CSV (.csv) files (one file for each element 
specified as Included or Always Included, plus one for the low-res grey image). The CSV 
files are saved in a location you specify with a base name you specify followed by the 
element name.

• Export Image as Bitmap. Saves the currently displayed electron image as a bitmap 
(.bmp) file. If the micron bar is set to be overlaid on the electron image, it will be 
exported as such in the bitmap. If the micron bar is set to be displayed in the header, it 
will not be exported in the bitmap. The bitmap file is saved in the corresponding 
Point ID or Spectral Imaging project folder with the sample name (displayed in the file 
list pane) followed by “export” as the filename.

• Export Image as Full-Res TIF. Saves the currently displayed electron image at the full 
resolution of the acquired data as a TIFF (.tif ) file. If the micron bar is set to be overlaid 
on the electron image, it will be exported as such in the .tif image. If the micron bar is set 
to be displayed in the header, it will not be exported in the .tif image. The TIFF file is 
saved in the project folder with the sample name (displayed in the file list pane) followed 
by the resolution (24bit) as the filename.

• Export Linescan as CSV. Saves the currently selected linescan as a CSV (.csv) file. You 
can enter a filename for the CSV file and select the folder where the CSV file is saved. 
The default folder is the current project folder, and the default filename is the sample 
name (displayed in the file list pane).

• Import Gatan File. Allows you to import a Gatan spectral image file. Appears in the 
Import/Export menu only when the optional 3rd Party Remote (portal) software is 
installed.
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Search For a Project
You can search for specific projects using keywords. The same keyword or words can be used 
in multiple projects.

 To add keywords to a project

1. Open Project Explorer (click Project Explorer button  on main toolbar or choose 
File (menu) > Project Explorer).

2. Select the project folder.

3. In the Properties panel, enter one or more keywords in the Key Words box, separating 
each word or phrase with a comma.

4. Choose OK.

 To find projects using keywords

1. Open Project Explorer (click Project Explorer button  on main toolbar or choose 
File (menu) > Project Explorer).

There are three ways to start a project search:

• In the Project Explorer window, right-click a high level folder (for example, 
Pathfinder Projects) and choose Project Search.

• In the Project Explorer window, select a high level folder and choose Edit > Project 
Search.

• In the Project Explorer window, select a high level folder and press F3 on the 
keyboard.

2. Enter a key word or words (with a comma separator) or select a key word from the list box 
and choose OK.
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3. The software searches all projects in the selected folder. Found project folders are 
highlighted in pink.

Open a Project in Windows Explorer
Use Project Explorer’s Open In Windows Explorer menu option to display the contents of a 
selected Pathfinder project or other folder in Windows Explorer, for example, to copy an 
exported data file.

 To open a project folder in Windows Explorer

1. Open Project Explorer (click Project Explorer button  on main toolbar or choose 
File (menu) > Project Explorer).

2. Right-click a Pathfinder folder (project or other) and choose Open in Windows 
Explorer.

The software opens a Windows Explorer window and displays all the files in the selected 
Pathfinder folder.

Found projects that
contain specified keywords

NOTICE    Be careful not to accidentally delete a Pathfinder data file, especially an 
associated file, or you may render the data unusable.
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3

Spectrum Mode

This section discusses the Spectrum analytical mode and its associated components. It 
provides an in-depth look at the tools for setting up, acquiring and analyzing X-ray spectral 
data (qualitative and quantitative) and all associated features. These tools described here are 
common to any analytical mode that includes a spectrum, including Spectrum, Point ID, and 
Spectral Imaging.

Select Spectrum Mode
Use Spectrum mode to acquire and analyze an X-ray spectrum. To select Spectrum mode, 
click the Spectrum button on the analytical mode toolbar.

Figure 17. Select Spectrum mode

In Spectrum mode, the software displays all the features and tools for X-ray analysis of a 
sample.
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Figure 18. Pathfinder Spectrum Mode User Interface

General Steps for Spectral Acquisition and Analysis

Pre-analysis Considerations

Sample preparation, microscope operating conditions, and detector geometry all affect the 
accuracy of any EDS analysis. This section provides general guidelines to consider before you 
use Pathfinder software to perform an EDS analysis for the first time.

Sample Preparation

The first step with any analysis is sample preparation. The instrument works well with 
samples that are flat, well polished (1 micron or less final polish), and electrically conductive. 
For some applications, such as failure analysis, polishing the sample would be 
counter-productive. For unpolished samples, some topography may affect the line of sight to 
the detector.

Spectrum pane Controls panel

File List paneElement Setup pane Results pane
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If your samples are non-conductive, apply a conductive coating or use variable pressure if your 
SEM has that feature. If you apply a conductive coating such as carbon or gold, make sure any 
quantitative measurements account for the added element in the spectrum. This can be 
accomplished by identifying the element (i.e., setting it to Identified in the periodic table) but 
excluding it from the quantitative analysis (i.e., setting its Quant Lines to Absent in the 
periodic table). The thinnest useful coating of carbon is best for the majority of samples. Be 
aware that coatings with high atomic number materials will absorb X-rays of low atomic 
number elements within the sample.

Microscope Considerations

Position the sample at the optimal (or analytical) working distance for the selected detector. 
This value is specific to the microscope and is included in the documentation provided with 
the EDS detector. To do this, first adjust the microscope working distance so the readout 
(usually labeled “WD” or Focus Point”) matches the detector’s optimal working distance. 
Then use the stage Z controls to raise or lower the sample surface to bring the sample into 
visual focus.

Make sure the detector is fully inserted before you acquire data. The insertion position is 
determined and set during installation. The detector position affects the efficiency of X-ray 
collection. Some sample conditions may preclude full insertion of the detector. However, keep 
in mind that this can cause the system to detect stray X-rays from areas not associated with the 
sample.

The microscope accelerating voltage determines the energy range of X-rays that are fluoresced 
and the rate of excitation from a sample. Estimate the highest order of element X-ray lines of 
interest and set the accelerating voltage 1.5 to 2 times higher than the energy of that line. This 
is known as the “over-voltage” for that line. For example, if you are analyzing the Copper K 
line (8.047 keV), use a minimum accelerating voltage of 13 KV. However, a good starting 
point is 15 or 20 KV.

The microscope beam current reaching the sample affects how much data can be acquired 
over a given period of time. Higher beam currents lead to higher count rates, which are useful 
for mapping large areas in a reasonable amount of time. A lower beam current produces lower 
count rates and higher quality spectra, which are useful for quantitative analysis. These higher 
quality spectra have narrower peaks, better peak separation and fewer spectral artifacts such as 
sum peaks.

To control the beam current reaching the sample, adjust the beam current (referred to as 
“probe current” or “spot size” on some microscopes). The microscope aperture, located in the 
beam path in the microscope column, can also be used to limit the amount of beam current 
that reaches the sample.

“Dead time” is a measure of how busy the pulse processor is when measuring the X-ray events. 
For mapping applications, a dead time of 50% or less is best. For quantitative applications, 
keep dead time between 20% and 30%.
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The chances of inducing spectral artifacts (sum peaks) increases with count rate for a given 
time constant. Using a lower count rate may require a longer acquisition time to produce 
sufficient X-ray counts for statistically good analyses.

Detector Geometry

Accuracy depends on many things, including sample preparation and how the analysis area is 
chosen. Precision mostly depends on how many X-ray counts are acquired, up to a point. The 
detector characteristics such as the takeoff angle and the window material affect the efficiency 
of X-rays reaching the detector. This changes as a function of energy (soft X-rays, those with 
energies less than 1.5 keV, are absorbed more easily than higher energy X-rays).

Depending on the microscope, the takeoff angle for the detector ports can vary from 20 to 
40 degrees. The higher the takeoff angle for a given microscope/detector installation the more 
efficient is the measurement. If your detector has a window, the window material may absorb 
certain X-rays, which can affect the measurement results if not accounted for in the analysis.

Acquire and Analyze a Spectrum

This section provides an overview of the steps to perform a spectral acquisition and element 
identification and quantification.

 To acquire and analyze a spectrum

1. Prepare the sample.

Place the sample in the microscope and obtain an image. Adjust the stage to the optimal 
working distance for the EDS detector. Obtain a good electron image of an area of 
interest on the sample.

2. Fully insert the detector.

3. Start Pathfinder software.

The Pathfinder Project Explorer window is displayed.

4. Select or create a project and choose OK.

The Pathfinder main screen is displayed.

5. Click the Spectrum  button on the analytical mode toolbar.

6. Enter an experiment name (used as a base name for automatically saving acquired data).

On the acquisitions toolbar, click the  button and enter the experiment name (or 
leave the default name).
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7. Click the Experiment Setup  button on the acquisitions toolbar (normal view toggle 
setting) to display the available acquisition settings for spectral analysis.

8. In the Active Detectors group (appears only when multiple Pathfinder-compatible 
detectors are installed on the microscope), select one or both Pathfinder-compatible 
detectors for the analysis.

9. In the Termination Criteria group:

• Set Live Time Limit (acquisition time) to 10 seconds.

• Set Max Peak Counts to 0.

10. In the Energy Range group:

• Set Low Energy Cutoff to 100 eV.

• Set High Energy Cutoff to Auto.

11. Set Time Constant to Auto.

12. Adjust the beam current, (spot size or condenser lens) on the microscope to obtain a 
detection rate of 50% or less dead time. (UltraDry detectors have a high count rate with 
low dead time.)

13. On the acquisitions toolbar, click Start Spectrum to begin the spectral acquisition.

Normal View 
toggle setting

Experiment
Setup

Acquisitions 
toolbar
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The button changes to Stop Spectrum and the acquisition continues until the 
termination condition (such as the Live Time Limit) is met.

• To pause the acquisition, click the Pause button.

To continue the acquisition, click the pause button again.

• To end the acquisition and save the data, click Stop Spectrum.

• To end the acquisition without saving the data, click the Abort button

The live spectrum is displayed in the spectrum pane.

The progress bar at the top of the Pathfinder window shows the progress of the 
acquisition.

The real acquisition time shown on the progress bar is always longer than the specified 
Live Time Limit due to dead time when the pulse processor is busy measuring the X-ray 
events. This is a normal part of X-ray sampling.

14. Wait until the acquisition is completed.

Stop spectrum 
acquisition

Pause 
acquisition

Abort 
acquisition
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15. If Auto ID and/or Auto Quant are selected (default), element identification and 
quantification results are displayed and updated at defined intervals during the 
acquisition and final results are displayed after the acquisition completes.

The qualitative (identification) results are shown as peak labels on the spectrum displayed 
in the spectrum pane. The quantitative results are displayed in the Results Pane. Here is 
an example:

Figure 19. Quantitative results displayed in the results pane

Spectral Acquisition Settings
This section explains the tools and settings for spectral acquisitions that are common to all the 
analytical modes that involve spectra (all but Linescan), including:

• microscope settings
• X-ray acquisition settings
• settings for element identification
• settings for element quantification
• spectral display properties
• advanced analytical methods such as Spectral Match.

The tools and settings are discussed in logical order for setting up a spectral analysis.

Microscope Settings

For any analysis, the software requires the current microscope accelerating voltage, working 
distance and magnification values.
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Enter Microscope Settings

Most modern microscopes allow the software to read the microscope accelerating voltage, 
working distance and magnification values automatically when they are needed. If your 
microscope does not include column automation, enter these values before you start an 
analysis (see the instructions below) and update the values whenever the Microscope 
Parameters box is displayed.

Skip this section if your microscope includes column automation, which allows our software to read 
these values automatically when they are needed.

 To enter microscope settings manually

1. From the Pathfinder main window, choose Edit (menu) > Microscope Parameters.

The Microscope Parameters and Status Bar Selection box is displayed.

Figure 20. Microscope Parameters and Status Bar Selection Box

2. Enter the accelerating voltage in KV.

3. Enter the magnification.

4. Enter the microscope working distance in mm.

Note  

• If Column Communications software is installed, these parameters are updated 
automatically.

• The Microscope Parameters can be displayed automatically at the start of an 
acquisition by selecting Display On Acquisition Start (see image above). This option 
is helpful if Column Communications are not installed.
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Display Microscope Settings on the Status Bar

The status of various microscope parameters can be monitored on the status bar, which 
appears in all analytical modes. Good choices include Accelerating Voltage, Magnification, 
Working Distance, Time Constant and Dead Time.

 To display microscope settings on the status bar

1. From the Pathfinder main window, choose Edit (menu) > Microscope Parameters to 
display the Microscope Parameters and Status Bar Selection box.

2. Click the check box adjacent to the settings you want displayed so the check box is 
selected. Here is an example:

X-ray Spectral Acquisition Settings

Experiment Name

Before you begin taking measurements, enter an experiment name by clicking the  
button on the acquisitions toolbar and entering a name for your experiment (or leave the 
default name). The experiment name is used as a base filename for automatically saving 
acquired data.

Note  To show or hide the status bar, from the Pathfinder main window, choose 
View (menu) > Status Bar so the menu command is selected.

Feature selected for 
display on status bar
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Spectral Acquisition Presets

In Spectrum mode, there are four setting presets available for acquiring X-ray spectra without 
having to set individual parameters. To select a preset, click the down arrow at the right of the 
Start Spectrum button.

Figure 21. Acquisitions toolbar, X-ray spectral acquisition presets

These selections are available:

• High Resolution. Longest (and slowest) Time Constant setting for high resolution 
spectral acquisition. 

• High Throughput. Shorter (and faster) Time Constant setting for high throughput 
spectral acquisition.

• User Defined 1 (and User Defined 2). Two sets of customized conditions that have been 
previously saved. See below for details.

Note  The High Resolution and High Throughput options are defined by the 
software and their settings cannot be changed.
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 To set up customized conditions for X-ray spectral acquisition

1. Click the Experiment Setup  button next to the Start Spectrum button on the 
Acquisitions Toolbar and set individual parameters as desired.

2. Click User Defined > Save User Defined Settings 1 (or Save User Defined Settings 2).

The icon on the toolbar changes to User Defined 1 (or User Defined 2) to show which 
preset is selected.

3. Click Start Spectrum to start the acquisition.

Note  In the future, use the arrow next to the Start Spectrum button on the Acquisitions 
toolbar to select your custom conditions.
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 To update custom settings

1. Click the Experiment Setup  button next to the Start Spectrum button on the 
Acquisitions Toolbar.

2. Click the Setting Presets button and select the custom parameter set you want to modify 
(User Defined 1 or User Defined 2).

3. Modify the individual parameters as desired.

4. Choose User Defined > Save User Defined Settings 1 (or Save User Defined Settings 
2).

Spectral Acquisition Experiment Settings

You can set acquisition parameters manually or use a spectral acquisition preset. This section 
provides general considerations for X-ray spectral acquisition and gives brief descriptions of all 
the available settings for acquiring X-ray spectra.

Spectral Acquisition Considerations

Consider these points before acquiring X-ray data for the first time.

• Termination Criteria. There are two criteria for terminating an acquisition: by time or 
by counts in the spectrum.

• Terminate By Time. To terminate by time, enter a Live Time Limit value in seconds 
in the Termination Criteria group. The length of time should be sufficient to acquire 
a statistically valid spectrum. See below for more information.

Note  If values, other than 0 or blank, are entered in the Termination Criteria group, 
the first criterion reached will terminate the acquisition (zero equates to infinite).
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• Terminate By Counts. There are two ways to terminate by counts in the spectrum:

• Maximum peak counts. If any channel in a spectrum reaches the specified 
number of counts, the acquisition is terminated.

• Region of interest by element and line max counts. If the gross counts in the 
element peak reaches the specified Max Counts value, the acquisition is 
terminated.

• Energy Range. The Energy Range group includes two selections:

• Low Energy cutoff (eV). Clips the energy acquisition range from 0 eV to the value 
entered in the edit box (i.e., it clips off the noise peak). The Auto selection adjusts the 
cutoff value depending on the estimated noise at a given pulse processor time 
constant. For most time constant settings, using a Low Energy Cutoff of 100 to 
120 eV eliminates the noise peak at the low energy range.

• High Energy Cutoff (keV). Determines the number of channels allocated in 
memory (each channel represents 10 eV). For example, if a maximum range of 
10 keV is selected, 1024 channels of memory are allocated. At this range, any peak 
greater than 10.240 keV is not saved or displayed.

Generally, the accelerating voltage in an SEM is limited to 30 KV. At this voltage the 
highest energy X-ray line that can be fluoresced and displayed is Mo K line at about 
17.4 keV. Thus, on an SEM, the maximum keV range is 20 keV; whereas, on a TEM 
at 200 KV, a 40 keV range would be appropriate.

The Auto selection adjusts the cutoff value to the accelerating voltage of the 
microscope. If the microscope accelerating voltage setting is incorrect, the high 
energy cutoff may also be incorrect.

• Time Constant. The time constant is the time allowed for the pulse processor to estimate 
the energy of an X-ray. The longer the time allowed, the better the estimate of the energy 
and the higher the peak resolution. However, the longer the time constant, the higher the 
dead time for a given count rate. High resolution spectra (long time constant) require a 
lower count rate and a longer acquisition time to produce statistically good spectra (low 
counting errors).

Note  In general, there should be sufficient counts in a peak to achieve a counting 
error of less than 1%. For most applications, this can be achieved with a Live Time 
Limit of 60 seconds and a Max Peak Count of 10,000. (Make sure you use Time 
Constant and beam current settings that will achieve 30% dead time or less.)

Note  Fixing the high energy cutoff at 20 keV for an SEM provides consistent 
spectra for comparison.
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For high resolution detectors, there are 10 fixed time constants plus the Auto selection. 
Non-extreme detectors have 8 or 9 fixed time constants plus the Auto choice. All time 
constants have estimated through-puts (counts per second). (To see the counts per second 
for the selected time constant, add Storage Count Rate to the status bar display by 
selected its check box in the Microscope Parameters and Status Bar Selection box.)

When selecting a time constant, consider the resolution of the spectrum and the length of 
time it takes to acquire the spectrum. Generally, select the longest time constant and 
acquire at a lower count rate to obtain a high resolution spectrum. For general samples, 
using a faster time constant (for example, Rate 3) increases throughput (i.e., shortens 
acquisition times) while still yielding a quality spectrum. For UltraDry detectors, a time 
constant of Rate 2 or Rate 3 yields quality spectra.

Note  When Time Constant is set to Auto, the software adjusts the time constant to 
achieve between 30% and 50% dead time. At high beam currents, the time constant 
is shorter and spectral resolution degrades. At low beam currents, the time constant is 
longer and spectral resolution improves.

Do not use the Auto setting for spectral comparisons or quantification with standards 
because spectra acquired with different time constants will have different spectral 
resolutions.
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Experiment Setup (Normal View)

To access the spectral acquisition settings, click the Experiment Setup button  on the 
right side of the acquisitions toolbar. For normal view, click to toggle the green arrow so it 
looks like this:

Normal View 
toggle setting

Experiment
Setup
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The following spectral acquisition settings are available in normal view. For more information 
about setting acquisition parameters for sample acquisition, see X-ray Spectral Acquisition 
Considerations.

Table 5. Spectrum Mode Experiment Settings, Normal View

Group Setting Description

Active Detector(s) Detector One/
Detector Two

Available only when multiple Pathfinder-compatible EDS detectors 
are installed on the microscope. When multiple EDS detectors are 
installed, use the Detector One/Detector Two buttons to select 
which detector(s) you want to use for the analysis.

Termination Criteria

Note: If all 
termination criteria 
have entered values, 
the first met 
termination criterion 
terminates the 
acquisition.

Live Time Limit(s) “Live time” refers to the period during acquisition when the system 
is waiting for new X-rays (whereas dead time is the period when the 
pulse processor is measuring the energy of an X-ray). Live Time 
Limit stops the acquisition when the system has acquired live data 
for the specified time period.

A general rule for spectral acquisitions is 100 seconds of live time 
collection at 25–30% dead time with Time Constant set to Rate 2 
or Rate 3. With SDD (UltraDry) detectors, the dead time will be 
lower.

Note: Set Live Time Limit to 0 for no live time limit (acquisition 
terminates based on other criteria).

Max Peak Counts Terminates the acquisition when the vertical full-scale of the 
centroid channel of any peak in the spectrum (including a noise 
peak) reaches this value.

Note: Set Max Peak Counts to 0 for no count limit (acquisition 
terminates based on other criteria). 

Energy Range Low Energy Cutoff 
(eV)

X-ray counts below the specified Low Energy Cutoff are ignored 
during an EDS acquisition. Can be used to eliminate the “noise” 
peak in the low energy region. Typical options:

• 100 eV. Clips the noise peak in the spectrum

• Zero. Includes the noise peak

• Auto. Adjusts the energy value according to the specified Time 
Constant. Each Time Constant setting has a unique noise level. 
In general, Auto includes about 3 channels of noise in the 
spectrum. Each time constant has a unique noise level.

High Energy Cutoff 
(keV)

X-ray counts below this limit are included in an EDS acquisition. 
Typically, a High Energy Cutoff setting of 20 keV will include an 
X-ray line from all elements using an SEM. For TEM applications, 
40 keV is appropriate. The Auto option changes the energy limit 
according to the microscope kV.
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Time Constant The amount of time the software measured the energy of an X-ray. 
Consider these options:

• Rate 1 and Rate 2 produce statistically good, high-resolution 
spectra

• Rate 3 and Rate 4 produce quality spectra for most analyses

• Auto adjusts the time constant to keep the dead time between 
30% and 50%. Depends on the beam current and accelerating 
voltage.

Note: Do not use the Auto setting for spectral comparisons or 
quantification with standards.

To see the time associated with each Rate setting, add Time 
Constant to the Pathfinder status bar.

User Defined Save User Defined 
Settings 1
Save User Defined 
Settings 2

Allows you to save up to two instances of the experiment settings 
for spectral acquisitions (User Defined 1 and User Defined 2) that 
can be easily recalled later by clicking the Setting Presets button on 
the Acquisitions toolbar and choosing an option from the list box.

Table 5. Spectrum Mode Experiment Settings, Normal View

Group Setting Description
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Experiment Setup (Advanced View)

To access the spectral acquisition settings, click the Experiment Setup button  on the 
right side of the acquisitions toolbar. For advanced view, click to toggle the green arrow so it 
looks like this:

The following spectral acquisition settings are available in advanced view.

Advanced View 
toggle setting

Experiment
Setup

Table 6. Spectrum Mode Experiment Settings, Advanced View

Group Setting Description

Region of Interest Element To define termination criteria based on the integrated counts in the 
energy region for a particular element, enter the atomic symbol for 
the element and select an X-ray line (see below).

Line If you entered an element (see above), select the X-ray line for that 
element.
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Set Up Automatic Spectral Processing

The Spectrum Processing settings control how spectrum identification and quantification are 
performed. To perform spectrum processing automatically for each acquired spectrum, set the 
spectrum processing parameters before you acquire a spectrum and make sure Auto ID and/or 
Auto Quant are selected.

Spectrum processing settings apply to all the analytical modes and are not included in the 
presets, so you only need to set them once.

 To set up automatic spectral processing

1. Click the Spectrum Processing icon  on the controls panel.

Max Counts Terminates the acquisition when the integral counts in the selected 
region of interest (element or user-defined) reaches this value.

User Defined To modify the default region of interest used for terminating an 
acquisition for a given element and line, set Element and Line, 
select the User Defined check box, and enter new high and low 
values for the region (see below).

Low (eV) When modifying the default region of interest for an element and 
line (see User Defined above), enter the low energy cutoff value in 
eV. X-ray counts below this value are ignored during an EDS 
acquisition.

High (eV) When modifying the default region of interest for an element and 
line (see User Defined above), enter the high energy cutoff value in 
eV. X-rays of energy up to this limit are included in the EDS 
acquisition.

Readouts Detects (/s) Shows the number of X-rays entering the EDS detector per second.

Stores (/s) Shows the number of X-ray counts that are measured and stored in 
the spectrum per second.

Dead Time (%) Shows the percentage of dead time for the current measurement 
settings. Dead time refers to the time the pulse processor is busy 
measuring X-ray events and cannot process another X-ray event. 
Rate 1 has the longest measurement time and produces the highest 
dead time for a given count rate. Rate 10 has the shortest 
measurement time and produces the lowest dead time for the same 
count rate.

A dead time of 25-30% is recommended for quantitative analysis, 
and up to 50% for a spectral imaging (mapping) analysis.

Table 6. Spectrum Mode Experiment Settings, Advanced View

Group Setting Description
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The following options are displayed.

2. To set up automatic element search and identification, choose Ident Setup, set the 
identification parameters as desired and make sure Auto ID is selected.

3. To set up a automatic quantitative analysis, choose Quant Setup, set the quant 
parameters as desired and make sure Auto Quant is selected.

Preliminary identification and quantitative results are displayed during the acquisition with a 
final update after the acquisition is completed.
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Display Quant Results
The software provides many options for displaying the results of a quantitative analysis. This 
section explains how to customize the quant results pane.

Select Quant Results Display Mode

Grid Display Mode

The default display mode for quant results is called grid mode. Each row in the grid represents 
a quantified element. The columns included in the grid are defined by the Options button in 
the quant results pane. Here is an example of Intensity, Net Counts, Weight% and Weight% 
Error displayed in grid mode:

Figure 22. Quant Results Displayed in Grid Mode

Click Charts to display quant results in chart format.

Display quant results in chart format Select quant results for display
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Chart Display Mode

To see quant results in chart format, click the Charts button in the quant results pane. Here is 
an example of a pie chart display:

Figure 23. Quant Results Displayed as Pie Chart in Chart Mode

To change the chart format, select Charts and then use the right and left arrow buttons to 
scroll through the available chart formats:

• pie chart (each color represents a quantified element)
• histogram (each vertical bar represents a quantified element)
• bar chart (each horizontal bar represents a quantified element)
• line chart (each data point represents a quantified element)

To change the quant result displayed, select Data and then use the right and left arrow 
buttons to scroll through the available results.

Use the Options button to select the quant results for display.

Click Grid to display quant results in table format (default).

Select Quant Results for Display

The software calculates a number of parameters during the quantification routine. Use the 
Options button on the results panel to select which results you want displayed after a 
quantitative analysis.

Scroll through available options:
- in Chart mode: pie, histogram, bar, or line
- in Data mode: quant resultsSelect chart format

Select quant result

Display quant results in table format Select quant results for display
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How to Select Quant Results for Display

 To select the quantitative results for display

1. Click Options in the results pane to display the Selectable Columns box.

2. Select the quantitative results you want displayed.

Weight%, and Weight% Error are typically included.

3. Select Line Type to display the X-ray lines used for Quantification.

Brief descriptions of all the available options are provided below.

4. Choose OK to save and close the Selectable Columns box.

The features you selected are added to the columns displayed in Grid mode and to the 
scrollable Data in Chart mode.

Note  

• Right-click the title bar in the results pane to quickly select or deselect commonly 
used column headings for quant results.

• If an “(S)” appears next to an element quantification result, this indicates the result 
was calculated by stoichiometry. In the Selectable Columns box, select Compund% 
to display the compound result. Select Chemical Formula to display the formula 
used.
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Available Quantitative Results for Display

The table below briefly explains the available quantitative results.

Table 7. Available Quantitative Results for Display in Results Pane

Result Name Description

Line Type X-ray line type (K or L) used for quantification

Intensity Intensity value for each reported line (net counts divided by live 
time and then divided by beam current)

Intensity err Error value for intensity

Net Counts Number of X-rays received and processed by the detector with 
background characteristics removed

Net Count err Error value for net counts

Weight % The mass of the quantified element in the sample expressed as a 
percentage

Weight % err Error value for measured weight%

ZAF Factor Correction factor for “matrix effect” (includes atomic number, 
X-ray absorption and X-ray fluorescence corrections combined).

Atom% The atomic concentration of the element in the sample 
expressed as a percentage

Atom% err The error in the atomic percentage value based on the counting 
error of the net count measurement

Source Source of the net count measurement (EDS, EDX STD, WDS, 
or FILE)

K-ratio Measured K-ratio (intensity sample/intensity from pure 
element) for the X-ray line

K-ratio err Error value for K-ratio (based upon the error in the net counts)

Z Factor Correction factor for atomic number effect as calculated by the 
Proza or ZAF matrix correction routine

A Factor Correction factor for X-ray absorption effect as calculated by the 
Proza or ZAF matrix correction routine

F Factor Correction factor for X-ray fluorescence effect as calculated by 
the Proza or ZAF matrix correction routine
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K Factor Correction factor applied to element intensity ratios when 
calculating quantitative results from thin film samples, usually 
in STEM analysis. Uses ratios of intensities taken from all the 
elements in a sample. The samples are assumed to be thin 
enough to ignore X-ray absorption effects.

K factors can be measured from standards or the software can 
calculate theoretical K factors for standardless analysis.

Norm. Wt.% The element’s weight concentration value normalized so that the 
total weight percentage from all elements equals the current 
Total Weight% setting.

Norm. Wt.% err Error value for normalized weight%

Chemical Formula Chemical formula of the compound containing the element 
used for stoichiometric calculations for Compound% results

Compound % Percentage by mass of the quantified compound in the sample

Norm. Compound % The element’s compound percent value normalized so that the 
total from all compounds is 100 percent.

No. of Cations Number of cations for the element based on the number of 
oxygen atoms defined in Quant Setup (see Normalize cations 
based on the following number of oxygen atoms)

Standard Name Name of the standard, if any, used to quantify the element or 
compound

Error Measures (Sigma) Defines the confidence level of the calculated results. Available 
options:

• 1 Sigma (~68% confidence)
• 2 Sigma (~95% confidence)
• 3 Sigma (~99% confidence)

For example, if the Wt% of an element is 10.0% with a 2 Sigma 
error of +/- 1.0%, we are 95% confident that the true Wt% of 
the element lies somewhere between 9.0 and 11.0 Wt% 
(i.e., 10% +/- 1%).

Decimal Places Defines the number of decimal places reported for the 
calculated results. Available options: 1, 2 (default), or 3.

Note: Because of the inherent error in EDS measurements, 
1 decimal place is warranted. However, some protocols have 
specific decimal place reporting requirements.

Table 7. Available Quantitative Results for Display in Results Pane

Result Name Description
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Show Matrix Only Displays only the X-ray lines used for quantification in the 
results pane.

Selecting this option reduces the number of entries in the quant 
results grid or chart.

When this option is cleared, all X-ray lines in the displayed 
spectrum (Spectrum pane) are included in the quant results 
pane. The following example shows both K and L lines for 
iron (Fe). Only the dominant (K line has a quantification 
result; the L line has dashes for Wt% and Wt% error.

Total Weight % Defines the total weight value used to normalize the data 
(default is 100%).

Leave this set to 100% unless you know the composition of the 
sample and want to normalize based on a percentage other than 
100%.

Note: For standardless analysis, we recommend using the 
default total weight% value (100%).

Table 7. Available Quantitative Results for Display in Results Pane

Result Name Description
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Display Quantification Information About an Acquired Spectrum

There are several ways to view quantification information about an acquired spectrum.

 To view quantification information from the results pane in grid mode

Move the mouse pointer over the title bar:

 To view basic spectrum information from the file list pane

1. Select the file in the file list pane.

2. Click the information button to display basic information about the selected file.

Basic information 
about selected file
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3. Click Details (see the previous image) to open the Details box for the selected file.

Here is an example:

Customize the Spectrum Pane
The spectrum pane shows the acquired or selected spectrum, with energy in keV along the 
X-axis and counts along the Y-axis.

If the Energy Cursor is displayed, it appears as a vertical line.

The vertical scale and integral counts are displayed in the upper left corner.
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The cursor location and number of X-ray counts at that location are displayed in the upper 
right corner.

Energy cursor
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Change Appearance of Spectrum Pane

You can change the appearance of the spectrum pane, such as the background color, to suit 
your preferences.

 To change the appearance of the spectrum pane

1. Click Spectrum Settings on the controls panel.
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Customize How Spectra are Displayed

You can change the colors of displayed spectra and define the appearance of spectra displayed 
in the spectrum pane.
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Adjust Colors of Spectra

Use these features to change the colors of various features of the display pane, such as the 
spectrum, background, cursor, line and font.

To change the color of a feature, such as the spectrum, click its color selection button, then 
select a color from the standard color palette or from the custom color palette.

Figure 24. Standard and Custom Color Selection Palettes

Standard Color Selection palette Custom Color Selection Palette
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Display Spectra in Log Scale

Checking Log displays the spectrum in a logarithmic scale (useful for seeing small peaks).

Figure 25. Spectrum displayed using log scale

Smooth Displayed Data

Select Smooth to smooth the spectrum. In some instances, the irregularities may be enhanced. 
Smoothing is only done in the display. The raw data are preserved.

Figure 26. Spectrum displayed with and without smoothing

Unsmoothed Spectrum Smoothed spectrum
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Display Grid in Spectrum Pane

Select Grid to display a grid in the spectrum pane to the display (useful for comparing peak 
counts).

Figure 27. Spectrum displayed with background grid

Display Spectra as Histograms

Select Histogram to view the spectral data as it was acquired (no processing). Deselecting 
Histogram applies a smoothing function to the spectral data.

Figure 28. Spectrum displayed with Histogram option turned on and off

Expanded peak with Histogram selected Expanded peak with Histogram deselected
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Display Energy Cursor in Spectrum Pane

Select Cursor to display the energy cursor in the spectrum pane.

Figure 29. Spectrum pane with energy cursor displayed

Display Peaks as Outlines

Select Outline to display peaks without the solid fill color. When Outline is selected, an 
additional Thick Lines option appears in Spectrum Settings. Use it to switch between thick 
and thin outlines.

Figure 30. Spectrum displayed in Outline mode (with colors set to black and white)

Note  With a simple black and white outline, you may also need to change the font color 
to see the peak labels.

Energy cursor

Spectrum displayed in outline 
mode with colors changed to 
black and white
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Customize How Peak Lines and Labels are Displayed

Peak lines are the vertical lines in the center of each labeled peak.

Figure 31. Spectrum with peak lines displayed

You can display or hide peak lines and peak labels and change several properties that affect 
how peak lines and labels appear in displayed spectra. These settings are in the Peak group in 
Spectrum Settings.

Figure 32. Peak settings

Peak linePeak label
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Display Peak Lines

Select Lines On to display peak lines in the spectrum pane (default is selected).

Select Peak Line Color

To change the peak line color, click the Line Color selection button, then select a color from 
the standard color palette or from the custom color palette.

Use Smart Labels

This selection controls the number of element X-ray lines that are labeled for a given element. 
When Smart Labels is selected, the software displays a limited number of element labels when 
space is limited to keep the spectrum pane from looking cluttered.

Deselect Smart Labels to display peak labels for all identified X-ray lines.

Figure 33. Spectrum with Smart Labels option turned on and off

Note  

• We recommend leaving peak lines displayed. They indicate the measured centroid 
location and provide information about the status of the energy calibration.

• The software does not display Peak Lines and KLM markers at the same time. If Show 
KLMs is selected in the Spectrum Settings KLMs group when you select Lines On, 
the peak lines will not be displayed.

Smart Labels selected Smart Labels deselected
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Select Peak Label Format (Short/Long)

Element labels can be displayed in a short form (element symbol only) or long form (element 
symbol and its X-ray line).

Figure 34. Spectrum with short and long format peak labels displayed

The long label format is useful for viewing which lines can be fluoresced at a given SEM 
accelerating voltage.

Note  Expanding an element peak allows more space to display element labels.

Note  Setting Labels to None turns off peak labeling.

Expanded 
spectrum of 
selected peaks

Short label format Long label format
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Select Peak Label Font

You can select the font, point size and color of displayed peak labels by clicking the Font 
button in the Peak group.

Figure 35. Select peak label font

The currently selected font and point size are displayed next to the Font button.

Customize How KLM Lines are Displayed

Characteristic KLM lines represent the energy of electron transitions between the K shell, 
L shell and M shell of an atom (or between their subshells) during X-ray analysis. You can 
display or hide KLM lines and change several properties that affect how KLM lines and labels 
appear in displayed spectra. Note that there can be several KLM lines in a single peak. Here is 
an example:

Figure 36. Spectrum with KLM lines displayed

KLM lines
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These settings are in the KLMs group in Spectrum Settings.

Here are brief descriptions of the options available for defining the appearance of KLMs 
displayed in the spectrum pane.

Feature Description

Show KLMs Show or hide K, L and M markers in displayed spectra.

Note: The software does not display KLM markers and peak lines 
at the same time. If Lines On is selected in the Spectrum Settings 
Peak group when you select Show KLMs, the KLM markers will 
not be displayed

Include Shells Specifies which markers (K, L, or M), or which combinations of 
markers, to display.

Scale Peaks Scales the height of the K markers such that the tallest K marker 
(usually K1) is the same height as the corresponding peak in the 
spectrum. It repeats this scaling for the L markers and M markers. 
Useful for finding hidden K, L, or M peaks.

Escape Peaks Marks the locations of any escape peaks for all elements in the 
displayed spectrum using a short marker bar

Sum Peaks Marks the locations of any sum peaks for all elements in the 
displayed spectrum using a short marker bar
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Adjust the Size of a Displayed Spectrum

Use these tools to expand or contract a displayed spectrum in order to see features of interest.

Using the Mouse

Using the Numeric Keypad

Transition Type Specifies which transition types between energy states to include.

Intensity Above % of 
max

Lets you define a minimum intensity value for display. Useful for 
filtering out lines with lower intensity values.

Feature Description

Table 8. Using the mouse to size a displayed spectrum

To... Do this...

Expand the spectrum Click the spectrum in the low energy range and drag it right
Or
Use the scroll wheel on the mouse to expand the spectrum 
around the current cursor position

Contract the spectrum To reduce the magnification of the spectrum and show a greater 
energy range, double-click the spectrum pane
Or
Use the scroll wheel on the mouse to contract the spectrum 
around the current cursor position

Scroll the spectrum Drag the spectrum left or right to scroll horizontally; drag it up 
or down to scroll vertically

Zoom in on a peak Hold down the Ctrl (or Shift) key on the keyboard while you 
drag the mouse cursor across the peak

Restore full spectrum 
view

To reset the X- and Y-axes to full spectrum view, double-click the 
spectrum pane

Table 9. Using the keyboard to size a displayed spectrum (action centers around energy cursor)

To... Use this keypad key...

Display the full spectrum Home (7)

Scroll left NumLock + Left Arrow (4)

Scroll right NumLock + Right Arrow (6)

Expand Page Up (9)

Contract Page Down (3)

Full vertical scale End (1)
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Manage Spectrum Files
After you acquire a spectrum—either from an acquisition in Spectrum mode or from a 
Spectral Imaging mode extraction viewed from Spectrum mode—you can change the file 
name of the spectrum, and delete a spectrum file. Elements can be identified and labeled 
automatically or manually.

Rename a Spectrum File

The current Experiment Name is automatically used as the base filename for each acquired 
spectrum. Subsequent spectra are given the same base name followed by the acquisition 
number.

To rename a spectrum file, select the file in the file list pane, click the Rename button on the 
file management panel, type a new filename and press Enter.

Figure 37. Rename a spectrum file

Increase vertical scale NumLock + Up Arrow (8)

Decrease vertical scale NumLock + Down Arrow (2)

Table 9. Using the keyboard to size a displayed spectrum (action centers around energy cursor)

To... Use this keypad key...

Note  If you enter the name of an existing spectrum file when renaming a file, the 
filename will not be changed.



 3 Spectrum Mode
Manage Spectrum Files

Thermo Scientific Pathfinder User Guide 81

Delete a Spectrum File

To delete a spectrum file, select the file in the file list pane and click the Delete button on the 
file management panel.

Figure 38. Delete a spectrum file

Open a Spectrum File

Files opened in Spectrum mode are handled as standard spectrum files. You can open files 
acquired using Pathfinder software, or EMSA format files acquired using a third-party EDS 
system.

 To open a spectrum file within a project

1. Open the project.

2. Click the Spectrum icon  on the analytical mode toolbar.

3. Select the file in the file list pane.

The file is displayed in the spectrum pane.

 To open (import) an EMSA file into the current project

1. Click the Spectrum icon  on the analytical mode toolbar.

2. From the Pathfinder Home screen, choose File > Open.

3. Navigate to the project folder that contains the file.

4. Select an EMSA (.emsa) file to import and choose Open.

NOTICE    Deleting a spectrum file permanently removes the data from the project and 
moves it to the computer’s Recycle bin.



3 Spectrum Mode
Qualitative Analysis

82 Pathfinder User Guide Thermo Scientific

The spectrum is copied to the current project’s temporary folder and inherits the current 
project’s settings.

5. To permanently save the file in the project, click the Save button  on the main 
toolbar, or choose File > Save.

Save a Spectrum

Spectra acquired in Spectrum mode are automatically stored in the current project’s 
temporary folder with an EMSA (.emsa) filename extension. When you close a project, 
Pathfinder displays a list of files that have been acquired or modified in the current session. 
Deselect those files you do NOT want saved. Choose OK to save the changes, or choose 
Cancel to close the Save dialog box and return to the project without saving any changes.

 To save a displayed spectrum without closing the project

Click the Save button  on the Main toolbar to save the file in the currently open project.

Qualitative Analysis
Qualitative analysis is the identification of elements that make up a specimen by recognizing 
the characteristic X-ray energy peaks associated with those elements in an X-ray spectrum. A 
qualitative analysis may be initiated automatically, immediately after an acquisition, or started 
manually at any time on any acquired spectrum. This section provides an overview of peak 
identification, guidelines to perform an accurate analysis, and general qualitative analysis 
procedures.

When qualitative analysis is done automatically, the software uses internal algorithms based 
on peak shape and location to identify the peaks in a spectrum. It is a good idea to manually 
inspect and refine the results in order to incorporate information about the sample and to 
resolve uncertainties due to overlapping peaks. The software also provides tools for identifying 
spectral peaks manually using KLM markers, which show the K, L, and M lines associated 
with each element. Both methods are explained in this section.

To perform an accurate qualitative analysis, acquire spectral data long enough to achieve 
sufficient counts for a good statistical analysis. A general rule is to acquire at least 5,000 
counts (vertical full scale) at 25 to 30 percent dead time at the longest time constant. Be aware 
that some peak energies are shared by more than one element. That fact, and the inherent 
resolving power of the EDS detector, results in the overlap of energy peaks in the spectra.
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Set Up Automatic Element Search and Identification

 To set up automatic element search and identification

1. Click the Spectrum Processing icon  on the controls panel.

The following options are displayed.

2. Click Ident Setup and then click the green arrow to show the Advanced view.

3. Make sure Auto ID is selected.

4. In the Peak Removal group, select Sum Peak Removal and Escape Peak Removal.

5. Set Overvoltage to 1.5 and set the Ident Sensitivity bar between 5 and 10.

The sensitivity setting determines the minimum peak height for element identification. A 
lower sensitivity value increases the number of peaks that are identified, especially the 
smaller peaks. (A higher sensitivity value reduces the number of peaks that are labeled and 
leaves only the larger peaks.)

Advanced View 
toggle setting
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When Auto ID is selected, preliminary identification results are displayed during the 
acquisition with a final update after the acquisition is completed. Sum peaks and escape peaks 
are removed after the acquisition is completed and before the final results are displayed.

Element Search and Identification Settings

Use Ident Setup on the Spectral Processing tab to define how element search and 
identification works for an acquired spectrum. You can set up the software to perform the 
analysis at run time or you can run it manually after an acquisition is completed.

The following element search and identification settings are available in advanced view.

To access these settings, click the Spectrum Processing icon  on the controls panel, click 
Ident Setup and then click to toggle the green arrow so it looks like this:

Note  When Auto ID is off, use the Process button on the controls panel to start 
automatic qualitative analysis using the displayed spectrum or the selected file.

The Identify button below the periodic table starts automatic qualitative AND 
quantitative analysis.

Advanced View 
toggle setting
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Table 10. Spectrum Mode Ident Setup, Advanced View

Group Setting Description

Auto ID Automatically performs element search and identification during a 
spectrum acquisition.

When Auto ID is selected, preliminary identification results are 
displayed during the acquisition with a final update after the 
acquisition is completed. Sum peaks and escape peaks are removed 
after the acquisition is completed and before the final results are 
displayed.

Peak Removal Sum Peak Removal Automatically removes any sum peaks from the spectral data. A sum 
peak occurs when two or more X-ray events reach the detector at 
exactly the same time. The two events are processed as a single pulse 
with a magnitude equal to the sum of the individual pulses.

When Sum Peak Removal is selected, the software determines 
which X-ray events generated sum peaks and transfers those counts 
into the appropriate component X-ray lines.

Sum peak removal is an additional processing step that occurs 
immediately after the acquisition is completed. The software always 
saves the originally acquired spectrum. It is always possible to return 
to the original, uncorrected data. Sum peak removal affects both 
qualitative and quantitative analysis.

Notes:
• To toggle sum peak removal on and off for a displayed 

spectrum, use Spectrum (menu) > Remove Sum Peaks.
• You can reduce the magnitude of sum peaks by reducing the 

count rate.
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Escape Peak Removal Escape Peak Removal automatically eliminates the effects of escape 
peaks from the spectral data. An Escape peak is an artifact peak that 
occurs when an Si K X-ray photon is produced near the surface of 
the detector as a result of the interaction between an incoming 
X-ray photon and the detector. If the Si K X-ray photon escapes 
from the detector, the energy measured for the original incoming 
X-ray photon will be reduced by the energy of the Si X-ray photon.   
The artifact peak always has an energy that is 1.74 keV less than the 
original X-ray photon.

When Escape Peak Removal is selected, the software calculates the 
probability of escape peaks in the spectrum, removes the escape 
peaks from the spectrum and adds the counts to the parent peaks.

Escape peak removal is an additional processing step that occurs 
immediately after the acquisition is completed. The software always 
saves the originally acquired spectrum. It is always possible to return 
to the original, uncorrected data. Escape peak removal affects both 
qualitative and quantitative analysis.

Note: 
• To toggle escape peak removal on and off for a displayed 

spectrum, use Spectrum (menu) > Remove Escape Peaks.
• Escape events are relatively rare under most conditions. Usually 

the magnitude of an escape peak is, at most, a few percent of 
that of its parent peak.

Table 10. Spectrum Mode Ident Setup, Advanced View

Group Setting Description
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Identify Elements Using the Periodic Table

When element identification is performed automatically, the software creates a list of possible 
elements identified from the spectrum and highlights them on the periodic table in the 
element setup pane. Depending on the display settings and the peak label settings, the spectral 
peaks associated with these elements may also be labeled in the spectrum pane. You can refine 
these results to search for or identify specific elements or to exclude other elements from the 
analysis.

If you know the sample composition and want to limit the analysis to specific elements, you 
can turn off automatic element identification and use the periodic table to specify elements 
for identification.

Ident Sensitivity Determines the minimum peak height for element identification. A 
lower sensitivity value increases the number of peaks that are 
identified, especially the smaller peaks. (A higher sensitivity value 
reduces the number of peaks that are labeled and leaves only the 
larger peaks.)

Available settings range from 1 to 100. Typical settings are between 
5 and 10.

Overvoltage In electron microscopy, overvoltage is the ratio of the accelerating 
voltage of the electron beam relative to the ionization energy for a 
given X-ray emission line. The ionization energy is always slightly 
higher than the corresponding X-ray emission line. Thus, a simple 
rule of thumb is that the overvoltage is the ratio of the accelerating 
voltage to the energy of the X-ray emission.

Available settings are 1 to 2. To obtain adequate emission for most 
analyses, we recommend using an overvoltage setting of at least 1.5.

Note: The peak identification software uses the Overvoltage setting 
to determine which peaks should be considered for labeling. If the 
accelerating voltage is 20 kV and the Overvoltage is 2, then peaks 
above 10 keV will not be considered for labeling. If the Overvoltage 
is reduced to 1.5, then the peaks above about 13 keV will not be 
considered for labeling. Keep in mind that the probability of 
generating an X-ray emission decreases rapidly in the low 
overvoltage range (below 1.5).

Table 10. Spectrum Mode Ident Setup, Advanced View

Group Setting Description

Note  Your selections in the periodic table do not change when you select a different 
analytical mode. This lets you analyze a spectrum in one mode, then switch to another 
mode and use the same analysis results.
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 To identify selected elements using the periodic table

1. In the element setup pane, right-click the symbol for the element you want to identify.

2. In the shortcut menu, choose Identified (or Always Identified).

The symbol for that element changes to green (identified) or pink (always identified).

3. If there are found elements you want to exclude, right-click each element symbol and 
choose Excluded (their symbols change to dark grey).

Note  

• You can also left-click an element to scroll through the available settings 
(Identified, Inactive, Excluded, or Always Identified). The color of the element 
indicates its current setting. The legend shows the color assignments.

If the legend is not displayed in the software, choose View (menu) > Preferences 
and, in the Periodic Table Options, select Show Legend.

• Hydrogen (H) and Helium (He) do not generate X-rays that are detectable using 
EDS and their element names are unavailable in the software. Lithium (Li) and 
several groups of elements including the noble gases, the lanthanides and the 
actinides, are set to Excluded by default. However, you can reset Li or individual 
elements in these groups if they are present in the samples.

To toggle all the elements in a group between Excluded and Inactive, right-click 
any element and, from the shortcut menu, choose Group and then select the 
group name.
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4. Click the Process button to start automatic qualitative analysis using the selected 
elements.

The button is located at the bottom of the Ident Setup tab in the Spectrum Processing 
group on the controls panel.

Exclude Elements from Analysis

 To exclude an element from any analysis

1. In the element setup pane, right-click the element you want to exclude.

2. In the shortcut menu, choose Excluded.

The symbol for that element changes to dark grey.

Note  The Identify button below the periodic table starts automatic qualitative AND 
quantitative analysis.
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Clear Identification Results

Use the Clear button at the bottom of the element setup pane to reset the element selections 
in the periodic table.

There are several options described below:

Identify Elements in a Spectrum

The automatic peak identification function labels each peak that the software identifies. 
When KLM markers are not displayed, the software can display lines, called “peak markers,” 
that indicate the locations of the found peaks. Use these markers as a starting point for 
manual peak identification.

The software provides several tools for refining element identification including peak markers, 
KLM markers and peak labels.

Table 11. Element Setup Pane, available Clear options

Setting Description

Clear All If an element is set to Identified (green) or Always Identified 
(pink), Clear All resets it to Inactive (light grey). If an element is 
set to Excluded, it will be unchanged.

Reset to Default Reset all elements to their default settings. Elements that are 
excluded by default, for example Li, the noble gases, the 
lanthanides and the actinides, are set to Excluded (dark grey). 
Everything else is set to Inactive (light grey).

Reset ROIs (Regions Of 
Interest)

Reset the Mapping Energy Region Of Interest (ROI) for all 
elements to their default values. These ranges can be set 
manually by right-clicking an element, choosing Advanced and 
entering new values.

Clear All WDS Element that are selected for WDS have a purple triangle in the 
upper left corner of the element symbol in the periodic table). 
Clear All WDS resets these elements to Inactive (light grey).
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Use Energy Cursor to Identify Elements in a Spectrum

 To identify elements using the energy cursor

To view a list of possible elements associated with an identified spectral peak, place the energy 
cursor over the centroid of the peak of interest. Elements with a K, L or M X-ray line near the 
energy at the cursor position are highlighted with a dark colored triangle in the upper right 
corner of the element name in the periodic table.

Figure 39. Elements near energy cursor are highlighted with dark triangle in upper right

You can change any of them to Identified if they match the element you are seeking. Some 
knowledge of the sample and other element peaks is useful in determining which elements 
should be identified manually.

Use KLM Markers to Identify Elements in a Spectrum

 To display KLM markers

You can use KLM Markers for a selected element to aid in positively identifying an element. 
First, make sure KLM markers are displayed in the software (in Spectrum Settings, select 
Show KLMs).
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Click an element in the periodic table to display the X-ray lines associated with that element. 
The symbol for the element that has its KLM markers displayed appears in the lower left 
corner of the spectrum pane, along with the element’s Z number. Here is an example:

 To adjust the number of KLM lines displayed

1. Use the features in the KLMs group of Spectrum Settings to adjust the number of KLM 
lines displayed for all identified peaks in a spectrum.

2. Set Include Shells to the shells you want displayed (K, L, M or All). We recommend 
setting Include Shells to All.

3. Set Transition Type to the number of transitions you want to include (1 to 3, 1 to 2, 1, 
or All). We recommend setting Transition Type to All.

4. To adjust the number of lines that appear at various levels of X-ray intensity, select the 
intensity level to display. We recommend setting Intensity Above % Of Max to All.

These selections will show all KLM Lines, including minor lines such as L and M.

KLM marker
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 To scroll through the KLM markers in a displayed spectrum

Use the Previous and Next arrow buttons at the bottom of the element setup pane (or click 
the spectrum pane and use the left and right arrow keys on the keyboard) to scroll through 
element KLM markers by atomic number, starting with the selected element.

 To search for elements using their KLM lines

You can position the energy cursor at an energy location on the displayed spectrum and search 
for elements with KLM lines that are higher or lower than that energy location by using the 
Element Search Up and Element Search Down buttons in the element setup pane. (You can 
also click the spectrum pane and use the up and down arrow keys on the keyboard.)

The Element Search Up/Down buttons use the energy reading at the energy cursor to search 
the software’s internal database of element lines and displays candidate KLM markers for each 
element found.

A high pitched beep means Pathfinder found an element X-ray line near the current cursor 
location. The found element is outlined in red in the periodic table and its KLM lines are 
shown on the spectrum. The elements with KLM lines near the cursor have cyan triangles in 
the element. A low pitched tone means you have reached the end of the possible elements for 
that cursor location.

Label Identified Peaks Manually

After you have identified a peak, you may want to label it on the spectrum for reference and 
reports. To label a peak, right-click its associated element in the periodic table and choose 
Identified (green) or Always Identified (pink).
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Change How Peak Labels are Displayed

The features in the Peak group in Spectrum Settings specify how peak labels appear in 
displayed spectra.

Figure 40. Peak settings

Set Labels to Short to display element symbols only, or Long to display element symbols and 
lines.

You can also change the font and color of peak labels using features in the Peak group in 
Spectrum Settings.

Delete Peak Labels

To delete all the peak labels for one element, right-click the element in the periodic table and 
select Inactive from the shortcut menu.

Note  Setting Labels to None turns off peak labeling. If you try to label an individual 
peak, the label will not appear on the spectrum until Labels is reset to Short or Long.
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To delete a single peak label, click the peak label so it is outlined and then press the Delete key 
on the keyboard. The element symbol for that peak is removed.

Figure 41. Selected Peak Label

Add Peak Labels

You can label specific elements for reference and reports.

To label all the peaks for a particular element, right-click the element in the periodic table and 
choose Include. If you just want to label an individual peak, manually delete the unwanted 
peak labels.



3 Spectrum Mode
Qualitative Analysis

96 Pathfinder User Guide Thermo Scientific

Select the Element Assigned to a Peak

To view possible overlaps for a found element, double-click the element label. A selection box 
lists the elements that emit in that energy range. To change the element assigned to the 
selected peak, select an element in the list and choose OK. The peak is relabeled with the new 
name.

Figure 42. Change the Element Assigned to a Peak

Use Spectra Check to Verify Peak Identification

Spectra Check is a tool for confirming peak assignments in a displayed spectrum. Use it after 
you have finished reviewing and adjusting peak assignments in a spectrum.

When the Spectra Check took is selected, it generates three synthetic spectra:

• Synthetic Spectrum. The software uses reference spectra from its internal database to 
calculate a synthetic spectrum based on the elements selected in the periodic table (i.e., set 
to Identified or Always Identified).

• Background. The calculated background for the displayed spectrum.

• Residual. The software subtracts reference spectra for the elements selected in the 
periodic table from the original spectrum to create a residual spectrum, which shows the 
peaks that are not accounted for in the original spectrum.
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 To activate Spectra Check and display the synthetic spectrum

1. Click the Compare button on the file management panel (along the right edge of the file 
list pane).

You can skip the normalization setting. 

The button stays highlighted to show that it is active.

Note  A theoretical model of the background shape and spectrum can be created if the 
following sample characteristics are known:

• approximate mass of the sample
• energy of the excitation electrons
• geometry of the system
• characteristics of the detector

Synthetic models provide visual evidence of the accuracy of a qualitative analysis and 
indicate whether a given sample is suitable for quantitative measurements.

Note  If the file list pane is not visible, click the green arrow to collapse Advanced 
View.
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2. Click the Spectra Check  button on the file management panel.

The button stays highlighted, to show that it is active, and the software adds 3 spectral 
files to the top of the file list (synthetic, background and residual).

3. Click Synthetic Spectrum in the file list so its selection box is highlighted (red).

The synthetic (red) spectrum is displayed in the spectrum pane, overlaid on the original 
(white) spectrum. The synthetic spectrum is based on the selected elements in the 
periodic table and is normalized to the displayed spectrum using the Maximum 
normalization algorithm.
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In this example, there is an element near Mo that is not identified.

Hover the mouse cursor over the title bar in the results pane to view the “goodness of fit” 
value (2) for the two spectra.

4. Use one of the following methods to identify the missed peak:

– Reference subtraction

– Nearest neighbor
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 Using reference subtraction to identify a missed peak

1. From the Home screen, choose Spectrum (menu) > Reference Subtract/Add to display 
the Elements to Subtract selection window.

2. In the Select Elements To Subtract box, select the Mo (L) line and click Apply.

The software subtracts a reference spectrum for the Mo (L) line from the original 
spectrum. The resulting (white) spectrum has the Mo (L) line removed.

3. Click the Identify button in the element setup pane.

The element Nb is now identified.
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4. Right-click the element Nb in the periodic table and set it to Identified.

The synthetic spectrum now outlines the missed peak and the (2) value has decreased 
from 16.8 to 3.8.

 Using the “nearest neighbor” method to identify a missed peak

1. Move the energy courser over the missed peak.
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Elements with a K, L or M X-ray line near the energy at the cursor position are 
highlighted with a dark colored triangle in the upper right corner of the element name in 
the periodic table.

2. Add the elements to the spectrum one at a time and view the fit to the overlaid synthetic 
spectrum.

Start with the element with the lowest Z number (Zr in this example). To add an element 
to the spectrum, right-click the element name in the periodic table and choose 
Identified. To remove an element, right-click its name and choose Excluded. When the 
peaks in the synthetic spectrum match the peaks in the original spectrum, you have 
correctly identified the missed element.

Compare Spectra

Use the Compare tool to overlay two or more spectra in the spectrum pane for comparison.

 To select multiple spectra for display

1. Display the spectrum you want to compare.

We will call this spectrum the “original” spectrum.

2. Click the Compare button on the file management panel (along the right edge of the file 
list pane)

The button stays highlighted to show that it is active.
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3. Select a normalization setting for the comparison spectra.

The normalization setting has no effect on the original spectrum. The available options 
are described below.

Note  If the file list pane is not visible, click the green arrow to collapse Advanced 
View.

Setting Description

None No normalization factor is applied

Livetime Normalizes the overlapped spectra based on the live time of 
the overlapped spectrum compared to the live time of the 
original spectrum. This simulates the same acquisition times 
for both spectra.

Element Adjusts the overlapped spectra to the height of the selected 
element peak or line in the original spectrum. The selected 
peak or line is based on accelerating voltage and the energy 
range of the spectrum.

Multiplier Enter a value that will be used to scale all overlapped spectra

Range Scales the overlapped spectra to the original spectrum based 
on a selected energy range. When Normalize To is set to 
Range, two dashed vertical lines are added to the displayed 
spectra. (If you don’t see the vertical lines, double-click to 
expand the spectrum pane.) Drag the lines left and right to 
define the left and right boundary of your selected range.

Note: Defining a range in a background region (between 
element peaks) sometimes gives the best results.
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4. Select one or more spectra to overlay by clicking their names in the file list pane so their 
selection boxes are highlighted (red).

In this example, the synthetic spectrum generated by a Spectra Check is selected for 
overlay.

Each overlaid spectrum selected in the file list pane is displayed in the spectrum pane in a 
unique color in outline mode.

Maximum Scales the overlapped spectra to the original spectrum based 
on their maximum peak values in the displayed region

Maximum in Overlap If the overlapped spectrum intersects the original spectrum, 
the software scales the maximum peak value in the 
overlapped spectrum to match the maximum peak value in 
the original spectrum.

Note: This setting is intended for WDS data where the 
spectra may not cover the same energy range but still overlap 
in some energies.

Setting Description

Original spectrum (white) Overlaid spectrum (red)
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Quantitative Analysis
Quantitative analysis determines the chemical composition of a sample by calculating the 
relative concentrations of chemical elements in the sample from the relative X-ray counts and 
applying matrix corrections. The matrix corrections adjust for atomic number, absorption, 
and secondary fluorescence effects. The general steps are outlined below:

1. The background characteristics are removed from the sample spectrum. When using 
Filter Fit, the background is removed using a “top hat filter.” When using Gaussian peak 
fitting, the peaks and background are fit using a model.

2. The software determines the net X-ray counts in each peak.

3. An iterative process is used to calculate a matrix correction by simultaneous equations 
with the element concentrations as unknowns.

4. Element concentrations are calculated by multiplying a measured K-ratio by the matrix 
correction.

5. The data are normalized to 100% and the results are reported.

This section provides guidelines for setting up and performing an accurate analysis.

Specify the Element Lines Used for Quant

The software assigns the element lines used for quantitative analysis based on the element and 
the accelerating voltage. This is typically the dominant line for each element. However, if the 
accelerating voltage is not high enough to excite the line properly, the software may select a 
line that is lower in energy instead.

Note  Before you quantify a new sample, run a qualitative analysis and verify that the list 
of elements present in the sample is accurate. See Qualitative Analysis and Using 
Spectra Check to Verify Peak Identification for more information.
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You can specify the element lines used for quantitative measurements by right-clicking the 
element symbol in the periodic table. From the shortcut menu, choose Quant Lines and 
select an available line.

Figure 43. Select Element Lines Used for Quant

Exclude an Element from Quant Results

You can include an identified element, such as a coating, in the matrix correction calculation 
but not report quantitative results for that element by right-clicking the element symbol in 
the periodic table. From the shortcut menu, choose Quant Lines and select Absent. When 
Quant Lines is set to Absent, a series of dashes (-----) appear in any displayed quantitative 
results cell for that element.

Set Up Automatic Quantitative Analysis

Use Spectrum Processing on the controls panel to set up a quantitative analysis. Auto Quant 
with no standards are sufficient for most analyses. For information about the standards 
manager or running quant with standards, see Quant with Standards.

 To set up automatic quantitative analysis

1. Click the Spectrum Processing icon  on the controls panel.

Note  

• Some elements may have only one line available for quantitative measurements.

• The Absent setting excludes the selected element from the quantitative results. For 
more information, see Exclude an Element from Quant Results.

Note  This change is applied to all future analyses in the current project until the element 
line for that element is changed.



 3 Spectrum Mode
Quantitative Analysis

Thermo Scientific Pathfinder User Guide 107

The following options are displayed.

2. Click Ident Setup and make sure Overvoltage is set to 1.5 or higher.

Overvoltage is in the advanced view. Typically, the accelerating voltage should be 1.5 to 2 
times greater than the highest X-ray energy line. The software uses this value to select a 
major X-ray line for quantitative measurements.

3. Click Quant Setup and then click the green arrow to show the Advanced view.

4. Make sure Auto Quant is selected and set Quant Method to Standardless.

5. Set Peak Fit Method to the algorithm you want to use to determine the peaks and remove 
the background.

These options are available:

• Filter Fit (default). Applies a digital “top hat” filter to remove the background and 
determine the peaks.

Normal/Advanced 
View toggle

Advanced View 
toggle setting

This area is used 
only for quant 
methods with 
standards
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• Gaussian. Uses Gaussian shapes to model the peaks. Uses a theoretical model to fit 
the background.

6. In the Correction Method group, select a matrix correction that suits the samples to be 
analyzed.

These options are available:

• None. Only net counts are reported.

• ZAF. Used primarily in metallurgical SEM applications.

• Proza. Used in SEM applications, especially for light elements. This is the default 
setting and the recommended setting for most sample analyses.

• Cliff-Lorimer (MBTS). Used in TEM/STEM applications only.

When Auto Quant is selected, preliminary quantitative results are displayed during the 
acquisition with a final update after the acquisition is completed. Sum peaks and escape peaks 
are removed after the acquisition is completed and before the final results are displayed.

Note  If you want to specify the ratio element for the Cliff-Lorimer correction, see 
Select Ratio Element for Cliff-Lorimer Correction.

Note  When Auto Quant is off, use the Process button on the controls panel to manually 
quantify the displayed spectrum or the selected file.
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Quantitative Analysis Settings

Use Quant Setup on the Spectral Processing tab to define quantitative analysis for an 
acquired spectrum. You can set up the software to perform the analysis at run time or do it 
manually after an acquisition is completed.

The following quantitative analysis settings are available in advanced view.

To access these settings, click the Spectrum Processing icon  on the controls panel, click 
Quant Setup and then click to toggle the green arrow so it looks like this:

Advanced View 
toggle setting
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Table 12. Spectrum Mode Quant Setup, Advanced View

Group Setting Description

Advanced View Quant Method Defines the type of quantitative method that will be used for 
quantitative measurements. Available options:

• Standardless. A quantitative method without standards. This is 
the typical setting for most X-ray analyses.

• Standards. A quantitative method that uses one or more 
standards for calculating sample results. Use the Standards 
Manager to select a standards database and to define standards 
for this analysis.

Standards Manager Used to set up a database of standards for any analysis and to define 
standards for the current analysis.

Peak Fit Method Defines the algorithm use to determine the peaks used for 
quantitative measurements and also to remove the background. 
Available options:

• Filter fit. Applies a digital “top hat” filter to remove the 
background and determine the peaks.

• Gaussian Fit. Uses Gaussian shapes to model the peaks. Uses a 
theoretical model to fit the background.

If the quant method includes standards, both peak fit algorithms 
will use the selected standards.
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Correction Method Defines a matrix correction method for the analysis. These options 
are available:

• None. No matrix correction is applied. The quantification 
results include only the intensity and net counts. Results such 
as weight percent are not reported.

• ZAF. Reports net counts and weight percentages. Uses classical 
formulas to adjust for average atomic number (Z) (Duncumb 
and Reed), absorption (A) (Heinrich), and fluorescence (F) 
factors. These factors influence spectrum differences between 
elements in pure form and elements in composition. Used in 
metallurgical SEM applications.

• Proza (Phi-Rho-Z). Reports net counts and weight 
percentages. Similar to ZAF but uses the Phi-Rho-Z technique 
to calculate the atomic number (Z) and absorption (A) 
corrections. Used in SEM applications, especially for light 
elements in a heavy matrix.

Proza is the default setting and the recommended setting for 
most sample analyses.

• Cliff-Lorimer (MBTS). Reports net counts and weight 
percentages. Provides metallurgical and biological thin-section 
(MBTS) corrections based on relative elemental K factors 
(Cliff-Lorimer factors). Assumes samples are infinitely thin 
(i.e., no absorption or fluorescence). Used for TEM and STEM 
applications only.

Absorbance. Select this option to use the Cliff-Lorimer 
correction described above with an absorption correction for 
thicker samples. Enter the sample thickness in nm and its 
density in g/cc).

Note: 
• If you want to specify the ratio element for the Cliff-Lorimer 

correction, see Select Ratio Element for Cliff-Lorimer 
Correction.

• Bulk matrix corrections (Proza or ZAF) do not work with 
TEM thin sections.

Table 12. Spectrum Mode Quant Setup, Advanced View

Group Setting Description
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Quantify Elements Manually

When quantitative analysis is performed automatically, the software quantifies all the 
elements listed as Identified (green) or Always Identified (pink) in the periodic table.

If you know the sample composition and want to limit the quantitative results to specific 
elements, you can turn off automatic identification and use the periodic table to specify the 
elements to quantify.

Calculate all elements as 
compounds

Selecting this option changes all reported elements to their 
associated compounds. The associated compound is the compound 
that is currently selected in the Compound Formula list in the 
Advanced Element box (default is the first compound in that list). 
To open the Advanced Element box, right-click the element in the 
Element Setup pane and choose Advanced. Here is an example:

Note: To add measured compounds to the results pane, click the 
Options button in that pane and make sure Compound% is 
selected for display. To add the compound name to the results table, 
make sure Chemical Formula is also selected for display.

Normalize cations based 
on the following 
number of oxygen 
atoms

This setting enables the software to calculate the stoichiometry of 
an oxide, typically a mineral, from a quantitative analysis. For 
example, if you suspect the analysis was done on an olivine, which 
has a chemical formula (Mg,Fe)2SiO4, set “Normalize Cations 
Based On...” to 4. When viewing the numbers of cations in the 
results, if the Mg and Fe values sum to 2, and Si=1, the analysis has 
stoichiometry consistent with an olivine. If not, the results likely 
represent some other oxide, or they indicate a poor analysis.

Note: To add a No. of Cations column to the results pane, click the 
Options button in that pane and make sure No. of Cations is 
selected for display.

Table 12. Spectrum Mode Quant Setup, Advanced View

Group Setting Description
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 To quantify the selected elements manually

1. Acquire a spectrum for a sufficient amount of time to allow for a good statistical analysis. 

For quantitative measurements, use more than 5,000 counts vertical full scale and less 
than 30% dead time. Recommended acquisition settings:

2. Run a qualitative analysis on the spectrum and confirm the list of found elements.

3. If there are found elements you want to exclude from the quantitative results, right-click 
each element symbol in the periodic table and choose Excluded (their symbols change to 
dark grey).

4. Click the Spectrum Processing icon  on the controls panel, click Quant Setup and 
then click to toggle the green arrow to open the advanced view.

Recommended quant settings:

Note  Your selections in the periodic table do not change when you select a different 
analytical mode. This lets you analyze a spectrum in one mode, then switch to another 
mode and use the same analysis results.

Feature Recommended Setting

Live Time Limit 30 seconds

Max Peak Counts 0

Low Energy Cutoff 100 eV

High Energy Cutoff 20 keV for SEM applications
40 keV for TEM or STEM applications

Time Constant Rate 1

Note  The accuracy of the qualitative results impact the quantitative analysis. For 
more information, see Qualitative Analysis and Using Spectra_Check to Verify Peak 
Identification.

Feature Recommended Setting

Auto Quant Selected

Quant Method Standardless (adequate for most analyses)
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5. Click the Options button in the results pane and select column headings for the reported 
results.

6. Click the Process button to manually quantify the spectrum.

The button is located at the bottom of the Quant Setup tab in the Spectrum Processing 
group on the controls panel.

When the analysis is completed, the results are displayed in the results pane.

Set an Element Weight Percent to a Fixed Value

 To set the reported weight percentage for an element to a fixed value

1. Right-click the element and choose Advanced.

Peak Fit Method Select a peak fit algorithm that suits the samples to be 
analyzed. Available options:

• Filter Fit. Applies a digital “top hat” filter to remove the 
background and determine the peaks.

• Gaussian. Uses Gaussian functions to calculate and 
subtract a theoretical background and determine the 
peaks.

Correction Method Select a matrix correct that suits the samples to be analyzed. 
Available options:

• None. Reports net counts only.
• ZAF. For metallurgical SEM applications.
• Proza. For SEM applications, especially light elements.
• Cliff-Lorimer (MBTS). For TEM and STEM 

applications.

Note  You can change the elements used for quantitative analysis at any time or any of the 
settings in Quant Setup. After you change an element or setting, click the Process button 
to rerun the analysis and update the results pane.

Feature Recommended Setting
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2. In the Advanced Element box, set Quantification of Weight% to Fixed and type a 
weight percentage in the associated entry box.

The software sets the weight percentage for this element to the entered value and takes 
that into account when calculating the quantitative results for other elements.

Report Compounds by Stoichiometry

You can associate specific compounds with individual elements in the periodic table, or 
configure the software to use the associated compounds for all identified elements.

 To associate a specific compound with an element

1. Right-click the element symbol in the periodic table and choose Advanced.

2. In the Advanced Element box, select Use Compound.

3. Select a item in the Compound Formula list.
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 To use the associated compounds for all elements

1. Click the Spectrum Processing tab on the controls panel, click Quant Setup and toggle 
the green arrow to show the advanced view.

2. Select Calculate All Elements As Compounds.

When this option is selected, the software reports the compound formula associated with 
each element instead of the pure element. This is true even if individual elements do not 
have their Use Compound boxes selected (see the previous section).

If you selected a compound for an element, the selected compound is reported. If you did 
not select a compound for an element, the first element in that element’s compound 
formula list is reported.

Additional Tools in Spectrum Mode

Reference Subtract/Add

You can subtract (or add) one or more element peaks or X-ray lines from (or to) the displayed 
spectrum using reference peaks from the software’s internal database. The spectrum must be 
quantified before you can subtract or add a reference peak.

 To subtract (or add) an element peak from (or to) the displayed spectrum

1. Display the spectrum you want to process.

2. From the Home screen, choose Spectrum (menu) > Reference Subtract/Add.

3. In the Select Elements To Subtract box, select Subtract or Add.

4. Select one or more element peaks or X-ray lines from the list or click Select All to select 
all the available lines.

The list includes all the elements found in the displayed spectrum.

5. Choose Apply (or OK) to complete the subtraction (or addition).

The resulting (displayed) spectrum has the selected peaks removed (or added).

Note  

• Leave Normalize Cations Based On The Following Number Of Oxygen Atoms set 
to zero. The software calculates the number of oxygen atoms based on the most 
common valence. Change this value only when the number of oxygen atoms is 
known.

• To add the compound name to the results pane, click the Options button in that 
pane and make sure Chemical Formula is selected for display.
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Element X-ray Lines

Use the Element X-Ray Lines feature in the Spectrum menu to quickly find the energy or 
relative intensity value of an element and X-ray line from the software’s internal database.

 To reference the energy or intensity value for an X-ray line

1. From the Home screen, choose Spectrum (menu) > Element X-Ray Lines.

2. In the X-Ray Lines box, set Element to the element you want to reference.

3. Set Line Series to the type of X-ray lines for the selected element (K, L or M).

The energy in keV and relative intensity value for the select X-ray lines are displayed.

4. Choose OK.

Batch Process

You can quantify a number of spectra and save the results as a CSV (Comma Separated 
Values) file (.csv filename extension) which can be opened in a spreadsheet application, such 
as Microsoft Excel, for further mathematical analysis.

Note  These operations create a copy of the spectrum before making modifications. The 
original spectrum is not changed.

Note  The features in the Selected Line group allow you to edit the stored reference 
values for any element. However, these values are generally accepted physical 
constants and, thus, should not be changed.



3 Spectrum Mode
Additional Tools in Spectrum Mode

118 Pathfinder User Guide Thermo Scientific

 To batch process spectra

1. From the Home screen, choose Batch Processing (menu) > Spectrum Analysis.

2. In the Select Type of Spectrum Processing to Perform window, select whether, as part of 
the batch process, you would like to Remove Escape Peaks, Remove Sum Peaks, Identify 
Elements, Quantify Elements or Match Spectrum.

3. Then click OK.

4. In the Select Files window, locate and select the spectrum (.emsa) files to process (use Ctrl 
or Shift keys to select multiple files) and click Open.

5. In the Enter a Filename box, type a filename for the csv file, select a folder for saving the 
file and choose Save.

Region Tool

Use the region tool to extract peak counts or rate data from a spectrum. You can also perform 
mathematical manipulations on element data in a spectrum. For example, you can add, 
subtract, multiply or divide peak counts or peak rates of elements in a spectrum. You can also 
determine the net and gross counts of a single peak or determine a ratio (divide) of two 
elements in a spectrum or X-ray line ratio.

 To use the region tool to extract peak information

1. Display the spectrum you want to extract peak information for.

2. From the Home screen, choose Spectrum (menu) > Region Tool.

Note  Batch processing can only be used on files that have been saved in the project folder 
(no temp files). To save files to the project folder, choose File (menu) > Save or click the 
Save button  on the main toolbar.

Note  If you select Quantify Elements above, you may want to clear (deselect) Identify 
Elements and predetermine your element list before you start the batch process.
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If the Spectrum menu is not displayed, click the spectrum pane.

3. Set Element to the desired element.

4. Set Line to an available X-ray line for the selected element.

5. Set Data Type to Counts or Rate.

6. Set Operator to None.

7. Click the plus (+) button to add the operation to the Region Operations list.

The gross count (Gross Rate) and net count (Net Rate) results are displayed in the Region 
Operations box (background is subtracted first).

 To extract information for two element peaks 

1. From the Home screen, choose Spectrum (menu) > Region Tool.

2. Set the left Element box to the desired element for the first peak.

3. Set Line to an available X-ray line for the selected element.

4. Set the right Element box to the desired element for the second peak.

5. Set Line to an available X-ray line for the selected element.

6. Set Data Type to Counts or Rate.

7. Set Operator to the operation to perform (divide, multiply, add or subtract).

Note  

• To remove an operation, select the row in the Region Operations box and click the 
minus (-) button.

• Subtract net counts from gross counts to get the counts in the background.
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8. Click the plus (+) button to add the operation to the Region Operations list.

The results are displayed in the Region Operations box. (For example, element1 gross 
counts/element2 gross counts and element1 net counts/element2 net counts.)

 To extract information for a selected spectral region

1. From the Home screen, choose Spectrum (menu) > Region Tool.

If the Spectrum menu is not displayed, click the spectrum pane.

2. Click the Element box and type “user.”

3. In the User Region Range, type and region start and end in eV.

You can also drag the vertical region markers (dashed lines) right or left to define the 
region.

4. Click the plus (+) button to add the operation to the Region Operations list.
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The results are displayed in the Region Operations box.

Spectrum Math

Use Spectrum Math from the Spectrum menu to perform math operations on spectra. You 
can add, subtract, multiply and divide any or all of the spectra in a project by a constant or by 
another spectrum. In addition, you have the option of getting the average or summed 
spectrum from any of the project spectrum files.

 To perform math operations on spectra

1. Display the spectrum you want to use for math operations.

2. From the Home screen, choose Spectrum (menu) > Spectrum Math.

If the Spectrum menu is not displayed, click the spectrum pane.

3. In the Spectrum Math box, click Select.

4. In the Spectrum Selection box, set Files of Type to an available file type, select a file in 
the current project (use the Ctrl or Shift key to select multiple files) and choose OK. 

These file types are available:

Analytical Mode File Type

Spectrum .emsa

Point ID .psmsa
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You can also left double-click to select a file and close the Spectrum Selection box, or right 
double-click to add a file and close. The selected file(s) are listed in the Spectrum Math 
box.

5. Set Operator to the desired math operation (see below for details).

6. Set Operand. The following options are available:

– Constant. Select the constant in the list box or enter a value.

– Spectrum. Use the list box to select another spectrum in the current project.

7. Use the Result Name box to enter a filename for storing the math operation result.

8. Click Calc. Result to perform the operation.

A progress bar shows the progress of the selected math operation(s). When the operation 
is completed, the resulting spectrum is displayed in the spectrum pane.

Available Math Operators

Spectral Imaging .fzs and .fzsa

Linescan .lsmsa

Note  

• When selecting Average or Sum operations, each of the selected files are read into 
memory and the average or sum spectrum is generated by averaging or summing the 
data on a channel-by-channel basis. Selecting any of the other choices result in the 
math operation being performed on each of the selected files with a new result 
spectrum being created for each.

• All math operations are performed on a channel by channel basis. The calculations are 
conducted with floating pint arithmetic. Upon completion of the calculation for a 
given channel, the floating point number is rounded to the nearest integer count 
value before the result is stored. If the calculation results in a negative number for the 
number of counts in a channel, the negative value is stored in the spectrum. All result 
spectra are stored in the project’s temp folder. 

Analytical Mode File Type

Math Operator Result of Operation

+ (Add) Add to each spectrum

- (Subtract) Subtract from each spectrum

x (multiply) Multiply each spectrum

/ (divide) Divide each spectrum

Average Average several spectra

Sum Sum several spectra
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Reset the Spectrum Math Window

To clear the selected file list and reset the Result Name to a default based on the current 
experiment name, click the Reset button in the Spectrum Math box. It also resets the 
Operator to Add, the Operand Type to Constant and the Operand to 1.0.

Right-Click Menu

If you right-click when the cursor is within the Spectrum Math box boundaries, a menu is 
displayed so that you can easily perform common actions. the menu items include:

• Clear the Selected Spectra List. Removes all spectra from the selected file list without 
performing a complete reset of the Spectrum Math box.

• Add Current (displayed spectrum) to List. Provides an easy way to add a currently 
displayed spectrum to the selected file list.

• Calculate the Result Spectrum. Alternate way to calculate the result using the current 
settings in the Spectrum Math box.

Normalize Beam Current Normalize each spectrum by beam current

Note: When you normalize a spectrum to a constant 
beam current, the constant beam current is stored with 
the attributes of the result spectrum. The normalization 
of a constant beam current is the same as livetime 
normalization. The counts of the result spectrum are 
normalized to what they would be if the constant beam 
current had been used for the spectrum acquisition.

When you normalize a spectrum to another spectrum, 
the result spectrum has counts that would have been 
present if the selected spectrum had been counted with 
the same beam current as the Operand spectrum. Upon 
completion the result spectrum has attributes that 
reflect those of the Operand spectrum upon which the 
normalization is based.

Normalize Livetime Normalize Livetime (same note above applies to 
Normalize Livetime)

Normalize Beam Curr. and LT Normalize by both beam current and livetime

Normalize vertical full scale Normalize each spectrum by the maximum counts

Math Operator Result of Operation
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4

Electron Imaging Mode

This section covers electron imaging mode, which can be used to acquire, save and load 
electron image files. The images are saved in the standard TIFF (.tif ) file format. A ruler is 
provided for measuring objects in the image. Guidelines for setting up and acquiring images 
from a scanning electron microscope (SEM) are provided. With optional stage and column 
integration modules and the Analysis Automation software, you can also acquire and generate 
a single image from multiple images (montage).

Select Electron Imaging Mode
To select electron imaging mode, from the Pathfinder Home screen, choose View (menu) > 
Electron Imaging Mode.

Figure 44. Select Electron Imaging Mode
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Electron imaging mode contains all the necessary tools for collecting electron image data and 
for image data processing and file manipulations.

Figure 45. Electron Imaging Mode User Interface

Image pane Information pane Controls panel

file list paneImage pane toolbar Note box for adding comments to an image
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Acquire an Electron Image
The software is configured to acquire an electron image of the current microscope location on 
the sample. You can acquire an electron image two ways, as an averaged, static image or as a 
live image with continuous image acquisition. This section explains how to acquire the image 
both ways.

Acquire Averaged Electron Image

An averaged electron image is a static (on time) image of the microscope view. If you collect 
more than one frame (one scan per frame), the frames are averaged to produce the image.

 To acquire an averaged electron image

1. Insert the sample on the microscope.

2. Set the basic microscope parameters:

– From the Pathfinder Home screen, choose Edit > Microscope Parameters

– Set these microscope parameters and then choose Close

• Accelerating Voltage in kilovolts (kV)

• Magnification

• Working Distance in millimeters (mm)

3. Focus the sample (it should be in critical focus).

4. From the Pathfinder Home screen, choose View > Electron Imaging Mode.

Note  If your SEM has Column Communications, these parameters are entered 
automatically.
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5. Set the image parameters, or use one of the acquisition presets such as Fast Image or High 
Resolution or a User-Defined option (see the image below).

– Click the Electron Image Setup  button on the acquisitions toolbar (normal view 
toggle setting).

– In the Averaged Acquisition group:

• Set Resolution (image size in pixels) to 512x384. This setting provides a good 
trade off between acquisition time and resolution. (A 512 image can be digitally 
zoomed about 4 times before it becomes pixelated.)

• Use the Frame Time box to enter or select the number of seconds to acquire each 
scan. Generally, a 5–10 second Frame Time produces a good pixel-to-noise ratio 
with few averaged frames.

• Set Number Of Frames to 2. Acquiring two averaged frames (each frame is one 
complete scan) produces a good image under most conditions for the first 
acquisition; thus you can eliminate the need to change settings and reacquire the 
data.

– Make sure Use Input 1 is selected (selects the microscope input channel to generate 
the image).

Acquisition 
presets

Normal/Advan
ced View 
toggle setting

Electron
Image Setup
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6. Enter an Experiment Name, which will be used as a base name for saving the image files.

On the acquisitions toolbar, click the  button and enter the Experiment Name (or 
leave the default name).

7. Start the acquisition and wait for it to complete.

On the acquisitions toolbar, click Get Image. The Get Image button changes to Stop 
Image, and the Pause and Abort buttons appear.

The image progresses vertically in the image pane. The progress bar at the top of the 
Pathfinder window also shows the progress in real time.

Feature Description

Stop Image Stops image acquisition at the end of the current frame and 
save acquired data

Abort Image Stops image acquisition immediately without saving acquired 
data

Stop image 
acquisition

Abort image 
acquisition
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When the acquisition is completed, the acquired image appears in the image pane in the 
upper left corner of the Pathfinder window. Here is an example of a typical averaged 
electron image.

Figure 46. Example of typical averaged electron image displayed in imaging mode

The software saves the image automatically in the open project using the experiment 
name entered in step 6 above, plus a numeric ID and a .tif filename extension.

Acquire Live Electron Image (TV Scan)

TV Scan mode allows you to use Pathfinder software almost at a video rate to view selected 
locations on a sample and to optimize the image settings to match the microscope.

To acquire a live electron image using the default settings, set the acquisition preset to TV 
Scan and click Get Image.
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Electron Image Settings

Image Settings

The following settings are available for creating and viewing an electron image in Electron 
Imaging Mode.

Note  You can set Resolution and Frame Time for TV Scan acquisitions. See Electron 
Image Settings for details.

Table 13. Electron Imaging mode settings

Feature Group Setting Description

Electron Image 
Setup 

Averaged Acquisition Resolution Image size for averaged image acquisitions in pixels. 
(Your computer’s video adapter determines the 
number of Y pixels). A higher resolution produces 
greater image detail but may increase acquisition 
time. Recommended setting is 512.

Frame Time (s) Time in seconds to acquire one frame. A frame is 
one complete scan from the upper-left corner to the 
lower-right corner of the image. A long frame time 
reduces image noise but increases acquisition time. 
A short frame time can result in blurred, streaked or 
noisy images. Optimum values depend on beam 
current, microscope and detector type (BS or SE).

Select Fastest to automatically select the fastest 
possible frame time for a given image resolution. 
Recommended setting is 5 seconds.

Dwell Time (us) Shows the length of time the beam will remain at 
each pixel location in seconds (based on the 
current Resolution and Frame Time settings). A 
long dwell time reduces image noise but increases 
acquisition time. A short dwell time might cause a 
blurred, streaked or noisy image.

Number of Frames Total number of frames to be acquired or averaged 
using the Kalman averaging technique. A frame is 
one complete scan from the upper-left corner to the 
lower-right corner of the image.

Recommended setting is 2 frames per second. For 
beam-sensitive samples, increase the number of 
frames.
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Acquisition Time Estimated total acquisition time in seconds.

Live Acquisition Resolution Image size for continuous (TV Scan) acquisitions in 
pixels. (Your computer’s video adapter determines 
the number of Y pixels). Generally, a low resolution 
is best for continuous acquisition.

Frame Time Time in seconds to acquire one frame. Generally, a 
low frame time is best for continuous acquisition.

Dwell Time Shows the length of time the beam will remain at 
each pixel location in seconds (based on the 
current Resolution and Frame Time settings).

User Defined button Allows you to save up to two instances of the 
Electron Image Setup screen (User Defined 1 and 
User Defined 2) that can be easily recalled later by 
clicking the acquisition presets button on the 
Acquisitions toolbar and choosing an option from 
the dropdown list.

Channel Use Input 1
Use Input 2

Specifies the channel from which the image data is 
acquired (for example, the SEI or BEI imaging 
detector of your microscope).

Note: Your microscope may not be set up for using 
the Channel group.

Compensation 
Interval

Applies to optional Drift Compensation software 
only. See Drift Compensation for more 
information.

Advanced Zoom factor Applies to optional Drift Compensation software 
only.

Image Settings Scope Specifies where to apply the image settings (electron 
image, a selected map or all maps). In Electron 
Imaging mode, Scope is automatically set to 
Electron Image and cannot be changed.

Table 13. Electron Imaging mode settings

Feature Group Setting Description
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Image Properties Mode Defines how to apply selected properties. Available 
options:

• Manual. Lets you manually adjust brightness, 
contrast and gamma encoding using the slider 
bars.

• Auto. Expands the histogram to average the 
image across the full range of intensities 
(0–65000 for a 16-bit image).

• Hot Pixel Suppression. Prevents unusually 
bright pixels (typically due to noise) from 
skewing an analysis results.

Note: The Contour option in the Mode list box 
applies to Spectral Imaging mode only.

Contrast Adjusts the contrast of the displayed image

Brightness Adjusts the brightness of the displayed image

Gamma Applies a gamma function to the colorizer used to 
display the selected image or map. Allows you to see 
detail at one end of the color ramp or the other 
(makes one end more sensitive than the other).

Slide the Gamma bar to the positive (right) end to 
enhance the lower (darker) end of the color ramp; 
move it to the negative (left) end to enhance the 
upper (lighter) end of the ramp.

Autoscale Automatically scales the histogram and expands it to 
the grey levels from 0 to 65000.

Table 13. Electron Imaging mode settings

Feature Group Setting Description
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Show Legend Displays or hides the element overlay legend for the 
image pane. The legend shows the maps (Spectral 
Imaging mode) or line scans (Linescan mode) that 
are overlaid on the electron image and their 
associated colors. Here is an example of a map 
legend:

The legend is available only when one or more 
extracted maps (SI mode) or line scans (Linescan 
mode) are selected for overlay. To select a map or 
line scan for overlay, click its element name so that 
the element name is highlighted (Spectral Imaging 
mode) or checked (Linescan mode). Here is an 
example of an element map that is selected for 
overlay.

Transparency 
Factor

Adjusts the transparency of any maps that are 
overlaid on the electron image (so you can see the 
image features below the map)

Table 13. Electron Imaging mode settings

Feature Group Setting Description

Overlay legend 
(Image pane)

Map selected 
for overlay
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Image Presets

In Electron Imaging mode, there can be up to five setting presets available for acquiring an 
electron image. To select a preset, click the down arrow at the right of the Get Image button.

Figure 47. Acquisitions toolbar, electron image acquisition presets

These selections are available:

• High Resolution. Use to quickly set up for high resolution (1024x768) image 
acquisition.

• Fast Image. Use to quickly set up for fast image acquisition.

• User Defined 1 (and User Defined 2). Two sets of user-defined conditions that have 
been previously saved. See below for details.

Marker Colors Lets you select colors for the following items in the 
image pane:
In the Image Markers group

• Coordinated Cursor. Specifies the color of the 
intensity cursor when it is displayed in the 
image pane.

• Extraction Shape. Applies to Spectral Imaging 
mode only. Specifies the color of the drawn 
rectangle, spot, polygon or magic wand when 
these are displayed in the image pane. For 
extracting maps from an electron image.

• Micron Bar Foreground. Fill color for micron 
bar displayed in the image pane.

• Micron Bar Background. Outline color for 
micron bar displayed in the image pane.

In the Map Markers group (applies to Spectral 
Imaging mode only):

• Coordinated Cursor. Specifies the color of the 
intensity cursors when they are displayed in the 
maps pane in Spectral Imaging mode.

Micron Bar Specifies the position of the micron (scale) bar in 
the image pane

Table 13. Electron Imaging mode settings

Feature Group Setting Description

Setting presets
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• TV Scan. Acquires a continuous (live) “video” image of the sample, which can be helpful 
for finding specific features on a sample.

 To set up user-defined conditions for electron image acquisition

1. From the Pathfinder Home screen, choose View > Electron Imaging Mode.

2. Click the Electron Image Setup  button on the acquisitions toolbar and set the 
parameters as desired.

3. Click User Defined > Save User Defined Settings 1 (or Save User Defined Settings 2).

The icon on the toolbar changes to User Defined 1 (or User Defined 2) to show which 
preset is selected.

 To update custom settings

1. In Electron Imaging mode, click the Experiment Setup  button on the acquisitions 
toolbar.

2. Click the Presets button and select the custom settings set you want to modify (User 
Defined 1 or User Defined 2).

3. Modify parameters as desired.

4. Choose User Defined > Save User Defined Settings 1 (or Save User Defined 
Settings 2) to save the new settings.

Note  In the future, use the arrow next to the Get Image button on the Acquisitions 
toolbar to select your custom conditions.
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About the Image Pane
The image pane shows the electron image that was most recently acquired or the stored image 
from the selected image file.

Figure 48. Example of typical averaged electron image displayed in Electron Imaging mode

In Electron Imaging mode, the following tools are available for interacting with the displayed 
electron image.

Tool Description

Micron bar Shows the scale of the displayed image in the appropriate unit. 
Position and colors of micron bar are selectable.

Intensity cursor Ruler

Micron bar
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Post Acquisition Image Processing
The following tools are available for working with the displayed image.

• Adjust Contrast, Brightness and Gamma Settings

• Measure Particles or Features

Adjust Image Contrast, Brightness and Gamma Settings

 To adjust image contrast, brightness and gamma

1. From the Pathfinder Home screen, choose View > Electron Imaging Mode.

2. Acquire an electron image or open a stored one. (The image should be displayed in the 
image pane.)

3. On the Controls panel, click Image Settings. (The software automatically sets Scope to 
Electron Image when Electron Imaging mode is selected.)

Ruler Adds the ruler to the displayed electron image. The ruler can be 
used to measure features in the image. To shorten or lengthen the 
ruler, drag either end. To move the ruler, drag it from the middle.

Intensity cursor Adds the intensity cursor (+) to the displayed electron image. The 
cursor shows the pixel intensity and location of the current cursor 
pixel in the upper left corner of the image pane. You can drag the 
cursor to another location on the image to update the pixel 
intensity and location information.

Tool Description

Ruler

Intensity cursor

Pixel intensity
Pixel location
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4. In the Image Properties group, set Mode to Manual, Auto or Hot Pixel Suppression.

• Manual. Lets you manually adjust brightness, contrast and gamma encoding.

• Auto. Automatically expands the histogram to average the image across the full range 
of intensities (0–65000 for a 16-bit image).

• Hot Pixel Suppression. Prevents bright pixels from skewing an analysis.

5. If Manual mode is selected, use the slider bars as needed to adjust the image contrast, 
brightness and gamma encoding.

6. To automatically scale the histogram and expand it to the grey levels from 0 to 65000, 
select Autoscale.

Autoscale off Autoscale on
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Measure Particles or Features in an Image

If you have the optional Feature Sizing software, you can measure or count particles or 
features in an image and extract a number of parameters.

Manage Image Files

Save an Image File

Files saved in Electron Imaging mode are stored in TIFF (.tif ) format with the experiment 
name and acquisition number.

When you close a project, the software displays a list of files that have been modified in the 
current session. Uncheck those files that you do NOT want saved. Choose OK to save the 
changes. Choose Cancel to close the Save dialog box and return to the project without saving 
any changes.

 To save without closing the project

1. Click the Save button  on the main toolbar to save to the currently open project.

Or

1. Choose File > Save.

Open an Image File

 To open an electron image file within a project

1. Open the project.

The image files contained in the project are listed in the file list pane.

2. From the Pathfinder Home screen, choose View > Electron Imaging Mode.

3. Select the image file in the file list pane. The image appears in the image pane.

 To open an image file outside the current project

1. From the Pathfinder Home screen, choose File > Open and navigate to the directory that 
contains the file.

2. Select the file and choose Open.

The file is copied to the current project’s temporary folder and inherits the current 
project’s settings. and displayed in the image pane.
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Rename an Image File

 To rename an electron image file

1. In the file list pane, select the file to rename.

2. On the File Management panel, click the Rename  button to enable filename 
editing.

3. Enter the new name and press the Enter key on the keyboard.

Delete an Image File

1. In the file list pane, select the file to delete.

2. On the File Management panel, click the Delete  button.

The software displays a message confirming the deletion.

3. Choose Yes to delete the file.

Batch Processing
In electron imaging mode, you can stitch together a series of images to create one larger 
image, referred to as a “montage.” The series of images must be collected using the optional 
Analysis Automation and Stage Control software.

Create a Montage (Mosaic) Image

Use Create Montage in the Batch Processing menu to create a montage of electron images 
(and X-ray maps) by stitching together images acquired as adjacent fields in a grid automation 
sequence into a larger image.

Note  To save an imported file to the current project folder, from the Pathfinder Home 
screen, click the save button  on the main toolbar or choose File > Save. If you close 
the project without first saving an imported file, the software displays a message asking if 
you want to save or discard the imported file.

NOTICE    Deleted files cannot be recovered.

Note  You must use Analysis Automation to create the grid file. For more information, see 
Acquiring Grid Files in Analysis Automation.
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 Creating a montage from a grid file

1. From the Pathfinder Home screen, choose View > Electron Imaging Mode.

2. Choose Batch Processing > Create Montage.

The Create Montage box is displayed.

Image files acquired in a grid pattern using Analysis Automation are listed in the Select 
Files to Process box. Grid files are named with the experiment name followed by 
“[Gridn].” (They have a .grid file extension in the project folder.)

3. Select a grid file to use for the montage.

4. Click the arrow button to start the montage.

The progress bars show the progress. When the montage is completed, it is displayed in 
the image pane. Here is an example of a montage image created from a grid file.
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Figure 49. Displayed montage created from Analysis Automation grid file

The montage data are saved in the Grid folder of the open project with this filename:

[gridn,montage].tif
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5

Point ID Mode

This section covers Point ID mode, which can be used to acquire spectra from user-defined 
points or areas of an acquired electron image.

You can start with an existing electron image or acquire a new image. Each new electron 
image starts a new Point ID data file. Files are named with the experiment name and a 
numeric identifier, followed by “PS” (for “”) and an .eds filename extension.

Spectral acquisition and analysis works the same way in this mode as it does in Spectrum 
mode. You can acquire spectra two ways, instant or batch, using a mixture of five different 
shapes (point, rectangle, irregular, Fat Spot and polygon). An instant acquisition begins when 
you click a new analysis point or area. In a batch acquisition, you select a number of analysis 
points or areas and then begin an automated sequence of spectral acquisitions.

You can add analysis points or areas to the open Point ID file until the file is saved or closed by 
either acquiring a new image or selecting a different analytical mode.

Select Point ID Mode
To select Point ID mode, click the Point ID button on the analytical mode toolbar.

Figure 50. Select Point ID mode

Note  You must acquire a new electron image before adding new analysis points or areas if 
you have switched the analytical mode, changed projects, or opened a Point ID file 
containing areas that were previously acquired. If you switch to another analytical mode or 
open a different project, acquired areas will be retained and areas that have not been 
acquired will be removed.
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In Point ID mode, the software displays all the features and tools for X-ray count analysis of 
the selected microscope field of view.

Figure 51. Pathfinder Point ID Mode User Interface

Figure 52. Image Pane Toolbar Buttons Available in Point ID Mode

* Use Start Spectrum button on Acquisitions toolbar to start a batch acquisition.

Image pane Spectrum pane Controls panel

File List paneImage pane toolbar Results pane (chart or grid)Element Setup pane

Cursor mode (on to select point 
or area/off to draw point or area)

Instant mode (on to acquire current point or 
area; off to *acquire batch points or areas)

Display/hide 
Intensity cursor

Select Acquisition Cursor Shape
Display/hide 
Acquisition Cursor
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Acquire Electron Image for Point ID Measurements
An electron image is required for all Point ID analyses. An average electron image must be 
used for the analysis, but a live image can be used for preliminary sample viewing. For more 
information, see Acquire an Averaged Electron Image.

Before you begin, enter the microscope settings. Most modern microscopes allow the 
software to read the microscope accelerating voltage, working distance and magnification 
values automatically when they are needed. If your microscope does not include column 
communications, enter these values before you start an analysis and update the values 
whenever the Microscope Parameters box is displayed.

 To acquire an averaged electron image for a Point ID measurement

5. Click the Point ID icon on the Analytical mode toolbar.

6. Select an image acquisition preset such as Fast Image or High Resolutions.

7. Enter an experiment name, which will be used as a base name for saving the image file 
and any of its associated Point ID data.

On the acquisitions toolbar, click the  button and enter the experiment name (or 
leave the default name).

8. Click Get Image on the Acquisitions toolbar and wait for the acquisition to complete.

The image is displayed in the image pane and saved along with any subsequently acquired 
Point ID data.
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Set Point ID Spectral Acquisition Parameters
Spectral acquisition and analysis in Point ID mode works the same way it does in Spectrum 
mode. For more information, see Acquire and Analyze a Spectrum and Spectral Acquisition 
Settings.

For a Point ID analysis, set the acquisition parameters as you would for a single acquisition for 
your sample.

 To set the Point ID spectral acquisition parameters

Select a spectral acquisition preset such as High Resolution or High Throughput.

Acquire and Analyze Data in Instant Acquisition Mode
You can do two different styles of Point ID acquisitions, instant and batch, using a mixture of 
five different shapes (point, rectangle, irregular, Fat Spot and polygon). This section covers 
instant acquisitions, which begin after you click a new analysis point or area. In a batch 
acquisition, you select a number of analysis points or areas and then begin an automated 
sequence of spectral acquisitions.

Use the image pane toolbar buttons to set up the analysis.

 To acquire and analyze data in instant acquisition mode

1. Use these Image toolbar settings:

– Select Acquisition cursor

– Select Instant acquisition mode

– Turn off (deselect) Intensity Cursor

– Turn off (deselect) Selection cursor
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2. Set the Cursor Shape selector (see the previous image) to Point or one of the area options 
(rectangle, spot or polygon).

3. Use the mouse to locate the first acquisition point over a feature of interest on the electron 
image.

4. Click on the electron image at the location where you want to begin the analysis. 

A Point acquisition starts when you click the point. For the area options, such as 
Rectangle and Spot, acquisition starts when you finish selecting the area.

The progress bar appears at the top of the Pathfinder window shows the progress of the 
acquisition. The acquisition continues until a termination condition (such as the Live 
Time Limit) is met.

• To pause the acquisition, click the Pause button.

To continue the acquisition, click the pause button again.

• To end the acquisition and save the acquired data, click Stop Spectrum.

• To end the acquisition without saving the data, click the Abort button

When the acquisition is completed, the spectrum appears in the spectrum pane and any 
quantitative results appear in the results pane. For the area acquisitions, the spectrum and 
quantitative results are averaged over the defined area.

Note  See the sections that follow for step-by-step instructions to acquire data using 
each Cursor Shape option.

Set Cursor 
Shape to Point

Select Instant Acquisition Mode

Turn off (deselect) 
Intensity Cursor

Select 
Acquisition Cursor

Turn off (deselect) Selection Cursor

Stop spectrum 
acquisition

Pause 
acquisition

Abort 
acquisition
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The filename and point (or area) number appear at the top of both panes. Here is an 
example:

The analysis results are based on the settings in Quant Setup and Ident Setup and the 
elements selected in the Element Setup pane.

5. To add another point or area, move the mouse to the new location, set Cursor Shape, and 
either click the new point or draw the new area. The new spectrum and results replace the 
previous ones in the spectrum and results panes.
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The data are saved in a temporary folder with the current measurement name followed by 
the point or area number. The folder appears in the file list pane. Here is an example:

You can select acquired points or areas for display two ways:

• by setting the Cursor Mode to Select (selected) on the image pane toolbar and then 
clicking the numbered point or area you want to view. The selected point or area is 
highlighted in the image pane and its associated spectrum and results are displayed in 
the spectrum and results panes, respectively.

• by selecting the measurement in the file list pane (look for the measurement name) to 
list the points or areas measured, and then selecting the numbered point or area you 
want to view.

When the acquisition is complete, the data set is automatically stored in the temporary 
directory and is ready for analysis. From here you can perform extractions to view spectral 
information or create different map sets and extract line scan data.

6. To save the data set from the temporary folder to the current project, click the Save 
button  on the main toolbar, or choose File (menu) > Save.

After the data are saved, you can no longer add analysis points or areas to that 
measurement.

Acquire Data at Each Defined Point

When Instant mode is selected and Cursor Shape is set to Point, you can actively acquire data 
at each selected point on an electron image. If you have acquired an electron image and set the 
acquisition parameters, an instant acquisition begins after you specify a new analysis point. 
(The default settings are for instant acquisitions with the beam in Point mode.)

When the acquisition is finished, you can repeat the procedure to acquire additional data 
using the same electron image.

 To acquire data at each defined point on the electron image

1. Use these Image toolbar settings:

– Select Acquisition cursor

– Set Cursor Shape to Point

– Select Instant acquisition mode
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– Turn off (deselect) Intensity Cursor

– Turn off (deselect) Selection cursor

2. Move the mouse to a feature of interest on the electron image.

3. Click the point to start the spectral acquisition.

Acquire Data at Each Defined Area

Rectangle

When Instant mode is selected and Cursor Mode is set to Rectangle, you can actively acquire 
data in each defined area on an electron image.

 To acquire data in each defined area on the electron image

1. Use these Image toolbar settings:

– Select Acquisition cursor

– Set Cursor Shape to Rectangle

– Select Instant acquisition mode

– Turn off (deselect) Intensity Cursor

Set Cursor 
Shape to Point

Select Instant Acquisition Mode

Turn off (deselect) 
Intensity Cursor

Select Acquisition 
Cursor

Turn off (deselect) Selection Cursor
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– Turn off (deselect) Selection cursor

2. Move the mouse to a feature of interest on the electron image.

3. Click and drag to draw a rectangle around the area.

The spectral acquisition starts when you release the mouse button.

Spot

When Instant mode is selected and Cursor Mode is set to Spot, you can actively acquire data 
in each defined spot on an electron image.

 To acquire data in each defined spot on the electron image

1. Use these Image toolbar settings:

– Select Acquisition cursor

– Set Cursor Shape to Spot

– Select Instant acquisition mode

– Turn off (deselect) Intensity Cursor

– Turn off (deselect) Selection cursor

Set Cursor Shape 
to Rectangle

Select Instant Acquisition Mode

Turn off (deselect) 
Intensity Cursor

Select Acquisition 
Cursor

Turn off (deselect) Selection Cursor
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2. Move the mouse to the center of a feature of interest on the electron image.

3. Click and drag to draw a circle around the area.

The spectral acquisition starts when you release the mouse button.

Polygon (Free-Hand Shape)

When Instant mode is selected and Cursor Mode is set to Polygon, you can actively acquire 
data in each defined area on an electron image. The Polygon shape allows you to free-hand 
draw around an irregular-shaped object to scan the electron beam over that object.

 To acquire data at each free-hand defined area on the electron image

1. Use these Image toolbar settings:

– Select Acquisition cursor

– Set Cursor Shape to Polygon

– Select Instant acquisition mode

– Turn off (deselect) Intensity Cursor

– Turn off (deselect) Selection cursor

2. Move the mouse to an area of interest on the electron image.

Set Cursor Shape 
to Spot

Select Instant Acquisition Mode

Turn off (deselect) 
Intensity Cursor

Select Acquisition 
Cursor

Turn off (deselect) Selection Cursor

Set Cursor Shape 
to Rectangle

Select Instant Acquisition Mode

Turn off (deselect) 
Intensity Cursor

Select Acquisition 
Cursor

Turn off (deselect) Selection Cursor
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3. Single-click an edge of the feature and then continue to click adjacent points to draw a 
boundary around the area.

4. Right-click to complete the polygon (it turns an opaque color).

The spectral acquisition starts when you release the mouse button.

Acquire Data in a Region Defined by Pixel Intensities

When Instant mode is selected and Cursor Mode is set to Magic Wand, you can actively 
acquire data in an irregular-shaped area that is defined by pixel intensities.

 To acquire data in each defined spot on the electron image

1. Use these Image toolbar settings:

– Select Acquisition cursor

– Select Instant acquisition mode

– Turn off (deselect) Intensity Cursor

– Turn off (deselect) Selection cursor

Right-click to close the outline

Set Cursor Shape 
to Magic Wand

Select Instant Acquisition Mode

Turn off (deselect) 
Intensity Cursor

Select Acquisition 
Cursor

Turn off (deselect) Selection Cursor
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2. Set Cursor Shape to Magic Wand.

The software displays the Image Intensity Selection box.

3. Move the mouse to a feature of interest on the electron image.

4. Set Cursor Diameter to the diameter of your selection area around the tip of the mouse 
cursor as a percentage of the image.

5. Adjust Similarity.

Start with a high similarity value and then gradually reduce it to include the intensities 
that select features of interest.
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6. Increase Smoothing to better define the image.

Here is the same image with additional smoothing.

7. Adjust the Brightness value as needed.

8. When you are finished, choose Close to start the spectral acquisition and analysis.

The progress bar appears above the spectrum pane and shows the progress of the 
acquisition. When the acquisition is completed, the spectrum appears in the spectrum 
pane and its analysis results appear in the results pane.

Acquire and Analyze Data in Batch Acquisition Mode
You can do two different styles of Point ID acquisitions, instant and batch, using a mixture of 
five different shapes (point, rectangle, irregular, spot and polygon). This section covers batch 
acquisitions, where you select a number of analysis points or areas and then begin an 
automated sequence of spectral acquisitions.

Table 14. Image Intensity Selection Box Features

Feature Description

Guard Ring Width Defines a perimeter width of the selected area that will not be 
sampled. Used to keep the excitation volume within the 
selected area when there are unwanted pixels next to the area 
boundary. Default setting is 5 um.

Cursor Diameter Sets the size of the area (number of pixels) around the tip of 
the mouse pointer as a percentage of the image width to select 
pixel grey level intensity. The higher the percentage value, the 
more pixels are evaluated.

Similarity Adjust the slide bar to include the intensities that select the 
object of interest.

Smoothing Select the number of smoothing passes to fill in holes.

Brightness This number is entered automatically based on the current 
mouse location. Adjust the value to change the image 
brightness.
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Use the image pane toolbar buttons to set up the analysis and the acquisition toolbar to start 
it.

 To acquire and analyze data in batch acquisition mode

1. Use these Image toolbar settings:

– Select Acquisition cursor

– Set Cursor Shape to Point or one of the area options (rectangle, spot or polygon)

– Turn off (deselect) Instant acquisition mode

– Turn off (deselect) Intensity Cursor

– Turn off (deselect) Selection cursor

2. Move the mouse to a feature of interest on the electron image.

3. Click a point (or select an area) for the first acquisition.

4. Set the Cursor Shape selector for the second acquisition (you can mix points and areas).

5. Click another point (or select an area) for the second acquisition.

Each point or area is numbered sequentially.

6. Continue adding your remaining acquisition points or areas.

You can delete a point or area without affecting the remaining drawn points or areas.

7. When you are ready to start the acquisition, click Start Spectrum on the acquisitions 
toolbar.

The software acquires the spectral data sequentially during one pass of the progress bar, 
starting with the first defined location and ending with the last one. When all the 
acquisitions are completed, the spectrum from the last point or area measured is displayed 
in the spectrum pane and its associated analysis results are displayed in the results pane.

The spectra can be analyzed individually or as a group (see Batch Processing for details) using 
the same functions as in Spectrum mode.

Set Cursor Shape to 
Point or an area option

Turn off (deselect) Instant Acquisition Mode

Turn off (deselect) 
Intensity Cursor

Select Acquisition 
Cursor

Turn off (deselect) Selection Cursor
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Delete a Defined Batch Point or Area

 To delete a defined batch point or area before you start the batch acquisition

1. Click the Select button on the image pane toolbar so the button is highlighted.

2. Click the point or area you want to delete.

3. Press the Delete key on the keyboard.

The selected point or area is removed from the image pane and the remaining points and 
areas are renumbered.

Batch Process Point ID Data

Point ID spectra can be quantified at one time using commands from the Batch Processing 
menu in Pathfinder software. You can select multiple files for batch processing.

Batch processing uses the current Identify and Quant settings to perform the analysis. The 
analysis results can be saved in table format to a comma separated values (CSV) file (.csv 
filename extension) in a selected folder. The data are organized to enable further analysis, such 
as calculating average Weight %.

 To quantify multiple Point ID spectra acquired in Batch mode

1. Select Point ID mode on the analytical toolbar.

2. Select the file you want to batch process in the file list pane.

3. On the main menu, select Batch Processing > Point ID Analysis.

A list of available measurement data is displayed with the selected measurement listed 
first.

4. Select one or more files to process and choose OK.

A Save box is displayed.

5. Select a folder for storing the CSV file (default setting is the current project folder), enter 
a filename and choose Save.

Or...

Click Cancel to batch process the selected data without writing it to a CSV file. (This can 
be useful for creating reports.)

Note  Files must be saved so they exist in the Project folder (not just the Temp folder) 
before they can be batch processed.
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Save Individual Spectra From a Point ID File
A Point ID file contains the electron image, the numbers and locations of the acquired points 
or areas and their associated spectra. To save an individual spectrum from a selected point or 
area, a copy of the spectrum must be separated from the Point ID file.

 To save a Point ID spectrum

1. Select Point ID mode on the analytical toolbar.

2. Select the desired point or area measurement to display its associated spectrum in the 
spectrum pane.

To select a point, use the Create/Select button in the image pane toolbar or select the 
measurement from the file list pane.

3. Select Spectrum mode on the analytical toolbar.

The selected Point ID spectrum remains in the spectrum pane.

4. Choose File (menu) > Save.

The spectrum is saved to the file list pane with its measurement name followed by the 
point or area number and an .emsa filename extension. Here is an example:

Stone_pt1.emsa

Note  To locate and open the csv file, click the Project Explorer button on the main 
toolbar. In the Project Explorer window, right-click the project and choose Open in 
Project Explorer. This opens an Explorer window that shows the contents of the current 
project folder with all the files visible. Double-click to open the CSV file.
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6

Spectral Imaging Mode

In Spectral Imaging mode, a data set of dead time corrected spectra are acquired at every point 
(pixel) in the microscope field of view. This data set is displayed in the image pane and 
referred to as the reference electron image. Once acquired and stored, you can analyze the data 
set and generate spectra for qualitative and quantitative analysis of selected areas, or the entire 
electron image, create a set of X-ray maps, extract line scans, and print reports.

Spectral imaging mode is the only way to collect X-ray maps. The optional Compass 
(Principle Component Analysis) software uses a spectral imaging data set to calculate and 
display principle component maps. If you purchased the optional Direct-to-Phase software, 
you can also extract and display phase maps during acquisition.

Select Spectral Imaging Mode
To select Spectral Imaging mode, click the Spectral Imaging button on the analytical mode 
toolbar.

Figure 53. Select Spectrum mode
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In Spectral Imaging mode, the software displays all the features and tools for X-ray analysis of 
the selected microscope field of view.

Figure 54. Pathfinder Spectral Imaging Mode User Interface

Figure 55. Image Pane Toolbar Buttons Available in Spectral Imaging Mode

Image pane Controls panel

File List paneElement Setup pane Spectrum pane

Maps pane

Display/hide 
Intensity cursor

Select Extraction Cursor Shape
Display/hide 
Extraction Cursor

Display/hide line 
scan cursor

Display/hide 
Surface Tools

Display/hide 
Ruler Tool
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Overview of Spectral Imaging Data Acquisition
The following steps outline the acquisition parameters that need to be set up before starting a 
Spectral Imaging (SI) acquisition. These steps are more or less in the sequence of setting the 
parameters but they can be set up in any sequence as long as all parameters are addressed.

 To set up spectral imaging data acquisition

1. Prepare sample.

Place into microscope, acquire image and adjust stage height (Z axis) to optimal working 
distance for EDS detector. Obtain good microscope image in critical focus.

2. Fully insert EDS detector to dead stop.

3. Select Spectral Imaging Mode in Pathfinder.

4. Set Microscope Parameters.

5. Set up electron image acquisition.

6. Set up spectral image acquisition.

7. Enter SI file name in Experiment Name box.

8. Acquire electron image.

9. Acquire spectral imaging data.

Acquisition Settings

Microscope Settings

For any analysis, the software requires the microscope accelerating voltage, working distance 
and magnification. To set microscope parameters, from the Home screen, choose Edit (menu) 
> Microscope Parameters. Enter the accelerating voltage, magnification and working 
distance in the appropriate edit boxes. For more information, see Microscope Settings.

Note  See Chapter 3, Spectrum Mode, for acquisition and sample preparation 
considerations for EDS best practices.

Note  If you have the optional Column Communications software, the microscope 
parameters are updated automatically.
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Electron Image Acquisition Settings

For any analysis, the software requires you to first acquire an electron image. You can start 
with a Livetime electron image. For more information, see Acquire Live Electron Image and 
Electron Image Settings in Electron Imaging Mode.

Spectral Acquisition Settings

You can set spectral acquisition parameters manually or use a spectral acquisition preset. This 
section provides general considerations for X-ray spectral acquisition and gives brief 
descriptions of all the available settings for acquiring X-ray spectra in Spectral Imaging mode.

Spectral Acquisition Considerations

Consider these points before acquiring X-ray data in Spectral Imaging mode for the first time.

• Map Resolution. When selecting a map resolution size, be aware that the larger the size, 
in pixels, the larger the SI data file and a longer time required for data acquisition. A 
256 resolution map is a good trade-off for length of acquisition time, SI file size and map 
detail. A 256 SI file may be as large as 100 Mb. However a 256 map will have reasonable 
resolution when printed. A 128 map is about the size of a postage stamp when printed 
and is not very useful for map detail. However, 128 maps have short acquisition times 
(<5 minutes). On the other hand a 512 map takes 4 times as long to acquire as a 
256 map. Be aware that when a 256 map is overlaid on the 512 gray reference image, 
there is some intercalation that must be calculated for the overlay. 

• Energy Range. Within the Energy Range group there are two selections: Low Energy 
Cutoff (eV) and High Energy Cutoff (keV).

• Low Energy Cutoff. Clips the energy display range from 0 eV to the value entered in 
the edit box (clips off the noise peak). The Auto selection adjusts the cutoff value 
depending on the estimated noise at a given pulse processor time constant. Generally, 
a fixed value of 100 to 120 eliminates the noise peak at the low energy range for most 
time constants.

• High Energy Cutoff. Determines the number of channels allocated in memory (each 
channel represents 10 eV). For example, if High Energy Cutoff is set to 10 keV, 
1024 channels of memory are allocated. At this range, any peak greater than 
10.240 keV is not saved or displayed.

Generally, the accelerating voltage in an SEM is limited to 30 KV. At this voltage, the 
highest energy X-ray line that can be fluoresced and displayed is Mo K line at about 
17.4 keV. Thus, the high energy cutoff keV for an SEM would be 20 keV; whereas, 
for a TEM at 200 KV, a 40 keV range would be appropriate.
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The High Energy Cutoff list box has the following options: Auto, 5, 10, 20, 40, and 
80 keV. Select Auto to automatically adjust the high energy cutoff to the accelerating 
voltage of the microscope. If the accelerating voltage is not entered correctly, the 
range may be incorrect. Fixing the high energy cutoff to 20 keV for an SEM provides 
consistent spectra for comparison.

• Time Constant. The pulse processor time constant is the time allowed for the pulse 
processor to estimate the energy of an X-ray. The longer the time allowed, the better the 
estimate of the energy and the better the estimate, the higher the resolution of the peak. 
However, the longer the time constant, the higher the dead time for a given count rate. 
High resolution spectra (long time constant), translate to lower count rates and longer 
acquisition times.

There is a trade-off of the length of time for SI data acquisitions and the resolution of the 
spectra. However, for mapping, X-ray counts are taken from the center of the peak. As a 
result, resolution plays a much lower importance over the time required for an 
acquisition. Good data sets take about 10 minutes to acquire even at very high count 
rates. Thus, use a shorter time constant (Rates 6 to 10, depending on the available beam 
current from the microscope) when acquiring spectral image data sets.

Set Time Constant to Auto to allow the software to adjust the time constant rate to keep 
the dead time between 30% and 50%. To switch from a high resolution (longer time 
constant) to a faster, high count rate SI acquisition, just increase the beam current and the 
software will adjust the time constant. This is very convenient when shifting from fast 
acquisitions to high resolution acquisitions and vise versa.

• Termination Criteria. Essentially, there are two criteria for terminating an SI acquisition: 
by number of total frames or by statistics.

• Termination by frames. You can set up termination by frames two ways: manual 
termination or total number of frames. The acquisition terminates when the total 
number of frames reaches the entered value, or it can be terminated manually at any 
time when the maps reach a “quality” level of counts (i.e., the maps “look good”). 

• Termination by statistics. There are three criteria for termination by statistics:

– By average pixel counts. Terminates the acquisition when the average X-ray 
counts in all pixels from all acquired maps reaches the specified value.

– By total spectrum. Terminates when any peak reaches a specified vertical full 
scale value)

– By element peak. Terminates when the specified element peak reaches a 
specified vertical full scale value)

If values, other than 0 or blank, are entered in a termination section, the first 
criterion reached terminates the acquisition (zero equates to infinite). Generally, 
spectral acquisitions are terminated by number of frames or manually.
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Experiment Setup (Normal View)

To access the spectral acquisition settings, click the Experiment Setup button  on the 
right side of the acquisitions toolbar. For normal view, click to toggle the green arrow so it 
looks like this:

The following spectral acquisition settings are available in normal view. For more information 
about setting acquisition parameters for sample acquisition, see Spectral Acquisition 
Considerations.

Normal View 
toggle setting

Experiment
Setup

Table 15. Spectral Imaging Mode Experiment Settings, Normal View

Group Setting Description

Active Detector(s) Detector One/
Detector Two

Available only when multiple Pathfinder- compatible detectors are 
installed on the microscope. When multiple detectors are installed, 
use the Detector One/Detector Two buttons to select which 
detector(s) you want to use for the analysis.

Note: The Detector 1 and Detector 2 settings in the software refer 
to the detector cables attached to the Detector 1 and Detector 2 
Preamp ports on the Pathfinder chassis.

SI Acquisition Resolution Map image size in pixels. A higher resolution provides greater image 
detail but increases acquisition time. Recommended setting is 
256x195.
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Frame Time Time in seconds to acquire one frame. A frame is one complete scan 
from the upper-left corner to the lower-right corner of the map. A 
long frame time reduces image noise but increases acquisition time. 
A short frame time can result in blurred or streaked images. 
Optimum values depend on the microscope and detector type.

Select Fastest to automatically select the fastest frame time. 
Recommended setting is 5 seconds.

Dwell Time The length of time the beam remains at each pixel location in 
seconds (based on the current Resolution and Frame Time 
settings). A long dwell time reduces image noise but increases the 
acquisition time. A short dwell time might cause a blurred or 
streaked image.

Minimum dwell time should be about 4-5 times longer than the 
pulse processor time constant. Recommended setting is 50 seconds. 
The shortest dwell time is 50 sec.

Number of Frames Total number of frames to be acquired or averaged using the 
Kalman averaging technique. A frame is one complete scan from 
the upper-left corner to the lower-right corner of the map.

Recommended setting for first acquisition is 200-300 frames. For 
beam-sensitive samples, increase the number of frames. Select 
Infinite if you want to stop the acquisition manually by pressing 
Stop or Abort on the acquisitions toolbar.

Acquisition Time Estimated total acquisition time in seconds.

Energy Range Low Energy Cutoff X-ray counts below the specified Low Energy Cutoff are ignored 
during an EDS acquisition. Can be used to eliminate the “noise” 
peak in the low energy region. Also used to determine where the 
noise peak ends and the baseline begins, which helps determine 
light elements such as the Be peak.

These options are available:

• 100. Clips the noise peak in the spectrum

• Zero. Includes the noise peak

• Auto. Adjusts the energy value according to the specified Time 
Constant. Each Time Constant setting has a unique noise level. 
In general, Auto includes about 3 channels of noise in the 
spectrum. Each time constant has a unique noise level.

Table 15. Spectral Imaging Mode Experiment Settings, Normal View

Group Setting Description
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High Energy Cutoff X-ray counts below this limit are included in an EDS acquisition. 
Typically, a High Energy Cutoff setting of 20 keV will include an 
X-ray line from all elements using an SEM. For TEM applications, 
40 keV is appropriate. The Auto option changes the energy limit 
according to the microscope kV.

Time Constant The amount of time the software integrates the energy during the 
measured portion of the peak. Consider these options:

• Rates 1 and 2 produce statistically good, high-resolution 
spectra

• Rate 3 and Rate 4 produce quality spectra for most analyses

• Auto adjusts the time constant to keep the dead time between 
30% and 50%. Depends on the beam current and accelerating 
voltage.

Note: Do not use the Auto setting for spectral comparisons or 
quantification with standards.

To see the time associated with each Rate setting, add Time 
Constant to the Pathfinder status bar.

Custom Save Custom Settings 1
Save Custom Settings 2

Allows you to save up to two instances of the Experiment Setup 
screen for spectral acquisitions (C1 and C2) that can be easily 
recalled later by clicking the Setting Presets button on the 
Acquisitions toolbar and choosing an option from the list box.

Table 15. Spectral Imaging Mode Experiment Settings, Normal View

Group Setting Description
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Experiment Setup (Advanced View)

To access the spectral acquisition settings, click the Experiment Setup button  on the 
right side of the acquisitions toolbar. For advanced view, click to toggle the green arrow so it 
looks like this:

Advanced View 
toggle setting

Experiment
Setup
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The following spectral acquisition settings are available in advanced view.

Acquire and Analyze a Data Set
This section provides an overview of the steps to perform a spectral imaging acquisition and 
element identification and quantification.

 To acquire and analyze a data set

1. Prepare the sample.

Place the sample in the microscope and obtain an image. Adjust the stage height (Z-axis) 
to the optimal working distance for the EDS detector. Obtain a good microscope image 
of an area of interest on the sample. See Microscope Considerations for details.

2. Fully insert the EDS detector.

Table 16. Spectrum Mode Experiment Settings, Advanced View

Group Setting Description

Terminate by 
Statistics

Average Counts per 
Pixel Limit

Terminates the acquisition when the average total X-ray counts in a 
pixel for all maps reaches this value.

Element Map Vertical 
Full Scale

Terminates the acquisition when the vertical full scale of the 
accumulated spectrum reaches this value.

Element To define termination criteria based on max counts in the energy 
region for a particular element, enter the atomic symbol for the 
element and select an X-ray line (see below).

Line If you entered an element (see above), select the X-ray line for that 
element.

Options Concurrent Image Acquires a gray level image at the same time as the maps. This 
image defaults to single color and is displayed in the map view pane 
at the same resolution as the maps.

Readouts Detects (/s) Shows the number of X-rays entering the EDS detector per second.

Stores (/s) Shows the number of X-ray counts that are converted, pass through 
the noise discriminator and are stored in the spectrum per second.

Dead Time (%) Shows the percentage of dead time for the current measurement 
settings. Dead time refers to the time the pulse processor is busy 
and cannot process another X-ray event. The higher the Time 
Constant setting (where Rate1 is the highest), the higher is the dead 
time for a given count rate.

A dead time of 25-30% is acceptable for a typical X-ray analysis.
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3. Start Pathfinder software.

The Pathfinder Project Explorer window is displayed.

4. Select or create a project and choose OK.

The Pathfinder Home screen is displayed.

5. Set the basic microscope parameters:

– From the Home screen, choose Edit > Microscope Parameters

– Set these microscope parameters and then choose Close

• Accelerating Voltage in kilovolts (kV)

• Magnification

• Working Distance in millimeters (mm)

6. Focus the sample (it should be in critical focus).

7. Click the Spectral Imaging icon  on the analytical mode toolbar.

8. Enter an experiment name (used as a base name for automatically saving acquired data).

On the acquisitions toolbar, click the  button and enter the experiment name (or 
leave the default name).

9. Acquire an averaged electron image to use as the reference image.

Note  If your SEM has Column Communications, these parameters are entered 
automatically.
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Click the Experiment Setup  button at the right of the Get Image group on the 
acquisitions toolbar (normal view toggle setting) to display the available image acquisition 
settings.

Use these settings in the Averaged Acquisition group:

To start the image acquisition, click Get Image on the acquisitions toolbar.

The button name changes to Stop Image. Wait until the acquisition is completed.

10. Acquire the X-ray data.

Click the Experiment Setup  button at the right of the Start Map group on the 
acquisitions toolbar (normal view toggle setting) to display the available map acquisition 
settings.

Feature Setting

Resolution 512x384

Frame Time 5 seconds

Number of Frames 1
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Use these settings in the Averaged Acquisition group:

To start the image acquisition, click Start Map on the acquisitions toolbar.

The button name changes to Stop Map. Wait until the acquisition is completed.

The cumulative spectrum from all pixels in the electron image is displayed in the 
spectrum pane. An Auto ID is performed periodically during the acquisition and X-ray 
maps are periodically updated in the maps pane. Here is an example:

Feature Setting

Resolution 256x192

Frame Time 20 seconds

Number of Frames 200

Low Energy Cutoff 100

High Energy Cutoff Auto

Time Constant Rate 3
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When the acquisition is complete, the data set is automatically stored in the temporary 
directory and is ready for analysis. From here you can perform extractions to view spectral 
information or create different map sets and extract line scan data.

Image pane Maps pane Controls panel

Element Setup pane Spectrum pane file list pane
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11. To save the data set in the current project, click the Save button  on the main 
toolbar, or choose File > Save.

Note  If you have the optional COMPASS software, during an acquisition you can switch 
to COMPASS mode and acquire principal component maps. To open COMPASS mode, 
select the Map Processing tab and click COMPASS. The component maps are updated 
and displayed periodically during the acquisition. You can also switch back to X-ray maps.
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Extract and Analyze Data
After the spectral imaging data set is acquired, use these tools to extract and analyze spectral 
data from specific areas of the electron image.

Extraction Tools

The toolbar at the bottom of the image pane contains buttons to specify an area of the 
electron image for analysis. Auto extraction is always selected in the software. This means 
X-ray maps are extracted automatically based on the elements identified from the extracted 
spectrum. The maps are extracted from the entire field of view; whereas the displayed 
cumulative spectrum is only from the area defined by the extraction tool.

Figure 56. Spectral Imaging mode, Extraction Tools

Extract and Analyze from Defined Points or Areas

Use the extraction cursor on the image pane toolbar to extract and analyze X-ray counts from 
each selected point or area on the electron image. Select a cursor shape from the dropdown list 
box. Click the cursor button to turn extraction on and off.

Figure 57. Spectral Imaging mode, Image Toolbar

Select Extraction Cursor Shape

Extract Line scan

Display 
Extraction Cursor

Note  Make sure the intensity cursor is off before you extract data. To turn off the 
intensity cursor, click to deselect the  button on the image pane toolbar.

Select Extraction Cursor Shape

Display Extraction Cursor
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When the extraction cursor button is selected on the image pane toolbar, the Map Processing 
tab opens on the controls panel with the Counts Map Type selected.

There are two algorithms for extracting X-ray counts:

• Area Integral (default). Extracts the spectral data and displays total X-ray counts from the 
selected area. Useful for most applications. Here is an example:
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• Trace Element Search. Extracts the spectral data and reports the maximum counts for 
each channel in the selected area. Useful for finding small concentrations of an element, 
or small, localized areas of an element that would otherwise be lost in the total 
background. Here is the sample processed using the Trace Element Search algorithm:

Single Pixel

Extract from a single pixel in the electron image. This is useful for evaluating noise in the 
spectral data.

 To extract and analyze data from a single pixel

1. Use these image pane toolbar settings:

– Select the extraction cursor

– Set Cursor Shape to Rectangle

Note  Notice that Ti shows up when the trace element algorithm is used but not for 
the area integral algorithm. If we filter out the noise from the Ti map, this element is 
clearly present.

Mean filter
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– Turn off (deselect) all the other buttons on the image pane toolbar

2. Click the desired location on the electron image.

The location is marked with a plus (+) sign on the electron image and the extracted 
spectrum is displayed in the spectrum pane. Here is an example:

Set Cursor Shape to Rectangle

Turn off (deselect) Intensity Cursor Turn off (deselect) Surface tool)

Turn off (deselect) Ruler tool)

Select Extraction Cursor
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Rectangle

Use the rectangle cursor shape to extract and analyze data from each defined area on an 
electron image.

 To extract and analyze data from each defined area on the electron image

1. Use these image pane toolbar settings:

– Select the extraction cursor

– Set Cursor Shape to Rectangle

– Turn off (deselect) all the other buttons on the image pane toolbar

2. Move the mouse to a feature of interest on the electron image.

3. Click and drag to draw a rectangle around the area.

The extraction starts when you release the mouse button.

To delete the shape and redraw the area, drag a new rectangle over the image. The 
rectangular area can be resized and moved. 

The software uses all pixels in the defined area to create a cumulative spectrum. The 
cumulative spectrum is displayed in the spectrum pane. The appearance of the spectrum 
and the identified elements are dependent upon the settings on the Map Processing tab 
on the controls panel. X-ray maps are extracted from the entire image.

Set Cursor Shape to Rectangle

Turn off (deselect) Intensity Cursor Turn off (deselect) Surface tool)

Turn off (deselect) Ruler tool)

Select Extraction Cursor

Click here to expand the shape to fill 
the image pane. Click again to return 
to the previous size and location

To move the shape, place the cursor 
inside the shape, then drag it to the 
new location

To resize the shape, drag any edge 
or corner
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Spot

Use the Spot cursor shape to extract and analyze data from each defined spot on an electron 
image.

 To extract and analyze data from each defined spot on the electron image

1. Use these image pane toolbar settings:

– Select the extraction cursor

– Set Cursor Shape to Spot (a predefined circle is displayed on the electron image)

– Turn off (deselect) all the other buttons on the image pane toolbar

2. Move the mouse to a feature of interest on the electron image.

3. Click to center the spot over the area.

The extraction starts when you release the mouse button.

The software uses all pixels in the defined area to create a cumulative spectrum. The 
cumulative spectrum is displayed in the spectrum pane. The appearance of the spectrum 
and the identified elements are dependent upon the settings on the Map Processing tab 
on the controls panel. X-ray maps are extracted from the entire image.

 To change the spot size

1. From the Home screen, choose Edit (menu) > Properties.

2. In the Properties box, click the Image Extract tab.

Set Cursor Shape to Spot

Turn off (deselect) Intensity Cursor Turn off (deselect) Surface tool)

Turn off (deselect) Ruler tool)

Select Extraction Cursor
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3. In the Spot group, enter the Radius for the spot size (as a percent of the image) and 
choose Apply to see the new spot size on in the image pane.

4. Click OK to keep the new setting and close the Properties box.

Polygon (Free-Hand Shape)

Use the polygon cursor shape to extract data from a user-defined area on an electron image. 
The Polygon shape allows you to free-hand draw around an irregular-shaped object to extract 
from that object.

 To extract and analyze data from each user-defined area on the electron image

1. Use these image pane toolbar settings:

– Select the extraction cursor

– Set Cursor Shape to Polygon

– Turn off (deselect) all the other buttons on the image pane toolbar

2. Move the mouse to an area of interest on the electron image.

Set Cursor Shape to Polygon

Turn off (deselect) Intensity Cursor Turn off (deselect) Surface tool)

Turn off (deselect) Ruler tool)

Select Extraction Cursor
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3. There are two ways to draw a shape:

• Click the image at the points where you want to begin your shape. Hold down the 
left mouse button and draw a closed shape around the object of interest.

• Single-click a corner of the shape and then continue to click adjacent corners to draw 
a boundary around the area.

4. Right-click to complete the polygon (it turns an opaque color).

The extraction starts when you release the mouse button.

To delete the shape and redraw the area, turn the cursor shape button off and back on. 
Then draw a new polygon over the image.

To draw multiple polygon shapes, hold down the Ctrl key on the keyboard while you 
draw all the shapes. Press the mouse button and draw the first shape. Then release the 
mouse button, move to a new location, press the mouse button again and draw the next 
shape. Right-click the image pane to close and fill all the drawn shapes.

The software uses all pixels in the defined area to create a cumulative spectrum. The 
cumulative spectrum is displayed in the spectrum pane. The appearance of the spectrum 
and the identified elements are dependent upon the settings on the Map Processing tab 
on the controls panel. X-ray maps are extracted from the entire image.

Extract and Analyze From Region Defined by Pixel Intensities

Use the Magic Wand cursor shape to select an irregularly-shaped area on the electron image 
based on grey-level intensity values. This is similar to drawing a polygon but it uses intensities 
within specified values to define the area. The magic wand tool is easier than hand drawing a 
polygon.

 To extract and analyze data using pixel intensities on the electron image

1. Use these image pane toolbar settings:

– Select the extraction cursor

– Set Cursor Shape to Magic Wand
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– Turn off (deselect) all the other buttons on the image pane toolbar

The software displays the Image Intensity Selection box.

2. Click within an area of interest on the electron image.

3. Set Cursor Diameter to the diameter of your selection area around the tip of the mouse 
cursor as a percentage of the image, or select Diameter In Microns and enter a value in 
microns.

The cursor diameter is the size or number of pixels around the mouse pointer that will be 
evaluated.

Set Cursor Shape to Magic Wand

Turn off (deselect) Intensity Cursor Turn off (deselect) Surface tool)

Turn off (deselect) Ruler tool)

Select Extraction Cursor
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4. Adjust Similarity.

Start with a high similarity value and then gradually reduce it to include the intensities 
that select features of interest. A lower similarity value will include more pixels.

5. Set Smoothing to the number of passes for a smoothing function.

One or two passes will decrease the noisy pixels around the mouse cursor.

6. Adjust the Brightness value as needed.

7. Select Spectrum Auto Extract to automatically extract the spectrum after an intensity 
area is selected.

8. When you are finished defining the magic want area, choose Close to start the spectral 
extraction and analysis.

The software uses all pixels in the defined area to create a cumulative spectrum. The 
cumulative spectrum is displayed in the spectrum pane. The appearance of the spectrum 
and the identified elements are dependent upon the settings on the Map Processing tab 
on the controls panel. X-ray maps are extracted from the entire image.

Table 17. Image Intensity Selection Box Features

Feature Description

Cursor Diameter Sets the size of the area (number of pixels) around the tip of 
the mouse pointer as a percentage of the image width to select 
pixel grey-level intensity (or in microns if Diameter in 
Microns is selected). The higher the percentage (or diameter) 
value, the more pixels are evaluated.

Diameter in Microns Changes the Cursor Diameter entry box from percentage of 
image to diameter.

Similarity Adjust the slide bar to include the intensities that select the 
object of interest.

Smoothing Select the number of smoothing passes to fill in holes.
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Extract and Analyze Line Scan Data

Line scan extraction allows you to investigate and analyze elemental transitions from region to 
region on the sample. You can specify the direction, width and number of points of the 
extracted area.

 To extract and analyze line scan data

1. Select the elements to include in the line scan.

There are two ways to do this:

• In the element setup pane (periodic table), set individual elements to Identified

• To populate the periodic table automatically, select Auto ID in Ident Setup (controls 
panel > Spectrum Processing > Ident Setup) and use the rectangle cursor shape to 
extract a large area.

2. Use these image pane toolbar settings:

– Select Line

– Turn off (deselect) all the other buttons on the image pane toolbar

Brightness This number is entered automatically based on the current 
mouse location. Adjust the value to change the image 
brightness.

Spectrum Auto Extract Select this option to automatically extract and analyze the 
spectrum after an intensity area is selected.

When Spectrum Auto Extract is cleared, the Extract Spectrum 
button is displayed. When you are finished defining the magic 
wand area, click Extract Spectrum to perform the extraction 
and analysis.

Table 17. Image Intensity Selection Box Features

Feature Description

Note  If you are unsure whether to include a particular element, include it in the 
initial line scan. You can exclude elements that are not of interest later.

Turn off (deselect) Cursor Shape

Turn off Ruler tool

Turn off Intensity cursor

Select Linescan Cursor

Turn off Surface tool
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This displays a line in the image pane and extracts the spectral data along the line.

The line scan data are presented as a graph in the graph pane.

 To move the line

• To move the entire line, position the mouse cursor in the middle of the line. The cursor 
changes to a 4-way arrow. Hold the left mouse button and drag the line to a new location.

• To lengthen, shorten or redirect the line, position the mouse cursor at either end of the 
line. The cursor changes to a 2-headed arrow. Hold the left mouse button and drag the 
end to a new location.

• To draw a new line, move the mouse cursor to a new location and drag and drop a new 
line.

Line color 
legend
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 To remove an element from the analysis

1. Right-click the element symbol in the element setup pane (periodic table) and choose 
Inactive.

2. Click the extraction line in the image pane to update the extraction.

 To add an element to the analysis

1. Right-click the element symbol in the element setup pane (periodic table) and choose 
Identify.

2. Click the extraction line in the image pane to update the extraction.

The element is added to the graph and legend.

 To change the number of points and width of the line scan

1. In the Linescan Processing group on the controls panel (opens automatically when you 
select Line on the image pane toolbar), use Number of Points in the Line group to change 
the number of points in the line scan.

2. Enter a Thickness (% of image) value to change the width of the line scan.

3. Click the extraction line in the image pane to update the extraction.
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Linescan Settings

Use the features in the Linescan Processing group on the controls panel to define the line scan 
graph output. The Linescan Processing group opens automatically when you select the Line 
button on the image pane toolbar in the image pane.

Figure 58. Linescan Processing Tab
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The line scan settings are described below.

Table 18. Linescan Processing Settings

Group Setting Description

Linescan Data Type Defines the format of the extracted quant 
data displayed in the line scan graph. These 
options are available:

• Counts. Number of X-rays received 
and processed by the detector.

• Atomic%. The atomic concentration of 
the element in the sample expressed as a 
percentage.

• Weight%. The mass of the quantified 
element in the sample expressed as a 
percentage.

• K-ratio%. Measured k-ratio (net 
counts sample/net counts from pure 
element) for the X-ray line.

• Net counts. Number of X-rays received 
and processed by the detector with 
background characteristics removed

Line Thickness Width of the line scan expressed as a 
percentage of the electron image

Number of Points Divides the length of the line scan into 
sections where each point is a section. If you 
include enough points, each section is 
equivalent to one pixel. With lower Number 
of Points settings, the data in each section 
are summed.

Data Options Log Scale Displays the acquired data using a 
logarithmic scale

Smooth Applies the selected level of smoothing to 
the line scan graph

Spline Applies a spline function to the line scan 
graph

Linescan Display Grid Displays a grid in the line scan graph 
background

Symbols Marks each data point in the line scan graph 
with a symbol
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Error Bars When Linescan Data Type is set to one of 
these options, adds error bars to the graph 
to indicate the error level for the measured 
value:

• Atomic%
• Weight%
• K-ratio%
• Net counts

Line Profiles Line Profiles Determines how line scan data for selected 
elements are overlaid on the electron image. 
These options are available:

• On Linescan. Displays line scan data 
for the selected elements adjacent to the 
line scan.

• On Axis. Displays line scan data for the 
selected elements on the electron image 
axis.

• Overlaid. When line scan data for 
multiple elements are selected for 
overlay, all of the element line scans are 
overlaid on the electron image.

• Stacked. When line scan data for 
multiple elements are selected for 
overlay, the element line scans are 
stacked and scaled according to the 
scale setting (see below).

• Scaled Independently. When 
selected, scales each overlaid line 
scan independently. When 
deselected, scales all overlaid line 
scans the same.

Table 18. Linescan Processing Settings

Group Setting Description
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Examples:

Figure 59. Linescan Display with Symbols Feature Selected

Figure 60. Linescan with Overlaid Element
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Analyze Line Scan Data

Coordinated Intensity Cursors

Click the Intensity Cursor  button on the image pane toolbar to display the 
intensity cursor in the image pane. The cursor shows the pixel intensity and coordinates of the 
current cursor location in the upper left corner of the image pane.

Figure 61. Intensity Cursor Displayed in Image Pane

You can click or drag the cursor to another location on the image to update the pixel intensity 
and location information.

If you click a point on a line scan in the image pane, a coordinated intensity cursor (vertical 
line) shows the location of that point on the line scan graph. You can also click points on the 
line scan graph to update the cursor location and information in the image pane.

Figure 62. Coordinated Intensity Cursors in Image Pane and Line Scan Graph

Intensity cursor

Pixel intensity
Pixel location

Coordinated Intensity Cursors
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Results Pane

The results pane shows the quant data at the current cursor location. If you drag the cursor 
line right or left to select a region of the graph (gray area), the results pane shows the averaged 
results for the selected region. Here is an example:

Figure 63. Quant Results for Selected Region

Selected region

Quant Results for Selected Region
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• To display the spectrum for the current cursor location, click Charts (see above) and then 
click Spectrum.

Figure 64. Results Pane with Spectrum Displayed

• To redisplay the quant results, click Grid (see above).

Compare Multiple Extracted Spectra

To compare spectra from multiple extraction regions, extract and then manually save each 
spectrum file to the project folder. Perform the spectral comparison in Spectrum mode. See 
Compare Spectra for more information.

Specify Which Elements are Mapped

 To specify which elements are mapped

1. Open or acquire a spectral imaging data set.

If Auto ID is selected, the software extracts the spectra from the electron image and 
identifies the found elements. A map for each found element is displayed in the maps 
pane. The cumulative spectrum from the electron image is displayed in the spectrum 
pane.

2. Perform an area extraction.

The software extracts the spectra in the selected area and identifies the found elements.

3. From the controls panel and select the Spectrum Processing tab.

4. Click Ident Setup and turn off (deselect) Auto ID.

5. Click Quant Setup and turn off (deselect) Auto Quant.



6 Spectral Imaging Mode
Extract and Analyze Data

196 Pathfinder User Guide Thermo Scientific

6. Right-click each element you want to analyze for and choose Identify.

7. Right-click each element you want to exclude from the analysis and choose Inactive.

8. Select the Map Processing tab and click the Process button.

The new map set is created and displayed in the maps pane. The cumulative spectrum for 
the selected area is displayed in the spectrum pane.

 To change which element X-ray line is mapped

1. Right-click the element symbol in the periodic table.

2. Choose Mapping Lines and select a line type.

Note  The software automatically identifies which lines are used for mapping based on 
their associated elements and the accelerating voltage setting in Microscope Settings.
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3. Select the Map Processing tab and click the Process button.

 To specify which energy range is mapped

1. Right-click the element symbol in the periodic table.

2. Choose Advanced.

3. In the Advanced Element box, specify the energy range in eV.

4. Select the Map Processing tab and click the Process button.

Quantify Map Data

Coordinated Intensity Cursors

Click the Intensity Cursor  button on the image pane toolbar to display the 
intensity cursor in the image pane. The cursor shows the pixel intensity and X-Y coordinates 
(in pixels) of the current cursor location in the upper left corner of the image pane.

Figure 65. Intensity Cursor Displayed in Image Pane

A coordinated intensity cursor shows the location of that point in every map in the maps 
pane. The X-Y coordinates (in pixels) of the current cursor location is displayed in the upper 
right corner of the maps pane.

Intensity cursor

Pixel intensity
Pixel location
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Figure 66. Coordinated Intensity Cursors in Image and Maps Panes

You can click points, or drag the cursor to another location, on the image or any map to 
update the pixel intensity and location information.

Note  If the resolution of the electron image is different from the resolutions of the 
element maps, the current cursor locations will be different since those locations are 
reported in pixels.

Note  

• To change the colors of the intensity cursors, choose Image Settings on the controls 
panel and click Marker Colors.

• If the Intensity Cursor and the Cursor (Extraction) Shape are both selected, the 
Intensity Cursor takes preference. (Turn off (deselect) the Intensity Cursor when you 
are extracting spectra and generating maps.)

Coordinated Intensity Cursors

Coordinated Intensity Cursors

Current Cursor Location
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Quantify Selected Elements

Follow these steps to specify quant settings and quantify the elements that are selected in the 
element setup pane (periodic table).

 To quantify the selected elements

1. On the controls panel, select the Map Processing tab and click Quant.

2. Set Map Data Type to the type of quant data to extract from the maps.
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3. Clear the Threshold option for the initial quantitative analysis to quantify all the 
extracted element maps.

4. Set Output Resolution to Partial Shift Kernel.

5. Set Processing Accuracy to High Precision.

6. Set Kernel Size to Auto.

7. To start the analysis, click the Process button on the Map Processing tab.

Note  If the noise level of your data is high, you can set up a count or intensity based 
threshold to minimize it. See Threshold for more information.
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The quant results are displayed in the maps pane. The data type, number of frames and 
kernel size used are listed above the maps. Here is an example:

8. You can refine the analysis based on your knowledge of the sample by trying other quant 
settings and then clicking the Process button to reanalyze the data.

Keep in mind that the High Detail resolution setting takes longer to process.

9. To see the quant data, select the Intensity Cursor  on the image pane toolbar 
and click a point on the electron image or any extracted map.
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The quant results for each element at the current cursor location are displayed at the right 
edge of the maps pane.
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Map Processing Quant Settings

To see the quant settings in Spectral Imaging mode, select the Map Processing tab on the 
controls panel and click the Quant button.
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These options are available:

Setting Description

Map Data Type Defines the format of the extracted quant data displayed in the 
maps pane. These options are available:

• Atomic%. Atomic concentration of the element in the 
sample expressed as a percentage.

• Weight%. Mass of the quantified element in the sample 
expressed as a percentage.

• K-Ratio%. Measured k-ratio (net counts sample/net counts 
from pure element) for the X-ray line expressed as a 
percentage.

• Net Counts. Number of X-rays received and processed by 
the detector with background characteristics removed (useful 
for cleaning up noisy maps)

Threshold Allows you to set a threshold value for the quantitative analysis. 
When Threshold is selected, you can enter threshold values for 
on peak counts or pixel intensity or both of those. To 
determine an appropriate peak count or intensity setting, 
perform a single pixel extraction at a representative location on 
the sample and assess the noise level on the spectrum.

Clear the Threshold option to quantify all peaks and pixel 
intensities in the extracted element maps.

Output Resolution Defines the resolution of the extracted element maps used for 
quantitative analysis. These options are available:

• High Speed. Uses tiled (adjacent) kernels with no overlap 
and provides the lowest level of detail.

• Partial Shift Kernel. Kernel areas are overlapped by less 
than half a kernel width (provides medium detail).

• High Detail. Kernel areas are overlapped by one pixel 
(provides the highest detail).

Processing Accuracy Defines the accuracy of the quantitative analysis. These options 
are available:

• High Speed. Provides reasonable filter fit results at high 
processing rates (makes some assumptions about the data).

• High Precision. Provides the most accurate filter fit results 
at slower processing rates (no assumptions are made).
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Overlay Maps and Electron Image
You can overlay individual (or multiple) element maps (X-ray count, quant or principal 
component) on the electron image to see where found elements overlap visible features on the 
sample.

 To overlay an element map on the electron image

1. Click to select the element label above the map.

Here is a map of magnesium K line overlaid on the electron image.

Kernel Size Divides the maps into squares based on pixels. The data in each 
section is summarized and used for quantitative analysis. These 
options are available:

• Auto. The software selects the optimal kernel size based on 
the total number of counts within the kernel.

• Manual (from 1x1 to 19x19).

Note: Kernel size affects the accuracy of the quantitative results; 
the larger the kernel size, the less detail will occur in the maps.

Process button Runs a quantitative analysis on the displayed data using the 
current Map Processing settings. Displays the results in the maps 
pane.

Select the Intensity Cursor  on the image pane 
toolbar to see the quant results for selected points on the electron 
image or element maps.

Setting Description

Mg map overlaid on electron image Mg map selected for overlay
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To adjust the transparency of the overlaid map, select the Image Settings tab on the controls 
panel, set Scope to Electron Image, and adjust the Transparency Factor slider bar.

Note  To help identify elements that are found together, assign the related element maps 
primary colors. For example, when a red map and a green one are overlaid on the electron 
image, the areas where they overlap will be yellow. In the same way, red plus blue equals 
magenta; blue plus green equals teal; red plus green plus blue equal white. Here is an 
example:

To assign map colors, select the Image Settings tab on the controls panel. See Adjust Map 
Type, Intensity and Color for more information.
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 To overlay all element maps on the electron image

1. Select the Image Settings tab on the controls panel.

2. On the Image Settings tab, set Scope to Electron Image.

3. Clear and then reselect Map Overlays.

Here is an example:

Use Show 
Legend in Image 
Settings to 
display legend 
of color 
assignments for 
overlaid maps
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Adjust Map Type, Intensity and Color

Select Map Type

Element maps (and the electron image) can be displayed as graduated maps or contour maps. 
All of the maps use color variations to show the locations and concentrations of elements on 
the sample. Use the Scope and Mode settings in Image Settings to select which type of maps 
to display.

Use Scope to select the map (electron image, all element maps, or a selected element map). 
Then use Mode to select the mode (Auto, Manual, Hot Pixel Suppression or Contour). All of 
these options are described below:

Note  To display the legend of color assignments for the element quant maps, select 
Show Legend on the Image Settings tab:

Note  The software displays all maps with hot pixel suppression during acquisition. After 
that, it may switch to Auto if the maps contain sufficient data to produce good definition 
with a linear color ramp.
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Map Mode options:

• Auto. Displays the selected map(s) or image as a single color with a linear ramp between 
the lowest and highest intensity values. Color intensity is directly related to X-ray 
intensity. Works well for electron images or element maps that have lots of statistical data 
(high number of X-ray counts).

• Manual. Lets you manually adjust brightness, contrast and gamma encoding for the 
electron image, a selected element map, or all displayed element maps. (If you change a 
Contrast, Brightness or Gamma setting, Mode automatically resets to Manual.)

• Hot Pixel Suppression. Displays the selected map(s) or image as a single color with a 
linear ramp that uses hot pixel suppression to assign intensity values. The pixel 
suppression algorithm eliminates unusually high intensity pixels that are typically due to 
random noise. The remaining pixel intensities represent X-ray counts that are due to the 
sample. It also expands the histogram to average the image across the full range of 
intensities. This helps ensure that pixels with the highest X-ray counts are set to a high 
intensity, and pixels with the lowest X-ray counts (i.e., due to noise) are set to a low 
intensity.

• Contour. Displays the selected element map with multiple colors where each color 
represents a step change in X-ray intensity. The relative spacing of the lines indicates the 
relative change in X-ray intensity. The Contour setting is available only when Scope is set 
to Selected Map.

Select Map Colors

 To change the color of a selected element map

1. Select the Image Settings tab on the controls panel.

2. Set Scope to Selected Map.

3. Click the element map in the maps pane to select the map you want to change.
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The element symbol appears next to the “Selected Map” button in the Image Settings.

4. In the Image Properties group, set Map Color to the new color for the selected map.

The selected map changes to the new color in the maps pane.

5. Adjust the brightness, contrast and gamma settings as needed.

These settings affect only the selected map.

6. Select Autoscale to autoscale the histogram of the selected map.

Reset Colors for All Element Maps

 To reset the colors for all displayed element maps

1. Select the Image Settings tab on the controls panel.

2. Set Scope to All Map.
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3. Click Reset Colors.

The software’s default color scheme is applied to all displayed element maps.

Select Colors for Contour Maps

We recommend using the default color palette for contour maps. If you want to change the 
palette for a contour map, follow these steps.

 To change the color palette for a contour map

1. Select the Image Settings tab on the controls panel.

2. Set Scope to Selected Map.

3. Click the element map in the maps pane to select the map you want to change.
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The element symbol appears next to the “Selected Map” button in the image settings.

4. In the Image Properties group, set Mode to Contour (see previous image).

Map Color is automatically set to Contour, which is a custom color palette for contour 
maps.

5. Click the green arrow to select Advanced View (see previous image).

6. In the Contour Properties group, set Type, Gradations and High/Low.

These contour color options are available:

Feature Setting

Type Defines how contour areas are displayed. Available options:
• Outline. Contour areas are outlined with selected color.
• Fill. Contour areas are filled with selected color.
• Fill + Outline. Contour areas are outlined and filled with 

selected color.

Gradations Number of gradations (steps) used for the contour map where 
each step is a unique color. The higher the number of 
gradations, the finer the detail in the contour map.

High Upper limit of intensity range that will appear in the contour 
map

Low Lower limit of intensity range that will appear in the contour 
map

Click to select 
Advanced View
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Examples:

Image Filters
Image filters can be used to improve the appearance of element maps and to selectively 
highlight specific information. The software offers a number of filtering techniques in 
Spectral Imaging mode. The best option depends on the image and how it will be used.

Filtering uses a kernel with an odd numbered matrix array of MxM size (e.g., 3x3, 5x5, 7x7, 
etc.). For example, a 3x3 kernel looks like this:

Filtering scales the pixel values that correspond with each kernel cell (A to I). The scaling 
factor for each cell is defined by the type of filter used (for example, the Sobel filter has 
different scaling factors than the Laplace filter). The results are always placed in the center 
pixel (cell “E” in the example above). The kernels are moved across the image at the full 
resolution of the image (i.e., one pixel at a time).

Original map

Contour map 
with Fill type 
and 2 
gradations

Contour map 
with Outline 
type and 2 
gradations

Contour map 
with Fill + 
Outline type 
and 2 
gradations

Note  Image filters alter the appearance of displayed element maps but do not change the 
raw data. 
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Using image filters to clean up element maps can facilitate interpretation. Here are some 
examples:

Figure 67. Raw Versus Filtered X-ray Maps

Figure 68. Overlay of Effectively Filtered X-ray Maps

Apply Image Filters

Image filters can be used to enhance element maps that have low counts in the element 
distribution and are “noisy” due to background counts. For example, semi-conductors 
produce low element counts because they do not have a lot of material to fluoresce. Selecting 
a filter that lowers background but preserves edge definition can significantly improve the 
appearance of these types of maps.

Note  Our software includes generally accepted filter types for processing image maps. 
Information about scaling factors and other setable parameters for these filters is available 
in any image processing text book or an equivalent resource.

Raw X-ray Maps

Same Maps with 1 Pass or 3x3 Kernel, Mean Filter Applied
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 To apply a filter on a single element map in Spectral Imaging mode

1. Select the Image Filters tab on the controls panel.

2. Select Use Filters.

3. On the Image Filters tab, set Scope to Selected Map.

4. Click the element map in the maps pane to select the map you want to apply a filter to.

The element symbol appears next to the “Selected Map” button in the image filters.

5. Select one or more available filters to apply by selecting the filter name in the list box and 
then clicking the right arrow  button to move it to the Selected Filters box (see the 
previous image).

We recommend that you start with a smoothing filter such as the mean filter and 
evaluate its effect on the element map before applying additional filters.

6. Change the Kernel Size and Passes if desired and click Update to adjust the effects of the 
selected filters.

7. Enter or select values for any other setable parameters for the selected filter.

For example, the Mean filter can be applied with or without normalization and negative 
offset.

The values are either 1 (on) or 0 (off ).

Note  To apply image filters to all displayed element maps, set Scope to All Maps 
instead of Selected Map.

Click to select 
Advanced View
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Image Filter Settings

Table 19. Image Filter Settings Available in Spectral Imaging Mode

Setting Description

Use Filters Defines whether the filters listed in the Selected filters box have 
been applied to the selected element map or to all displayed 
element maps

Scope Specifies where the selected filters are applied (selected element 
map or all displayed element maps)

Available Filters List of industry standard filters available in the software. Select 
an available filter from the dropdown list and click the right 
arrow  button to copy it to the Selected Filters list and 
apply it to the selected map(s).

Filters fall into three general categories:
• Smoothing filters, which reduce noise but blur intensity 

level boundaries. Includes Mean, Adaptive Mean, Lowpass 
1 or 2, Gaussian, Median, Rank, Erode, Dilate, SNN, K-N, 
EPS, Extended MHN, Wiener.

• Sharpening filters, which enhance differences in intensity 
levels but increase noise. Includes Sharpen, Highpass 1, 2 or 
3, Gated Rank, Min/Max.

• Edge filters, which smooth less effectively but preserve the 
divisions between intensity levels. Includes Sobel, Laplace 1, 
2, or 3, Horizontal or Vertical Derivative, Horizontal or 
Vertical Line, Positive or Negative Diagonal.

If you add multiple filters to the list, use the up and down 
arrows to specify the order in which the filters are applied.

Kernel Size Divides each map into squares based on the specified odd 
number of pixels (e.g., 3x3, 5x5, 7x7, etc). This is the pattern 
used to apply the specified filter(s).

Passes Specifies the number of times the selected filters are applied

Normalize Output For mean filtering, set this option to 1 to normalize the filtered 
output. Normalization adjusts the histogram scaling using a 
predefined scaling factor based on the number of pixels.

Set Normalization Output to zero to turn off normalization.
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Work With Spectral Imaging Files

Open Spectral Imaging Files

 To open a spectral imaging file in the current project

1. Select the file in the file list pane.

This can be a CSI (.csi), MAP (.map), or EDS (.eds) filename extension.

 To open a spectral imaging file from other project

1. From the Home screen, choose File (menu) > Open.

2. Navigate to the project that contains the file.

3. Select All Files to show all the available files in the folder.

4. Select the file click Open.

This can be a CSI (.csi) (full data) file or a noneditable MAP (.map) file that was 
previously saved. The data are displayed in the Spectral Imaging mode and take on the 
characteristics of the current project.

Compress Spectral Imaging Files

Use this option to select a folder of acquired data for additional compression, resulting in file 
sizes that are reduced by a factor of 10. (All acquired data are partially compressed during 
acquisition.)

 To reduce the size of a spectral imaging file

1. From the Home screen, choose File (menu) > Compress SI File.

Negative Offset For mean filtering, set this option to 1 to apply a negative offset 
to the data.

Set Negative Offset to Zero to turn off the negative offset.

Update Applies the current filter settings to the selected element map or 
to all displayed maps, depending on the Scope setting.

Table 19. Image Filter Settings Available in Spectral Imaging Mode

Setting Description

Note  If Compress SI File is unavailable in the File menu, all the files in the current 
project folder have already been compressed. This option is also unavailable during 
acquisition.
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2. Select a folder and select one or more SI files to compress.

3. Click OK.

A progress dialog box appears. Compression time might take several minutes per file.

Save Element Maps

Spectral imaging files that contain all the available data and information have an EDS (.eds) 
filename extension in the file list pane. You can also save just the map data that have been 
extracted or processed, or all the displayed element maps, to a MAP file (.map filename 
extension). This is helpful if you want map data in a specific format without having to extract 
it each time you open the file.

 To save just the map data from a spectral imaging file

1. In Spectral Imaging mode, select a spectral imaging file that contains all the acquired 
data, such as an EDS (.eds) file.

2. Extract and configure the electron image (image pane) and element maps (maps pane) as 
you want them saved, including any map processing or image filters.

3. Choose File (menu) > Save Map File.

4. In the Save SI Map Set box, enter a two-part filename for the map file in the two edit 
boxes (the original SI filename and data type are the defaults).

5. Choose OK to close the Save box.

The map file appears in the file list pane with the entered filename and a MAP (.map) 
filename extension. Here is an example:

Note  Once saved, the .map file is a fixed image of the final map state. It can no longer be 
processed or manipulated other than changing image filters or image settings such as 
brightness, contrast and gamma. If you want to apply more advanced processing steps, 
you will need to re-extract the original spectral imaging data set.
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Additional Tools

Measure Feature Sizes with the Ruler Tool

Use the Ruler tool  on the image pane toolbar to measure the size of features in the 
electron image.

 To measure a feature in the electron image

1. Select the Ruler tool on the image pane toolbar to display the ruler in the image pane.

The current length of the ruler is displayed directly below it.

2. Drag the middle of the ruler to move it to the feature you want to measure. To lengthen 
or shorten the ruler, drag either end.

Note  When you save maps, the software also creates the following files which are visible in 
the file list pane in electron imaging mode and in Windows Explorer.

• [Filename]_[element name]_Map.tif (one file for each element map).
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Display Topographical Images with the Surface Tool

Use the Surface tool  on the image pane toolbar to create a topographical element 
map for the entire region displayed in the image pane. The topographical image shows the 
distribution of X-ray count values for the selected element over the measured sample surface.

Display a Topographical Element Map

 To display a topographical element map

1. Select the Surface tool on the image pane toolbar.

The image pane and element map pane move to the bottom of the screen and a large 
topographical map pane appears. The X-Ray Topography settings are displayed on the 
controls panel.

File List paneElectron image Maps pane

Topographical Map pane X-Ray Topography settings
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2. Select an element map by clicking it’s symbol directly above the map.

The image pane shows the selected element map overlaid on the electron image. A 
topographical map for the selected element overlaid on the electron image appears in the 
topographical map pane. The X-Ray Topography settings are displayed on the controls 
panel.

Change the Element Map Displayed in the Topographical Map Pane

 To change the element map displayed in the topographical map pane

1. Click to deselect the symbol for the currently displayed element map.

2. Click to select the symbol for the new element map.

Electron image with overlaid element map

X-Ray Topography settingsTopographical Map of Overlaid Element

Selected element
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X-Ray Topography Settings

Use the settings on the X-Ray Topography tab to specify the appearance of the displayed 
topographical map. These options are available:

Table 20. X-Ray Topography Settings in Spectral Imaging Mode

Setting Description

Graph Style Defines the overall appearance of the topographical graph. 
Available options:

• None. Used for showing contour plots only. Here is an 
example:

Note: Contour Style must be set to Contour or Profile.

• Solid Surface. A warped, interpolated surface showing 
values at different locations on the sample. This is a 
conversion of the contour display to a three-dimensional 
form that makes it easier to see the values across the sample.

• Wireframe. Same as Solid Surface setting with black lines 
running along the intersecting edges of the imaginary planes 
of the surface plot but does not display the planes 
themselves.

Contour Style Defines the appearance of the contour lines. Available options:

• Contour. Uses contour lines to represent constant values. 
When Graph Style is set to Solid Surface, the contour lines 
are black. When Graph Style is set to Wireframe, values are 
indicated by the colors defined in the color bar (similar to 
the contour lines of a geographical relief map that indicate 
constant elevation).

• Profile (waterfall). Uses profile lines to represent constant 
Y-axis values. When Graph Style is set to Solid Surface, the 
profile lines are black. When Graph Style is set to 
Wireframe, the Z (vertical axis) values are indicated by the 
colors defined in the color bar.
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Color Scheme Defines the color scheme for the topographical image. Available 
options:

• Gray Scale. Uses shades of gray along a gradient to represent 
values.

• Rainbow. Values are represented by a gradient of blended 
rainbow colors.

• Banded. Values are represented by bands of distinct colors.

• Blue-to-red. Values are represented by blended colors from 
blue to red.

Cursor Style Specifies a style for the intensity cursor in the topographical map 
pane. (Use the image pane or map pane to select the cursor 
location.) Available options:

• Wireframe Planes. Displays cursor as outlines of three 
imaginary orthogonal (perpendicular) planes that intersect 
at the cursor location. Perpendicular lines that pass through 
that location are also displayed.

• Extended Cross Hairs. Displays cursor as perpendicular 
lines that pass through the cursor location along with 
extension lines that connect those lines to the axes.

Smoothing Smooths the edges and blends color transitions in the 
topographical image.

• None. No smoothing function is applied to the 
topographical image.

• Mesh. Applies a smoothing function that emphasizes peak 
heights.

• Shading (Gouraud). Applies a (Gouraud) smoothing 
function that emphasizes shading.

Font Size Increases or decreases the font size of axes markers in the 
topographical map pane.

Opacity % Increases or decreases the opacity of the topographical image.

Reducing the opacity makes high intensity peaks that are close 
together more translucent so you can see underlying peak 
shapes.

Table 20. X-Ray Topography Settings in Spectral Imaging Mode

Setting Description
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Extract and Analyze Principal Components with the COMPASS Tool
COMPASS is an optional software application that allows you to extract compositionally 
distinct components from a spectral imaging data set. COMPASS is a multivariate statistical 
analysis with no user input.

Principal Component Analysis (PCA) is a powerful technique to determine the relationship 
between variables within a data set. PCA uses advanced matrix algebra (linear 
transformations) to transform a number of possibly correlated variables into a smaller number 
of variables called principal components. The results are based on eigenvectors and 
eigenvalues. The eigenvector with the highest eigenvalue has the highest variance and is 
principal component number 1. The next highest eigenvalue is principal component number 
2, and so on.

Combine Electron Image Creates a topographical grey scale image in which the grays 
match those in the electron image. Intensities are indicated by 
peak heights (Z values) rather than by colors.

Clip Data Outside Color 
Range

Clips peaks that are outside the color range of the selected color 
scheme.

Show Outline Box Displays or hides the outline box in the topographical map pane. 
The outline box indicates the outer limits of the topographical 
image.

Show Axes Displays or hides the X, Y, and Z axes in the topographical map 
pane.

Table 20. X-Ray Topography Settings in Spectral Imaging Mode

Setting Description
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Map Processing COMPASS Settings

To see the COMPASS settings in Spectral Imaging mode, select the Map Processing tab on 
the controls panel and click COMPASS.

The following settings are available for performing a COMPASS analysis.

Table 21. COMPASS Settings in Spectral Imaging Mode

Setting Description

Method Specify a data set to evaluate. Available options:

• Area (default). Weights the principal component analysis such 
that the pixels for a given component are generally located 
close together (i.e., weights by nearest neighbor). 
Recommended for most sample types.

• Spectral. Does not add any nearest neighbor weighting. 
Intended for data sets that contain many small phases or when 
the spectral imaging resolution is such that the interaction 
volume is much smaller than the step size. 

Background Defines how the background is removed. Available options:

• Calculate Using Data. Recommended for data sets that 
contain sufficient X-ray counts.

• Use Internal Model. Recommended for data sets that have low 
numbers of X-ray counts.
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Low Energy Cutoff Allows you to remove the noise peak from the data set to remove 
the noise component from the analysis results by entering a low 
energy cutoff value in eV. (The noise peak is a component and is 
calculated along with the elements.)

Number of 
Components

Defines the number of expected components (minus the noise peak 
if the Low Energy Cutoff is set up to remove it from the data set). 
Available options:

• 0 (Auto). Recommended for the first pass of a COMPASS 
analysis. This allows the software to calculate the maximum 
number of eigenvectors (covariance pairs) in the data set.

• 1-15. You can decrease the number of found components to 
exclude components you don’t need. For example, some 
components are similar and can be combined. You may also 
want to eliminate components that represent the interaction 
volume between two phases.

Note: You can also use the Phases and image filter tools to help 
with interpreting COMPASS maps.

Process Runs a COMPASS analysis on the displayed data using the current 
Map Processing settings. Displays the results in the maps pane.

Table 21. COMPASS Settings in Spectral Imaging Mode

Setting Description
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Perform a COMPASS Analysis

 To perform a COMPASS analysis on the selected elements

1. On the controls panel, select the Map Processing tab and click COMPASS.

2. Select the method and background options.

3. If you want to remove the noise component from the analysis, enter an appropriate Low 
Energy Cutoff value for the data set in eV.

4. Set Number Of Components to 0 (Auto) for the initial analysis.
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5. Click Process to start the analysis.

When the analysis is completed, the component maps are displayed in the maps pane. 
Here is an example:

Each component map represents a unique found component in the sample. The first 
component (C1) represents the elements with the smallest covariance value. The map 
labeled C2 represents elements with the next highest covariance, and so on. The spectrum 
displayed in the spectrum pane (CP1) is associated with the first component map (C1).

6. To display the spectrum for another component, click its map image in the maps pane.

7. Reduce the Number Of Components setting if desired to eliminate unwanted found 
components, or adjust other settings as needed, and click Process to rerun the analysis.

Change Component Map Colors

 To change the colors of the component maps

1. Select the component map you want to change by clicking its image.

2. Select the Image Settings tab on the controls panel.

Electron Image COMPASS SettingsComponent Maps

File List paneFound Elements Spectrum for Component 1
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3. In Image Settings, set Scope to Selected Map.

The map name appears next to the “Selected Map” button in the image settings.

4. Set Map Color to the new color for the selected component map.

5. Adjust Mode, Brightness, Contrast or Gamma or Autoscale settings if needed.

Reset Color Palettes for All Component Maps

 To reset the color palettes for all displayed component maps

1. Select the Image Settings tab on the controls panel.

2. Set Scope to All Map.
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3. Click Reset Colors.

The software’s default color scheme is applied to all displayed component maps.
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Extract and Analyze Phases with the Phases Tool
The Phases tool is an optional software application that allows you to generate phase maps 
from X-ray count maps or COMPASS (component) maps. Phase maps are binary maps that 
indicate the locations of areas with similar composition.

Map Processing Phase Settings

To see the phase settings in Spectral Imaging mode, select the Map Processing tab on the 
controls panel (Map Type To Display can be set to Counts or COMPASS), click the Process 
button to extract the maps and then click Phases.

Note  After you have generated phase maps for a set of element maps (count maps or 
COMPASS maps), the Phases tab only allows you to combine selected phase maps. To 
regenerate the phase maps, first turn off (deselect) the Phases tab and click the Process 
button on the Map Processing tab to re-extract the element maps. Then click the Phases 
button to display the Phases tab shown above.
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The following settings are available for performing a phase analysis.

Table 22. Phase Settings in Spectral Imaging Mode

Setting Description

Phase Map Type Defines the type of phase map to generate. Available options:

• Maximum Intensity. Uses Maximum intensity values in each 
pixel of the X-ray lines to create phase maps. When this option 
is selected, the resulting phase maps look similar to COMPASS 
maps that have been extracted maps from the same sample, 
except the phase maps are binary. There are always the same 
number of found maximum intensity phases than found 
principal components.

• X Phase. Uses a proprietary algorithm to create phase maps 
(based on relative concentrations of the elements in the entire 
electron image). When this option is selected, the resulting 
phase maps may or may not resemble the COMPASS maps 
(There are typically more found phases than found 
components).

Minimum Phase 
Area %

The software does not create phases that are smaller than the 
entered minimum phase percent value. If a phase falls below the 
entered value, it is combined with the nearest phase. A setting of 
100% always produces one phase. A setting of 50% produces at 
most two phases.

Combinations Use this box to select the element count maps (COUNTS) or 
component (COMPASS) maps used to generate phases.
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Auto Runs a phase analysis on the selected elements where the software 
identifies the phases based on peaks and valleys in the data. Results 
are displayed in the maps pane.

Manual Allows you to manually set the thresholds used to generate phases 
for selected elements. Click Manual to set up the thresholds. In the 
Manual Phase Editor box, use the list box to select an element 
(Counts) or principal component (COMPASS) and then click the 
plus (+) button to add it to the setup box. Drag the vertical markers 
in the element spectrum to define low and high thresholds based 
on the displayed element map.

The Low and High Thresholds and Area % are updated 
automatically each time you move a marker. These additional 
options are available:

• Auto Segment Images. Automatically defines thresholds for all 
the element maps. May define multiple low/high threshold sets 
(segments) for each element.

• Auto Create Phases. Creates phase maps based on the 
elements and segments listed in the Manual Phase Editor box.

Table 22. Phase Settings in Spectral Imaging Mode

Setting Description
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Extract Phases From X-ray Count Maps

You can generate phase maps from X-ray count maps and combine selected phases. Select the 
element maps to include before you generate the phases. You can also include the 
low-resolution electron image.

 To extract phases from X-ray count maps

1. Acquire a spectral imaging data set or open an existing spectral imaging file.

2. Select the Map Processing tab on the controls panel and click Counts.

3. Extract and analyze X-ray count maps for the elements selected in the element setup pane 
(periodic table).

4. Click Phases on the Map Processing tab.

5. In the Select Elements For Phase Analysis box, select the element maps to include.

6. Set the Phase Map Type and Minimum Phase Area% if desired.

Note  If you don’t see the Phase tab settings shown above, turn off (deselect) the 
Phases tab and click the Process button on the Map Processing tab to re-extract the 
element maps. Then click the Phases button to display the Phases tab shown above.
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7. Click Auto to start the analysis.

The phase maps are generated and displayed in the maps pane. Here is an example:

8. To combine phases, select the phases you want to combine in the Combinations box.

Hold down the Ctrl key on the keyboard to select additional phases.

9. In the Combine Selected Phases Into This Phase box, select the phase to combine into 
(default is the first phase selected).

10. Click Combine.

The phases maps are updated with the selected phases combined.

Note  The phase maps are stored in the project’s temp folder and are moved to the project 
folder when the data are saved. This allows you to switch between COMPASS phase maps 
and X-ray count phase maps for comparison.

Combine these 
phases
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Extract Phases From COMPASS Maps

You can generate phase maps from component (COMPASS) maps and combine selected 
phases. Select the component maps to include before you generate the phases.

 To extract phases from principal component maps

1. Acquire a spectral imaging data set or open an existing spectral imaging file.

2. Select the Map Processing tab on the controls panel and click Counts.

3. Extract and analyze X-ray count maps for the elements selected in the element setup pane 
(periodic table).

4. On the Map Processing tab, click COMPASS.

5. Adjust the COMPASS settings as needed and click Process to extract and analyze 
component maps for the selected elements.

6. Click Phases on the Map Processing tab.

7. In the Select Elements For Phase Analysis box, select the component maps to include.

8. Set the Phase Map Type and Minimum Phase Area% if desired.

9. Click Auto to start the analysis.

The phase maps are generated and displayed in the maps pane.

Note  If you don’t see the Phase tab settings shown above, turn off (deselect) the 
Phases tab and click the Process button on the Map Processing tab to re-extract the 
element maps. Then click the Phases button to display the Phases tab shown above.
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10. To combine phases, select the phases you want to combine in the Combinations box.

Hold down the Ctrl key on the keyboard to select additional phases.

11. In the Combine Selected Phases Into This Phase box, select the phase to combine into 
(default is the first phase selected).

12. Click Combine.

The phases maps are updated with the selected phases combined.

Note  The phase maps are stored in the project’s temp folder and are moved to the project 
folder when the data are saved. This allows you to switch between COMPASS phase maps 
and X-ray count phase maps for comparison.
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7

Linescan Mode

This section covers Linescan mode, which can be used to acquire X-ray spectra at each point 
on a user-defined line drawn on an acquired electron image. Line scan data can provide 
detailed information about the transitions between distinct features on a sample. For example, 
line scan analysis is sometimes used to evaluate the integrity of a coating material or to 
investigate the migration of a coating into the base material and vice versa.

Acquired line scan data can be easily reprocessed and displayed in different formats.

Select Linescan Mode
To select Linescan mode, click the Linescan button on the analytical mode toolbar.

Figure 1. Select Linescan mode
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In Linescan mode, the software displays all the features and tools for X-ray count analysis of 
the transitions in a user-defined axis across the selected microscope field of view.

Figure 2. Pathfinder Linescan Mode User Interface

Figure 3. Image Pane Toolbar Buttons Available in Linescan Mode

Image pane Line Scan Graph Controls panel

File List paneImage pane toolbar Results pane (spectrum, chart or grid)Element Setup pane

Display/hide 
Intensity cursor

Display line scan
cursor (always selected)
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Overview of X-ray Line Scan Acquisition
The basic steps to set up and acquire X-ray line scan data are outlined below. All of these steps 
are described in more detail in the sections that follow.

 Basic steps to perform a line scan analysis

1. Start Pathfinder software and create or select a project.

2. Select the Linescan analytical mode.

3. Set the basic microscope parameters.

4. Prepare the sample.

5. Enter an experiment name.

6. Acquire an averaged electron image to use as the reference image.

7. Set the line scan acquisition and processing parameters.

8. Set the known elements to Always Identified in the periodic table.

9. Acquire and save the line scan data.

Note  The sample composition is assumed to be known. If the sample elements are 
unknown, start with a spectral analysis (Spectrum mode) or spectral imaging analysis 
(Spectral Imaging mode) to determine the sample composition before proceeding with the 
line scan analysis.
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Line Scan Spectral Acquisition Settings
To access the spectral acquisition settings for Linescan mode, click the Experiment Setup 
button  on the right side of the acquisitions toolbar.

The following spectral acquisition settings are available.

Linescan 
Acquisition
Settings

Table 1. Linescan Mode, Spectral Acquisition Settings

Group Setting Description

Active Detector(s) Detector One/
Detector Two

Available only when multiple Pathfinder- compatible detectors are 
installed on the microscope. When multiple detectors are installed, 
use the Detector One/Detector Two buttons to select which 
detector(s) you want to use for the analysis.

Note: The Detector 1 and Detector 2 settings in the software refer 
to the detector cables attached to the Detector 1 and Detector 2 
Preamp ports on the Pathfinder chassis.

Linescan Number of Points in 
Scan

Defines the number of measured points in the line scan (typically at 
least one point per micron).

Note: The extract properties for line scan points apply only to 
Spectral Imaging Line Scans and do not affect the acquired number 
of points in X-ray Linescan mode.
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Number Of Scans The number of times the electron beam scans the line. To increase 
element intensities, acquire more scans. For sensitive samples, 
increase the scan count and reduce the dwell time.

Dwell Time Per Pixel The length of time the beam remains at each measured location in 
seconds. A long dwell time reduces image noise but increases the 
acquisition time. A short dwell time might cause a blurred or 
streaked image.

For sensitive samples, increase the scan count and reduce the dwell 
time.

Acquisition Time Estimated total time in seconds to acquire all requested scans of the 
drawn line

Total Line Time Estimated time in seconds to acquire one scan of the drawn line

Options Acquire Video Acquires a grey-scale intensity profile concurrently with each line 
scan. The profile provides a reference intensity for each line scan 
point.

Scan Stage When the Stage Automation option is installed, selecting this 
option moves the microscope stage to generate the line scan, 
resulting in a higher resolution scan. Typically used for WDS 
acquisitions to ensure the WDS stays in focus throughout the line 
scan.

When this option is cleared, the software moves the electron beam 
to generate the line scan. This is the faster option.

Custom Save Custom Settings 1
Save Custom Settings 2

Allows you to save up to two instances of the Experiment Setup 
screen for spectral acquisitions (C1 and C2) that can be easily 
recalled later by clicking the Setting Presets button on the 
Acquisitions toolbar and choosing an option from the list box.

Table 1. Linescan Mode, Spectral Acquisition Settings

Group Setting Description
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Linescan Processing Settings
To access the processing settings for Linescan mode, click the Linescan Processing tab on the 
controls panel.

The following Linescan processing settings are available.

Table 2. Linescan Mode, Linescan Processing Settings

Group Setting Description

Linescan Data Type Linescan Data Type Defines the format of the extracted quant data displayed in the line 
scan graph. These options are available:

• Counts. Number of X-rays received and processed by the 
detector.

• Atomic%. The atomic concentration of the element in the 
sample expressed as a percentage.

• Weight%. The mass of the quantified element in the sample 
expressed as a percentage.

• K-ratio%. Measured k-ratio (net counts sample/net counts 
from pure element) for the X-ray line.

• Net counts. Number of X-rays received and processed by the 
detector with background characteristics removed

Number Of Points Number Of Points Defines the number of measured points in the line scan (typically at 
least one point per micron).

Data Options Log Scale Displays the acquired data using a logarithmic scale

Smooth Applies the selected level of smoothing to the line scan graph
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Line Scan Spectral Processing Settings
We typically recommend that you use one of the other analytical modes, such as Spectrum 
mode or Spectral Imaging mode, to identify the elements in the microscope field of view 
before you perform a line scan analysis. You should also specify the spectral processing settings 
(Ident Setup and Quant Setup) you want to use.

Once you know the sample composition, select the Linescan analytical mode and set the 
known elements to Always Identified before you start the line scan analysis.

If you want to run the line scan analysis with automatic spectral processing (qualitative and 
quantitative) using only the data points measured in the line scan, follow these steps.

Spline Applies a spline function to the line scan graph

Linescan Display Grid Displays a grid in the line scan graph background

Symbols Marks each data point in the line scan graph with a symbol

Error Bars When Linescan Data Type is set to one of these options, adds error 
bars to the graph to indicate the error level for the measured value:

• Atomic%
• Weight%
• K-ratio%
• Net counts

Line Profiles Line Profiles Determines how line scan data for selected elements are overlaid on 
the electron image. These options are available:

• On Linescan. Displays line scan data for the selected elements 
adjacent to the line scan.

• On Axis. Displays line scan data for the selected elements on 
the electron image axis.

• Overlaid. When line scan data for multiple elements are 
selected for overlay, all of the element line scans are overlaid on 
the electron image.

• Stacked. When line scan data for multiple elements are selected 
for overlay, the element line scans are stacked and scaled 
according to the scale setting (see below).

• Scaled Independently. When selected, scales each overlaid 
line scan independently. When deselected, scales all 
overlaid line scans the same.

Table 2. Linescan Mode, Linescan Processing Settings

Group Setting Description
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 To set up automatic spectral processing (not recommended)

1. Click the Spectrum Processing tab  on the controls panel.

The following options are displayed.

2. To set up automatic element search and identification, choose Ident Setup, set the 
identification parameters as desired and make sure Auto ID is selected.

3. To set up a automatic quantitative analysis, choose Quant Setup, set the quant 
parameters as desired and make sure Auto Quant is selected.

4. In the element setup pane, right-click the C (carbon) symbol and choose Always 
Identified.

Since carbon is present in most samples, this allows the line scan to run without any other 
elements identified. You can then identify the elements of interest and manually set each 
one to Always Identified.

Acquire a Line Scan
This section walks you through a line scan analysis.

 To acquire and analyze a data set

1. Start Pathfinder software and create or open a project.

2. Click the Linescan icon  on the analytical mode toolbar.

Note  The sample composition is assumed to be known. If the sample elements are 
unknown, start with a spectral analysis (Spectrum mode) or spectral imaging analysis 
(Spectral Imaging mode) to determine the sample composition before proceeding with the 
line scan analysis.
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3. Prepare the sample.

Place the sample in the microscope and obtain an image. Adjust the stage height (Z-axis) 
to the optimal working distance for the EDS detector. Obtain a good microscope image 
of an area of interest on the sample. See Microscope Considerations for details.

4. Fully insert the EDS detector.

5. Set the basic microscope parameters:

– To set the microscope parameters manually, from the Home screen, choose Edit > 
Microscope Parameters. Set these parameters and then choose Close

• Accelerating Voltage in kilovolts (kV)

• Magnification

• Working Distance in millimeters (mm)

6. Enter an experiment name (used as a base name for automatically saving acquired data).

On the acquisitions toolbar, click the  button and enter the experiment name (or 
leave the default name).

7. Acquire an averaged electron image to use as the reference image.

Note  If your SEM has Column Communications, these parameters are entered 
automatically.
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- Click the image acquisition presets button on the acquisitions toolbar and choose 
Fast Image or High Resolution (see Electron Imaging Mode for more information).

- Click Get Image to acquire an electron image.

The button name changes to Stop Image. Wait until the acquisition is completed.

8. Set the line scan spectral acquisition parameters.

- Click the Linescan spectral acquisition presets button on the acquisitions toolbar and 
choose Fast Line or High Resolution (see Line Scan Spectral Acquisition Settings for 
more information).
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9. Set the line scan processing parameters.

- Click the Linescan Processing tab on the controls panel and set Linescan Data Type.

10. Select the known elements for analysis.

In the element setup pane (periodic table), right-click each element that is present in the 
sample and choose Always Identified.

11. Acquire the line scan data.

- In the image pane, click and drag the mouse cursor to draw the line you want to scan. 
The line can be any length and direction. Here is an example:

- Click Start Linescan to start the line scan acquisition.

The button name changes to Stop Linescan.

• To end the acquisition and save the data, click Stop Spectrum.

• To end the acquisition without saving the data, click the Abort button

Wait until the acquisition is completed.
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The results are displayed in a line scan graph. A legend shows the color assigned to each 
identified element. Here is an example:

When the acquisition is completed, the data set is automatically stored in the temporary 
directory and is ready for analysis. From here you can view the spectral or quant 
information for selected points or regions, or change the quant data type or the line scan 
display options.

12. To permanently save the data set in the current project, click the Save button  on the 
main toolbar, or choose File > Save.

Linescan data are saved with a LSCTL (.lsctl) filename extension. If you open a LSCTL 
file from Windows Explorer, it contains the following individual files:

• .lsmsa (spectra)

• .lsref (reference image)

Image pane Line scan graph Element List
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Analyze Line Scan Data

Coordinated Intensity Cursors

Click the Intensity Cursor  button on the image pane toolbar to display intensity 
cursors in the image and graph panes.

Figure 4. Coordinated Intensity Cursors in Image Pane and Line Scan Graph

The cursors show the pixel intensity and coordinates of the current cursor location in the 
upper left corner of the image pane.

Figure 5. Intensity Cursor Displayed in Image Pane

You can click or drag the cursor to another location in either pane to update the pixel intensity 
and location information.

Coordinated Intensity Cursors

Intensity cursor

Pixel intensity
Pixel location
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The results pane shows the quant data at the current cursor location. If you drag the cursor 
line right or left to select a region of the graph (gray area), the results pane shows the averaged 
results for the selected region. Here is an example:

Figure 6. Quant Results for Selected Region

Selected region

Quant Results for Selected RegionCharts button Options button
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• To select which quant results to include in the table, click the Options button (see the 
previous image).

• To display the spectrum for the current cursor location, click the Charts button (see the 
previous image) and then click Spectrum.

Figure 7. Results Pane with Spectrum Displayed

• To redisplay the quant results, click Grid (see above).
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Select Elements For Line Scan Graph

When the line scan acquisition is completed, a list of found elements appears at the right edge 
of the line scan graph.

Figure 8. Linescan Graph Element List

 To add an element to the line scan graph

1. Right-click the element in the element setup pane (periodic table) and choose Always 
Identified.

The data are reprocessed automatically and the added element appears in the element list.

 To remove an element from the line scan graph

1. Right-click the element in the element setup pane (periodic table) and choose Excluded.

The data are reprocessed automatically and the excluded element is removed from the 
element list.
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Change Line Scan Data Type

The Y-axis label shows the data type for the line scan graph.

Figure 9. Quant Data Type

 To change the line scan data type

1. Click the Linescan Processing tab on the controls panel.

2. Reset Linescan Data Type.

The data are reprocessed automatically. The updated results are displayed in the graph 
pane.
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Change the Appearance of the Line Scan Graph

Add Log Scale, Smoothing, Symbols or Grid

Use the features in Data Options and Linescan Display on the Linescan Processing tab to 
change the appearance of the line scan graph.

Figure 10. Line Scan Graph Display Options

Overlay Line Scans on Electron Image

 To overlay element line scan profiles on the electron image

1. Select the elements to overlay by clicking their symbols in the element list.
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2. Select the position of the overlaid element profiles (On Linescan or On Axis).

3. If multiple elements are selected, choose whether their profiles are overlaid or stacked on 
the electron image.

Figure 11. Line Scan Profiles Overlaid On Electron Image (On Linescan and Stacked)
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Export Line Scan Data
 To export line scan data as a CSV (comma separated values) file

1. In the Linescan analytical mode, select the file to export in the file list pane.

2. From the Home screen, choose File (menu) > Import/Export > Export Linescan as 
CSV.

3. Navigate to or create a folder for the exported data and choose Save.

The CSV file can be opened in any data processing application.
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8

Spectrum Match

Use the optional Spectrum Match software to identify a spectrum from an unknown material 
by comparing it to a database of previously acquired spectra from known materials. Spectrum 
Match can also be used in conjunction with Phase calculations in Spectral Imaging mode. 
Spectrum Match features are available in the software only when the option is installed.

Before you can use Spectral Match, you must create a Match library of spectra from known 
materials that are relevant to your field of study. You can then use the Match library to create 
smaller, application-specific databases that can be searched individually or in groups.

All of the features for creating a Match library and databases and for setting up and 
performing a search are on the Spectrum Match tab on the controls panel. Spectrum Match is 
available in all the analytical modes.

Figure 12. Spectrum Match features

Select and organize 
searchable spectra

Show/Hide Spectrum 
Match settings

Select a database 
to search

Search results 
pane

Run a spectral 
search
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Use Database Manager (see the previous image) to add spectra to the Match library and to 
create personal databases of searchable spectra that can be used with any project. Use Current 
Database to select a database to search. Use the Match button to search the selected 
spectrum. Use the down arrow button to access additional settings for customizing the search 
results.

Add Spectra to the Match Library
Before you can use Spectral Match, you must create a Match library of spectra of known 
materials that are relevant to your field of study. You can then use the Match library to create 
smaller, application-specific databases that can be individually searched.

This section explains how to add spectra to and delete spectra from the Match library. You can 
add spectral files immediately after you acquire them, import spectra from any project, or add 
synthetic spectra created using the software’s internal database of element spectra. Synthetic 
spectra can be created manually by entering elements and composition values or using CSV 
(comma separated values) data from an analyzed spectrum.

Add Acquired Spectra to Match Library

 To add acquired spectra to the Match library

1. Click the Spectrum Match tab on the controls panel.

2. Acquire the first spectrum so that it is displayed in the spectrum pane in any analytical 
mode.

3. Click Database Manager.

Note  It is good practice to search using spectra acquired with the same microscope 
accelerating voltage setting as the unknown sample spectrum. As a result, you may want to 
acquire spectra that will be added to the Spectrum Match library at several microscope 
accelerating voltage settings.

Note  The file will be added to the Match library with the filename shown in the file 
list pane. If you want to edit the filename before adding the spectrum to the library, 
use the Rename  button on the file management panel.
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4. In the Database Manager box, click the down arrow next to New Match File and select 
From Spectrum.

5. Enter a filename for the spectrum or use the default name and choose OK.

The spectrum is added to the end of the Available Match Files list. Here is an example:

Import Spectra to Match Library

 To import spectra to the Match library

1. Click the Spectrum Match tab on the controls panel.

2. Click Database Manager.
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3. In the Database Manager box, click the down arrow next to New Match File and select 
Import.

4. Navigate to the project and folder where the spectrum (.emsa) file is stored.

5. Select the file and choose Open.

The spectrum is added to the end of the Available Match Files list.

Create Synthetic Spectrum For Match Library

 To create a synthetic spectrum for the Match library

1. Click the Spectrum Match tab on the controls panel.

2. Click Database Manager.

3. In the Database Manager box, click the down arrow next to New Match File and select 
Manual.
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4. In the Create Simulated Spectrum box, enter the following:

• use Match Name to enter a name for the synthetic spectrum

• enter the desired Acceleration (accelerating voltage) in kV

• enter the desired Zero Width (width of the zero peak) in eV

• select a Composition Type (weight%, atomic% or atom count, which is the number 
of atoms from a stoichiometric formula)

5. For each element you want to add, use the down arrow to select the element symbol from 
the periodic table and enter its composition in the specified format.

The software uses its internal element database to create the simulated spectrum.

6. Click Show Spectrum to display the synthetic spectrum in the spectrum pane.

7. Click Define For Match and click OK to add the spectrum to the Match library.

8. Create and add additional synthetic spectra if desired.
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9. When you are finished, click the Close button to close the Create Simulated Match 
Spectrum box.

The added spectra are listed at the end of the Available Match Files list.

Use CSV Data To Create Synthetic Spectrum For Match Library

 To use CVS data to create a synthetic spectrum for the Match library

1. Click the Spectrum Match tab on the controls panel.

2. Click Database Manager.

3. In the Database Manager box, click the down arrow next to New Match File and select 
From CSV.
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4. In the Create Simulated Match Spectrum From CSV File box, enter the Acceleration 
Voltage in kV and Zero Width (width of the zero peak) in eV for the simulated 
spectrum.

5. To select one or more reference CSV files provided with the software, such as the 
stainless-steel spectra shown above, select the files in the list (use Ctrl or Shift keys to 
select multiple files).

The software uses its internal element database to create the simulated spectra.

Click Show Spectrum to display the selected synthetic reference spectrum in the 
spectrum pane. (This button is active only when one spectrum is selected.)

Click Define For Match and click OK to add the selected spectra to the Match library.

6. Create and add additional synthetic spectra if desired.

7. When you are finished, click the Close button to close the Create Simulated Match 
Spectrum box.

The added spectra are listed in the Available Match Files list.

Delete Spectra From the Match Library
 To delete spectra from the Match library

1. Click the Spectrum Match tab on the controls panel.

2. Click Database Manager.

Note  To add CSV data to this list in order to recreate the associated spectra and 
import them to the Match Library, open the list and enter the CSV values manually. 
The list is stored in this location:

C:\Program Files (x86)\Thermo Scientific\NSS\Match Library.csv
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3. In the Available Match Files box, select the file(s) you want to remove and click Delete.

Hold down the Shift key to select multiple contiguous files; hold down the Ctrl key to 
select multiple independent files.

Create a Searchable Match Database
Once you have the needed spectra in the Match library, you can use them to create 
application-specific databases that can be individually searched in any project.

 To create a searchable Match database

1. Click the Spectrum Match tab on the controls panel.

2. Click Database Manager.

3. In the Database Manager box, select the Current Database box, enter a new database 
name and click Create Database.

Note  It is good practice to search using spectra acquired with the same microscope 
accelerating voltage setting as the unknown sample spectrum. As a result, you may want to 
set up searchable databases that include spectra acquired at specific accelerating voltage 
settings.

Note  The Create Database button is available in the software only when the Current 
Database box is empty or contains a new database name.
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The Available Match Files box shows all the files in your Match library (use the scroll bar 
to review them). Those files are available for use in any searchable database you create. 
The Currently In Database box is empty.

4. In the Available Match Files box, select one or more files to include in the new database 
and click Add To Database.

Hold down the Shift key to select multiple contiguous files; hold down the Ctrl key to 
select multiple individual files.

Note  All the spectra you select should have been acquired using the same accelerating 
voltage setting. Use the kV column in the Available Match Files group to verify the 
accelerating voltage associated with each spectrum.

Match library 
spectra

Spectra in 
current 
database 
(empty)
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The files remain in the Match library box and also appear in the Currently In Database 
box.

5. Continue adding as many spectra as you need.

6. When you are finished, click the Close button to save the new database and close the 
Database Manager box.

The new Spectrum Match database is now ready for use.

Remove Spectra From a Match Database
 To remove spectra from a Match database

1. Click the Spectrum Match tab on the controls panel.

2. Click Database Manager.

3. Set Current Database to the database that contains the file(s) you want to remove.
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4. In the Currently In Database box, select the file(s) you want to remove and click Remove.

Hold down the Shift key to select multiple contiguous files; hold down the Ctrl key to 
select multiple independent files.

Delete a Match Database
 To delete a Match database

1. Click the Spectrum Match tab on the controls panel.

2. Click Database Manager, set Current Database to the database you want to delete.

3. Click Delete Database.

4. click the Close button to close the Database Manager.

Use Spectrum Match
After you have created one or more databases of searchable spectra, you are ready to run a 
Spectrum Match analysis, which searches the selected (displayed) spectrum against the 
selected spectral database. Spectrum Match can also be used in conjunction with Phase 
calculations in Spectral Imaging mode. Spectrum Match can be set up to run automatically 
after each spectrum is acquired, or it can be run manually on a displayed or stored spectrum.
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Identify an Unknown Material Using Spectrum Match

 To manually identify an unknown material using Spectrum Match

1. In any analytical mode, acquire or select the spectrum of an unknown sample so the 
spectrum is displayed in the spectrum pane.

2. Click the Spectrum Match tab on the controls panel.

3. Set Current Database to the database you want to use.

4. Click the arrow at the right of the Match button and specify the Spectrum Match settings 
(Auto Match can be on or off ).

5. Click the Match  button to start the search.
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The results are displayed on the Spectrum Match tab. The best matched spectrum is listed 
first. Here is an example:

Spectrum Match search results:

• Match Name is the filename of the spectrum in the selected database

• Chi-squared indicates the quality of the fit. The lower the chi-squared value the 
better is the fit. A chi-squared value of 0.0 is a perfect match. Try to keep the 
chi-squared value under 10.

6. To overlay a database spectrum from the Match Results box with the spectrum of the 
unknown sample, click the spectrum’s associated check box. The overlaid spectrum is 
highlighted in red in the spectrum pane. Here is an example:

To scale the overlaid spectrum, click the Match  button on the File Management 
panel and select a normalization setting. The normalization setting has no effect on the 
original spectrum.
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The available normalization options are described below.

Identify an Unknown Phase Spectra Using Spectrum Match

Spectrum Match can be used in conjunction with Phase calculations in Spectral Imaging 
mode. If a database exists and if Auto Match is selected in the Spectrum Match settings, the 
software attempts to match each spectrum generated by a Phase calculation with the spectra in 
the database. If a match is found, it renames that phase with the name of the matched 
spectrum.

Setting Description

None No normalization factor is applied

Livetime Normalizes the overlapped spectra based on the live time of 
the overlapped spectrum compared to the live time of the 
original spectrum. This simulates the same acquisition times 
for both spectra.

Element Adjusts the overlapped spectra to the height of the selected 
element peak or line in the original spectrum. The selected 
peak or line is based on accelerating voltage and the energy 
range of the spectrum.

Multiplier Enter a value that will be used to scale all overlapped spectra

Range Scales the overlapped spectra to the original spectrum based 
on a selected energy range. When Normalize To is set to 
Range, two dashed vertical lines are added to the displayed 
spectra. (If you don’t see the vertical lines, double-click to 
expand the spectrum pane.) Drag the lines left and right to 
define the left and right boundary of your selected range.

Note: Defining a range in a background region (between 
element peaks) sometimes gives the best results.

Maximum Scales the overlapped spectra to the original spectrum based 
on their maximum peak values in the displayed region

Maximum in Overlap If the overlapped spectrum intersects the original spectrum, 
the software scales the maximum peak value in the 
overlapped spectrum to match the maximum peak value in 
the original spectrum.

Note: This setting is intended for WDS data where the 
spectra may not cover the same energy range but still overlap 
in some energies.
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Configure Spectrum Match to Run Automatically

 To configure Spectrum Match to run automatically

1. Click the Spectrum Match tab on the controls panel.

2. Click Database Manager, set Current Database to the database you want to use and 
click the Close button.

3. Click the arrow at the right of the Match button and select Auto Match.

4. In any analytical mode, acquire or select the spectrum of an unknown sample so the 
spectrum is displayed in the spectrum pane.

The results are displayed on the Spectrum Match tab. The best matched spectrum is listed 
first.
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Spectrum Match Settings
To display the settings for customizing a Spectrum Match search, select the Spectrum Match 
tab on the controls panel and click the arrow next to the Match button.

Figure 13. Spectrum Match Settings

The available options are described below.

Table 3. Spectrum Match Settings

Feature Description

Match Cutoffs Enter a low and/or high cutoff value in eV to limit the 
searched region of the unknown sample spectrum 
(where 1000 eV is equal to 1 keV)

Max. Number of Match Results Defines the maximum number of search results to 
display
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Chi-Square Cutoff Defines the maximum chi-squared value for the search 
results. Typical value is 5. Increase this number to 
include more spectra in the search results box. 
Generally, a chi-squared value of 10 or less indicates a 
reasonable match.

Note: The number of background channels greatly 
influences the chi-squared values.

Auto Match Select this option to automatically run a Spectrum 
Match after each acquired spectrum

Table 3. Spectrum Match Settings

Feature Description
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9

Analysis Automation

Use the optional Analysis Automation software to automate analyses at pre-defined locations 
of the microscope stage without requiring operator input. Analysis Automation features are 
available in the software only when the software is installed. (The stage must be motorized 
and under digital control.)

You define the number of sampling points and their stage locations. The selected analytical 
mode specifies the type of data acquired and how the data are analyzed. When you start the 
automated analysis, the system moves the stage to the first sampling location and acquires and 
processes the data. Then it moves the stage to the next position and repeats the acquisition 
and analysis. The process continues until all specified points or area have been acquired and 
processed. Sampling locations can be saved for reuse.

Analysis Automation can be used in these analytical modes:

• Spectrum

• Spectral Imaging

• Point ID

• Linescan

• Electron Imaging

• Feature Sizing

Note  

• In Spectrum mode, the Analysis Automation settings allow you to specify the beam 
position (center spot or the entire field of view). The Pathfinder chassis hardware 
controls the beam position for Analysis Automation in all other analytical modes.

• Analysis Automation is designed to work with simple drift compensation where the 
area used to track the electron image is the same as the area being measured. To run an 
automated sequence with drift compensation, before you acquire an electron image or 
automated spectral acquisition, make sure Drift Compensation is set to Drift On. 
(Do not use the Rect Drift On setting.) See Drift Compensation for more 
information.



9 Analysis Automation
Analyze Pre-defined Locations In Spectrum Mode

278 Pathfinder User Guide Thermo Scientific

Analyze Pre-defined Locations In Spectrum Mode
This section provides an overview of the steps to set up and run a basic X-ray spectral analysis 
of selected sampling locations with Analysis Automation. It is assumed that you are familiar 
with basic sample acquisition and analysis using the Spectrum analytical mode.

 To acquire and analyze a series of sampling locations with Analysis Automation

5. Click the Spectrum  button on the analytical mode toolbar.

6. Set up the microscope as you would for a Spectrum analysis (adjust beam current to 
desired count rate and dead time).

7. Click the  button on the acquisitions toolbar and enter an experiment name (used as 
a base name for automatically saving acquired data).

8. Click the spectral acquisition presets button on the acquisitions toolbar and select a preset 
such as High Resolution or High Throughput.

9. Select the Spectrum Processing tab on the controls panel and set up any qualitative or 
quantitative analysis for the acquired data.

For qualitative analysis, click Ident Setup and make sure Auto ID is selected; for 
quantitative analysis, click Quant Setup and make sure Auto Quant is selected.

10. Click the Analysis Automation button on the acquisitions toolbar.

11. Set Acquisition Type to Selected Area.

12. Enter a Sequence Name (appended to the experiment name to identify each microscope 
location analyzed with Analysis Automation).
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13. Specify any advanced automation settings.

- Click the green arrow to show the advanced settings:

- Set Spectrum Acquisition:

• Center Spot. Acquires a spectrum in the center of the field of view for each specified 
location.

• Microscope Raster. Acquires spectra over the entire field of view and produces an 
average spectrum for each specified location.

- If you want the software to save the magnification settings with each sampling location, 
select Use Saved Mag.

- If you want the software to turn off the electron beam after the automated analysis is 
completed, select Beam Off.

14. Move the microscope stage to the first location you want to analyze on the sample.

15. Click Add Location.

The software adds the location to the Acquisition Locations box.
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16. Move the stage to the next location and click Add Location to add that point to the 
Acquisition Locations box.

17. Continue moving the stage and adding sampling locations as needed.

18. When you are finished, click Save Points File to save the locations if you want to use 
them for future acquisitions.

19. Click Start Automation to start the analysis.

The button name changes to Stop Automation.

• To pause the acquisition, click the Pause button.

To continue the acquisition, click the pause button again.

• To end the acquisition after the current point is completed and save the acquired 
data, click Stop Automation.

• To end the acquisition without saving the data, click the Abort button

The spectrum for the first sampling point is displayed in the spectrum pane.

Note  To remove a sampling location, click the row in the Acquisition Locations box 
and then click Remove Location.

Pause AbortStop
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The progress bar at the top of the Pathfinder window shows the progress of the 
acquisition.

20. Wait until the acquisitions for all selected sampling locations are completed.

The results for the first sampling point are displayed. Here is an example:

If Auto ID and Auto Quant are selected in Spectrum Processing, the found elements are 
displayed in the element setup pane (periodic table) and the quant results are displayed in 
the results pane.

The acquired data are listed in the file list pane (one spectral (.emsa) file for each analyzed 
location).

21. To save the data set in the current project, click the Save button  on the main 
toolbar, or choose File (menu) > Save.

Found elements (green or pink) Quant results Acquired data (one .emsa file 
for each analyzed location)

Spectrum from the first analyzed location

Note  If Auto Quant is selected in Quant Setup on the Spectrum Processing tab, the 
quantitative results are automatically saved to a CSV (Comma Separated Values, .csv) file.
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Save and Load Selected Locations

After you have located and entered a series of sampling location so they are listed in the 
Acquisition Locations box on the Analysis Automation tab, you can save the settings so they 
are available for repeated use.

 To save a series of sampling locations

1. On the Analysis Automation tab, add the sampling locations for automated analysis by 
moving the stage to each location and clicking the Add Location button.

2. Click Save Points File.

3. In the Save Points File box, select a folder, enter a filename and click Save.

The file is saved with an .apf (Automation Points File) filename extension.

 To load a saved sampling series

1. On the Analysis Automation tab, click Load Points File.

2. Navigate to the project and folder that contains your saved .apf (Automation Points File), 
select the file and click Open.
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The file’s contents are displayed in the Acquisition Locations box on the Analysis 
Automation tab.

If you want to use some locations and not others, use the check boxes (see the previous 
image) to select which points to sample.

If you want to remove a sampling location from the list, click its associated row in the 
table so the row is highlighted and then click Remove Location.

If you want to move the stage to a location to verify the settings, select (highlight) the row 
and click Go To Location.

Analyze a Grid at Each Location

If you need to investigate a large region of the sample, use the Grid (rectangular) or Circular 
option for Acquisition Type to acquire a series of spectra. You can elect to have the software 
define a grid of adjacent areas based the current microscope field of view, or to define the grid 
manually by specifying the number of X and Y fields to include.

 To acquire and analyze a grid using analysis automation

1. Click the Spectrum  button on the analytical mode toolbar and set up your spectral 
analysis.

2. On the Analysis Automation tab, set Acquisition Type to Grid or Circular.
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The following message is displayed for the Grid (rectangular) acquisition type:

3. Move the stage to the upper left-hand corner of the region you want to sample, focus the 
image by adjusting the stage Z-axis, and choose OK.

The next message is displayed:

4. Move the stage to the lower right-hand corner of the region you want to sample, focus the 
image and choose OK.

A third message is displayed:
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5. Move the stage to a third location inside the region you want to sample (in approximately 
the upper-right or lower-left corner) and focus the image.

This position allows the software to calculate a 3-dimensional plane that defines the stage 
Z-axis position for each point in the grid.

6. When you are finished, click OK.

The first grid location is displayed in the Acquisition Locations box.

7. Continue to define additional sampling grids as needed.

Here is an example:

8. When you are finished, click Start Automation to start the analysis.

Depending on the number of sampled areas included, a series of files are created for each 
defined grid. For example, the following files are created for a 4x2 grid:

Basename[Grid@0 0].emsa
Basename[Grid@0 1].emsa
Basename[Grid@1 0].emsa
Basename[Grid@1 1].emsa

Note  

• To remove a sampling location, click the row in the Acquisition Locations box 
and then click Remove Location.

• You can edit the grid settings (including the magnification and anchor point 
locations) by selecting its associated row in the Acquisition Locations box and 
choosing Edit Location.
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Basename[Grid@2 0].emsa
Basename[Grid@2 1].emsa
Basename[Grid@3 0].emsa
Basename[Grid@3 1].emsa

To monitor the acquisition, click the green arrow to open the advanced view.

The grid changes color as each new area is completed.

The spectrum in each file is acquired by rastering the beam over the field of view of the 
SEM at each point in the grid. If the SEM is set to focus the electron beam to a point or 
spot on the sample, then the EDS spectrum at each grid point will come from the point 
defined in each field of view.

Note  The circular grid works the same way but uses round areas and is ideal for round 
samples such as a circular filter paper. The first two specified locations define the diameter 
of the circular region. The third location marks the Z movement to keep the image in 
focus over the defined region. The software skips the empty corners.
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Clear a Grid List

To clear the list of grid locations, right-click anywhere in the Acquisition Locations box on the 
Analysis Automation tab and choose Clear All.

Grid Settings for Analysis Automation

You can edit the grid location settings and then redo a grid by selecting its associated row in 
the Acquisition Locations box and choosing Edit Location.
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The Edit Positions box is displayed.

The following Grid options are available in the Edit Positions box.

Table 4. Grid Settings for Analysis Automation

Feature Description

Number Grid number displayed in the Acquisition Locations box on 
the Analysis Automation tab and used in the filename for the 
acquired data

Label Label displayed in the Acquisition Locations box on the 
Analysis Automation tab and used in the filename for the 
acquired data

Magnification Shows the magnification used for the selected grid. You can 
enter a magnification value or set the microscope to the 
desired magnification and click Update to read the new 
setting.
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Frame Layouts Specifies how the grid is divided up. Available options:

• Adjacent. The software defines a grid of adjacent areas 
based on the magnification of the microscope field of 
view.

– Overlap%. Specifies the amount of overlap for 
adjacent areas of the grid.

Note: We recommend using a small overlap (2-3%) of 
adjacent frames, especially if you plan to use the grid to create 
a montage.

• User Grid. Allows you to enter the number of sampling 
areas to include along the X and Y-axes of the grid. The 
software divides the grid equally into the specified number 
of fields based on the magnification of the microscope 
field of view.

Note: You may have unsampled areas in your defined region 
when using the Adjacent setting but not for the User Grid 
setting if you include enough fields to completely cover the 
defined region. 

Position table Shows the current locations of the two anchor points used to 
define the grid, and the location used to define the focus (Z 
Correct). Available options:

• Add or change a point (+). Allows you to change the 
selected anchor point or redo all three anchor points.

To change an anchor point, move the stage to the new 
location (or click Move Stage To Point and adjust from 
there), select the anchor point you want to change and 
click the + button.

To add an anchor point, first delete all three anchor points 
and then add them in this order: upper-left corner, 
lower-right corner, upper-right or lower-left corner (for 
focus position).

• Remove Point (—). Removes the selected anchor point 
from the Position table.

• Return To Stage Point (–>). Moves the microscope stage 
to the anchor point selected in the Position table.

Table 4. Grid Settings for Analysis Automation

Feature Description
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Analysis Automation with Other Analytical Modes
Analysis Automation can be used in these analytical modes:

• Spectrum

• Point ID

• Linescan

• Spectral Imaging

• Electron Imaging

• Feature Sizing

See the previous sections for details on how to use Analysis Automation in Spectrum mode. 
This section explains additional considerations for Analysis Automation when use with the 
remaining analytical modes.

Analysis Automation in Point ID Mode

When Point ID mode is selected, the only Acquisition Type available on the Analysis 
Automation tab is Selected Area (no grid options). This is because Point ID is based on 
user-defined points or areas at each sampling location.

The automated Point ID analysis is similar to automated analysis in Spectrum mode except 
you need to acquire an electron image at each sampling location and add acquisition points or 
areas to the image before you add the location to the Acquisition Locations box on the 
Analysis Automation tab.

 To acquire and analyze a series of sampling locations in Point ID mode

1. Click the Point ID  button on the analytical mode toolbar.

2. Set up the microscope as you would for a Point ID analysis.

3. Enter an experiment name.

4. Move the microscope stage to the desired location on the sample.

Accept Saves your edits

Cancel Closes the box without saving your edits

Table 4. Grid Settings for Analysis Automation

Feature Description
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5. Acquire an electron image.

- Select an image acquisition preset on the acquisitions toolbar.

- Click Get Image to acquire the image.

6. Select a spectral acquisition preset on the acquisitions toolbar.

7. Select the Spectrum Processing tab on the controls panel and set up any qualitative or 
quantitative analysis for the acquired data.

For qualitative analysis, click Ident Setup and make sure Auto ID is selected; for 
quantitative analysis, click Quant Setup and make sure Auto Quant is selected.

8. Use these Image toolbar settings to set up batch acquisitions:

Set Cursor Shape to 
Point or an area option

Turn off (deselect) Instant Acquisition Mode

Turn off 
Intensity Cursor

Select Acquisition 
Cursor

Turn off Selection Cursor
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9. Use the mouse to add acquisition points or areas to the electron image.

10. Click the Analysis Automation button on the acquisitions toolbar.

11. Enter a Sequence Name (appended to the experiment name to identify each microscope 
location analyzed with Analysis Automation).

12. Specify any advanced automation settings.

- Click the green arrow to show the advanced settings:

- If you want the software to save the magnification settings with each sampling location, 
select Use Saved Mag.

- If you want the software to turn off the electron beam after the automated analysis is 
completed, select Beam Off.
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13. Click Add Location.

If you see a message similar to the following, click Proceed.

The software adds the location to the Acquisition Locations box.

14. Move the stage to the next location, acquire a new electron image, add your acquisition 
points or areas to the image and click Add Location.

15. Continue moving the stage and adding sampling locations as needed.

16. Click Start Automation to start the analysis.

If Auto ID and Auto Quant are selected in Spectrum Processing, the found elements are 
displayed in the element setup pane (periodic table) and the quant results are displayed in 
the results pane.

The acquired data are listed in the file list pane (one Point ID file for each analyzed 
location). Here is an example:

Note  To remove a sampling location, click the row in the Acquisition Locations box 
and then click Remove Location.
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17. To save the data set in the current project, click the Save button  on the main 
toolbar, or choose File (menu) > Save.

Analysis Automation in Linescan Mode

When Linescan mode is selected, there are two Acquisition Type options on the Analysis 
Automation tab: 

• Linescan Image. Similar to automated analysis in Point ID mode in that it is based on an 
electron image acquired at each sampling location. The main difference is that you draw a 
line scan on the image where you want to acquire data before you add the location to the 
Acquisition Locations box on the analysis Automation tab.

• Linescan Stage. Allows you to acquire a continuous line scan over a large area of the 
sample by defining two anchor points and automating the stage movement and 
acquisitions between them.

Run an Automated Linescan Image Analysis

The automated Linescan Image analysis is similar to automated analysis in Point ID mode in 
that it is based on an electron image acquired at each sampling location. The main difference 
is that you draw a line scan on the image where you want to acquire data instead of selecting 
points or areas.

To set up the analysis, set Acquisition Type in Analysis Automation settings to 
Linescan (Image) and follow the steps for Analysis Automation in Point ID mode with the 
exception of drawing a line scan on each acquired image instead of points or areas. The 
acquired data have the same filename extension as data acquired in normal Linescan mode, 
except the Analysis Automation Sequence Name is appended to the experiment name. One 
file is produced for each analyzed location. Here is an example:

Note  If Auto Quant is selected in Quant Setup on the Spectrum Processing tab, the 
quantitative results are automatically saved to a CSV (Comma Separated Values) file 
with a .csv filename extension.

Note  

• The sample composition is assumed to be known. If the sample elements are 
unknown, start with a spectral analysis (Spectrum mode) or spectral imaging analysis 
(Spectral Imaging mode) to determine the sample composition before proceeding 
with any type of line scan analysis. Before you start the line scan analysis, set the 
known elements to Always Identified in the element setup pane (periodic table). See 
Linescan Mode for more information.

• The speed of the microscope stage is the primary factor that determines the length of 
time needed to acquire a large line scan.
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Auto Example[Point@1].lsctl
Auto Example[Point@2].lsctl

Run an Automated Linescan Stage Analysis

The automated Linescan Stage analysis allows you to acquire a continuous line scan over a 
large area of a sample by defining two anchor points and automating the stage movement and 
acquisitions between them. The software uses a wizard to step you through setting up this 
analysis.

The wizard allows you to specify a step size between sampling points or a total number of 
points to sample, as well as the acquisition time in seconds at each sampling point. Each point 
can be one spectrum acquired in the center of the electron beam or an averaged spectrum 
representing the entire field of view. For example, if you select center point sampling with a 
10 mm step size for a set of anchor points that are 1 mm apart, the sampling points will be 
0.01 mm apart with a total of 11 points sampled (includes the anchor points). See Analysis 
Automation Linescan Settings for details.

 To set up and run an automated Linescan stage analysis

1. Set up the Linescan analysis including spectral acquisition, Linescan Processing and 
Spectrum Processing.

If you are using Auto ID, make sure the known elements are set to Always Identified in 
the element setup pane (periodic table). 

2. Click the Analysis Automation button on the acquisitions toolbar.

3. Set Acquisition Type to Linescan (Stage) (see the previous image).

4. Click Add Location and follow the wizard to define the line scan.

Note  If Auto Quant is selected in Quant Setup on the Spectrum Processing tab, the 
quantitative results are automatically saved to a CSV (Comma Separated Values, .csv) file. 
If you save the 

Note  There is no need to manually acquire an electron image or draw a linescan in 
this analysis mode. The software performs these steps automatically.
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The software adds the location to the Acquisition Locations box.

5. Continue adding line scans as needed.

6. Click Start Automation to start the analysis.

If Auto ID and Auto Quant are selected in Spectrum Processing and the known elements 
are set as Always Identified in the element setup pane (periodic table), the quant results 
are displayed in the results pane.

The acquired data have the same filename extension as data acquired in normal Linescan 
mode, except the Analysis Automation Sequence Name is appended to the experiment 
name. One file is produced for each analyzed location. Here is an example:

Auto Example[Point@1].lsctl
Auto Example[Point@2].lsctl

The acquired data are listed in the file list pane (one Linescan file for each analyzed 
location). Here is an example:

Note  

• To remove a sampling location, click the row in the Acquisition Locations box 
and then click Remove Location.

• You can edit the wizard settings (including beam control, stage control, 
acquisition time, magnification and anchor point locations) and then redo a line 
scan by selecting its associated row in the Acquisition Locations box and choosing 
Edit Location.
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7. To save the data set in the current project, click the Save button  on the main 
toolbar, or choose File (menu) > Save.

Linescan (Stage) Settings for Analysis Automation

You can edit the settings and then redo a line scan by selecting its associated row in the 
Acquisition Locations box and choosing Edit Location.

The Edit Positions box is displayed.

Note  If Auto Quant is selected in Quant Setup on the Spectrum Processing tab, the 
quantitative results are automatically saved to a CSV (Comma Separated Values) file 
with a .csv filename extension.
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The following options are available in the Edit Positions box.

Table 5. Grid Settings for Analysis Automation

Feature Description

Number Line scan number displayed in the Acquisition Locations box 
on the Analysis Automation tab and used in the filename for 
the acquired data

Label Label displayed in the Acquisition Locations box on the 
Analysis Automation tab and used in the filename for the 
acquired data

Magnification Shows the magnification used for the selected line scan. You 
can enter a magnification value or set the microscope to the 
desired magnification and click Update to read the new 
setting.

Beam Control Specifies how each location is sampled. Available options:

• Microscope Raster. Acquires spectra over the entire field 
of view and produces an average spectrum for each 
specified location.

• Center Point. Acquires a spectrum in the center of the 
field of view for each specified location.

Stage Control Specifies where each location is sampled. Available options:

• Step Size. Distance in mm between each sampling point 
(center point to center point). The software determines 
the number of points sampled based on the distance 
between the specified anchor points and the beam 
diameter.

• Number of Points. You specify the number of sampling 
points to include between the specified anchor points.

Note: If you specify the number of points to sample, consider 
the distance between the anchor points and the beam diameter 
to avoid duplicate sampling.

Acquisition Time Length of time in seconds to acquire data at each sampling 
location. An acquisition time of 1 second is typical.
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Analysis Automation in Spectral Imaging Mode

To use Analysis Automation in Spectral Imaging Mode, you specify the points or areas to be 
sampled and the acquisition and analysis settings, including spectral processing and map 
processing.

When Spectral Imaging mode is selected, all three Acquisition Type options are available on 
the Analysis Automation tab:

• Selected area. You specify the locations to acquire a spectral image by moving the 
microscope stage and clicking the Add Location button.

• Grid. You specify a rectangular sampling area for each stage location and how the area is 
divided up and measured.

• Circular. You specify a circular sampling area and how the area is divided up and 
measured.

Position table Shows the current locations of the two anchor points used to 
define the line scan (focus and magnification settings are saved 
with both anchor points). Available options:

• Add or change a point (+). Allows you to change the 
selected anchor point or redo both anchor points.

To change an anchor point, move the stage to the new 
location (or click Move Stage To Point and adjust from 
there), select the anchor point you want to change and 
click the + button.

To add an anchor point, first delete both anchor points 
and then add them in this order: beginning of line scan, 
end of line scan (both positions should be in focus).

• Remove Point (—). Removes the selected anchor point 
from the Position table.

• Return To Stage Point (–>). Moves the microscope stage 
to the anchor point selected in the Position table.

Accept Saves your edits

Cancel Closes the box without saving your edits

Table 5. Grid Settings for Analysis Automation

Feature Description
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 To acquire and analyze a series of sampling locations in Spectral Imaging mode

1. Click the Spectral Imaging  button on the analytical mode toolbar and set up 
your analysis.

This includes experiment name, electron image acquisition, spectral image (map) 
acquisition, Spectrum Processing and Map Processing (Counts, Quant or COMPASS, 
with or without phases).

2. On the Analysis Automation tab, set Acquisition Type to Selected Area, Grid or Circular.

3. Move the microscope stage to the first location you want to analyze on the sample.

4. If you selected the Selected Area option in step 2 above, acquire an electron image and use 
the extraction cursor on the image pane toolbar to specify the points or areas to be 
analyzed. Then click Add Location on the Analysis Automation tab to add those points to 
the Acquisition Locations box.

If you selected the Grid (rectangular) or Circular option, click Add Location and follow 
the steps in the wizard to define anchor points (boundaries) for the rectangle or circle you 
want to sample. For more information, see To acquire and analyze a grid using analysis 
automation.

5. Move the stage to the next location and repeat step 4 to add the new point, area or grid to 
the Acquisition Locations box.

6. Continue moving the stage and adding sampling locations as needed.

7. Click Start Automation and wait until the automated acquisitions are completed.

If Auto ID and Auto Quant are selected in Spectrum Processing, the found elements are 
displayed in the element setup pane (periodic table) and the quant results are displayed in 
the results pane. The quant maps are displayed in the maps pane.

Note  There is no need to manually acquire an electron image when Acquisition Type 
is set to Grid or Circular. The software performs this step automatically. For details on 
using the grid options for Analysis Automation, see To acquire and analyze a grid 
using analysis automation.

Note  To remove a sampling location, click the row in the Acquisition Locations box 
and then click Remove Location.
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The acquired data are listed in the file list pane (one Spectral Imaging (.eds) file for each 
analyzed location). Here is an example:

For selected area:

Auto Example[Point@1].MAP.EDS

For grid and circular:

Auto Example[Grid@X Y ].MAP.EDS

8. To save the data set in the current project, click the Save button  on the main 
toolbar, or choose File (menu) > Save.

Create a Montage From Analysis Automation Data
You can use Analysis Automation to create a montage of electron images, X-ray images, 
COMPASS maps or phase maps by stitching together images acquired as adjacent fields in a 
grid automation sequence.

Create Montage of Electron Images

 To create a montage of adjacent electron images

1. From the Pathfinder Home screen, choose View (menu) > Electron Imaging Mode.

2. In the Analysis Automation settings, set Acquisition Type to Grid.

3. Click Add Location and follow the steps in the wizard to define anchor points for the 
grid. For more information, see To acquire and analyze a grid using analysis automation.

Note  If Auto Quant is selected in Quant Setup on the Spectrum Processing tab, the 
quantitative results are automatically saved to a CSV (Comma Separated Values) file 
with a .csv filename extension.
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4. Select the grid by clicking its associated row in the Acquisition Locations table and then 
click Edit Location.

5. In the Edit Positions box, set Frame Layouts to Adjacent and enter a small overlap (3% is 
a good start) and click Accept.

6. Click Start Automation and wait until the automated acquisitions are completed.

7. From the Home screen, choose Batch Processing (menu) > Create Montage.



 9 Analysis Automation
Create a Montage From Analysis Automation Data

Thermo Scientific Pathfinder User Guide 303

8. In the Create Montage box, select your grid file in the Select Files to Process box (make 
sure its associated check box is selected).

9. Set Data Type to Process Counts (see the previous image).

10. Click the —> button to create the montage (see the previous image).

The two rate bars at the bottom of the Create Montage window indicate the progress and 
the montage image appears in the image box.



9 Analysis Automation
Create a Montage From Analysis Automation Data

304 Pathfinder User Guide Thermo Scientific

11. To save the montage in the current project, click the Save button  on the main 
toolbar, or choose File (menu) > Save.

A montage consists of a .map file and a .tif for each element map and electron image. The 
map file is named:

BaseName[Grid,montage].map

Here is an example of how the elemental map TIFF files are named:

BaseName[Grid,Montage]_Al_K_map.tif

Corresponding electron images are either

BaseName[Grid,Montage]_Grey_map.tif
or
BaseName[Grid,Montage]_RefGrey.tif

Create Montage of X-ray Maps

The steps to create a montage of X-ray maps are similar to creating a montage of electron 
images. You can use this technique to create a montage of X-ray count maps, X-ray quant 
maps, COMPASS components or phases. Start by creating a grid file in Analysis Automation. 
Then create the montage.

 To create a montage of X-ray maps

1. Click the Spectral Imaging button on the analytical toolbar.

2. Set up your spectral analysis, including acquiring the electron image and spectrum 
processing, and map processing.

Depending on the kind of montage you want to create, on the Map Processing tab, set 
Map Type To Display to Counts, Quant, COMPASS or Phases and set any associated 
parameters as needed.

3. In the Analysis Automation settings, set Acquisition Type to Grid.

4. Click Add Location and follow the steps in the wizard to define anchor points for the 
grid. For more information, see To acquire and analyze a grid using analysis automation.

Note  Keep in mind that grid files acquired in Spectral Imaging mode can be large. Each 
grid file is a complete spectral imaging (.eds) file.



 9 Analysis Automation
Create a Montage From Analysis Automation Data

Thermo Scientific Pathfinder User Guide 305

5. Select the grid by clicking its associated row in the Acquisition Locations table and then 
click Edit Location.

6. In the Edit Positions box, set Frame Layouts to Adjacent and enter a small overlap (3% is 
a good start) and click Accept.

7. Click Start Automation and wait until the automated acquisitions are completed.

8. Choose Batch Processing (menu) > Create Montage.

9. In the Create Montage box, select your grid file in the Select Files to Process box (make 
sure its associated check box is selected).

10. Depending on the kind of montage you want to create, set Data Type to Process Counts, 
Process Quant or Process COMPASS.

11. If you want to create a montage of phase maps (Data Type must be set to COMPASS), 
select Create Phases.
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12. Click the —> button to create the montage.

The two rate bars at the bottom of the Create Montage window indicate the progress. 
The spectral imaging files are processed first and then added to the montage, which 
slowly appears in the image box as the montage is created.

13. To save the montage in the current project, click the Save button  on the main 
toolbar, or choose File (menu) > Save.

Figure 14. Montage created from a 7x2 grid of X-ray count maps and the electron image
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Figure 15. Montage created from a grid of X-ray quant maps

Troubleshoot Analysis Automation

Minimize Montage Edge Mismatch

To minimize any mismatch at the edges of the images in a montage, double-check the 
following:

• Make sure the X axis of the microscope scan is aligned with the X-axis of the stage. Use 
the microscope’s scan rotation to align these movements together. This can be done by 
putting a feature at the top of the scan and moving the stage back and forth until the 
feature remains at the same Y position as the stage is moved. Adjust the scan rotation if 
this is not the case.

• Make sure the Pathfinder X and Y scan are calibrated correctly for the selected 
magnification. If the pixel size and squareness of the pixels are incorrect, the amount of 
stage motion associated with the scans field width will be incorrect. Make sure the stage 
backlash correction has been set up properly (must be done by a qualified service 
engineer). Also, try increasing or decreasing the overlap percentage setting in the grid 
location settings on the Analysis Automation tab.



9 Analysis Automation
Troubleshoot Analysis Automation

308 Pathfinder User Guide Thermo Scientific

Figure 16. Individual Grid Images

Figure 17. 2x2 Montage Properly Aligned
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Problems with Point Registration for Point ID or Linescan Data

If you experience a problem with point registration when using Point ID or Linescan mode 
with Analysis Automation, one of the following may be the cause:

• The stage is not correcting for backlash. Make sure the stage supports backlash correction. 
If it does, consult the stage manufacturer to ensure backlash correct is set up properly. If 
the stage does not support backlash correction, contact our Technical Support for 
information about enabling backlash correction in the Pathfinder automation routines.

• Backlash was not corrected properly before acquiring the reference image and indexing 
the points. Index the stage location in the points table, tell the software to return to the 
previously defined stage position, acquire an image, set the desired location, and update 
the previously set locations.

Note  If you combine Point ID or Linescan with Analysis Automation and Drift 
compensation, make sure Drift Compensation is enabled (set to Drift On) before you 
acquire the reference image at each stage location. You cannot mix stage locations that use 
drift compensation with stage locations that do not.
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10

Drift Compensation

In an electron microscope, the image can shift during an acquisition, especially when using 
high magnifications. Drift can be caused by slight movement of the microscope stage or 
electronic drift in the lens and is dependent upon your microscope configuration. Depending 
on the severity, drift can significantly affect the integrity of the data and the accuracy of your 
results (qualitative and quantitative). Our optional Drift Compensation software uses precise 
hardware beam control to monitor image position over time and immediately correct any drift 
that occurs during an acquisition.

There are two Drift Compensation operating modes:

• Simple. The area used to track image drift is the same as the area being analyzed.

• Rect Drift. You define a rectangular area for image tracking, which is typically in a 
different location than the feature you want to analyze. This enhances drift compensation 
when the sampling location has low contrast. (The user can select an area with higher 
contrast to monitor and compensate for any drift.)

Drift Compensation can be used in the following analytical modes and works similarly in all 
of them:

• Point ID

• Spectral Imaging

• Linescan
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Set Up Drift Compensation

Set Up Simple Drift Compensation

Simple drift compensation uses the same area to track image drift as the area being measured.

 To set up simple drift compensation in Point ID, Spectral Imaging or Linescan mode

1. Click the Drift Compensation icon on the acquisitions toolbar and select Drift On.

The icon changes from an “open lock” (drift off ) to a “closed lock” to indicate that simple 
drift compensation is enabled.

2. Click the Electron Image Setup  button on the acquisitions toolbar (see the previous 
image) and adjust the image acquisition settings and drift compensation settings as 
needed.

3. Click Get Image to acquire an electron image.

Image tracking starts immediately with a new electron image acquired after the specified 
interval. See Acquire Data Using Simple Drift Compensation for more information.

4. Click the Experiment Setup  button and adjust the mapping, line scan or spectral 
acquisition settings as needed.

5. Click Start Map (Spectral Imaging mode), Start Spectrum (Point ID mode) or Start 
Linescan (Linescan mode) to begin the spectral (or spectral imaging) acquisition.
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Set Up Rectangular Drift Compensation

Rectangular Drift compensation uses a user-defined (rectangular) area for image tracking, 
which is typically in a different location than the feature you want to analyze. This enhances 
drift compensation when the sampling location is featureless or has low contrast.

 To set up rectangular drift compensation

1. Click the Drift Compensation icon on the acquisitions toolbar and select Rect Drift On.

The icon turns green to indicate that Rect Drift is enabled.

2. Click the Electron Image Setup  button on the acquisitions toolbar (see the previous 
image) and adjust the drift compensation settings and the other electron image 
acquisition settings as needed.

3. Click Get Image on the acquisitions toolbar.

The drift compensation icon changes to red and the Set Image button is displayed.
Click to exit Rect Drift setup mode
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The software acquires an electron image and displays it in the image pane along with two 
rectangles (yellow and red).

4. Drag the red rectangle to the area you want to analyze; drag the yellow rectangle to the 
area you want to use for image tracking.

It is important to select an area that includes unique features and some contrast for image 
tracking. Here is an example:
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5. Click Set Image on the acquisitions toolbar.

Image tracking starts immediately with a new electron image acquired after the specified 
interval. See Acquire Data Using Rect Drift Compensation for more information.

6. Click the Experiment Setup  button and adjust the mapping, line scan or spectral 
acquisition settings as needed.

7. Click Start Map (Spectral Imaging mode), Start Spectrum (Point ID mode) or Start 
Linescan (Linescan mode) to begin the spectral (or spectral imaging) acquisition.

Drift Compensation Settings

To adjust the drift compensation settings, click the Electron Image Setup  button on the 
acquisitions toolbar and then click the green arrow to show the advanced view.

The settings that affect drift compensation are described below.

Note  Keep in mind that the boundaries for image tracking are defined by the 
boundaries of your current field of view. If your system has significant drift, position 
the yellow rectangle as close as possible to the center of the image. To increase the 
boundaries, increase the Zoom Factor setting in Electron Image Setup. However, keep 
in mind that this automatically decreases the maximum resolution that can be used in 
the analysis area. See Zoom Factor for more information.

Setting Description

Compensation Interval Determines how often the software should check the position of 
the electron image and correct for any movement.

Available options:

• Automatic with min time of ___ seconds. The software 
acquires the electron image used for drift compensation each 
time the minimum time is exceeded. If the software 
determines that the image is drifting at a faster or slower 
pace than the entered value, it adjusts the interval based on 
the actual drift rate to achieve a maximum of one pixel 
change per correction.
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Acquire Data Using Simple Drift Compensation
Simple drift compensation uses the same area to track image drift as the area being measured. 
To turn on simple drift compensation, click the Drift Compensation icon on the 
acquisitions toolbar and select Drift On.

• Manual with fixed time of ___ seconds. The user specifies 
how often to acquire the electron image used for drift 
compensation.

• Current mapping resolution gives a minimum Map and 
SI interval of ___ seconds. Reports the minimum time 
required to complete a Spectral Imaging acquisition based 
on the current settings for Resolution and Frame Time in 
Spectral Image Setup and the specified drift compensation 
interval (see above). For example, if Compensation Interval 
is 60 seconds and Frame Time is 5 seconds, the calculated 
interval is 69 seconds for one drift check. (Due to the 
complexity of the operation, the calculations for drift 
compensation require a few seconds to complete.)

Note: In Spectral Imaging mode, the software can perform image 
correction only at the end of a frame. The entered minimum 
(automatic) or fixed (manual) value should always be higher than 
the reported “minimum Map and SI interval.” (The software 
defaults to the reported minimum.) To compensate at a faster 
rate, decrease total frame time by decreasing the Resolution or 
Frame Time setting in Spectral Image Setup.

Zoom Factor Defines the boundaries of the area used to track image shift by 
adjusting the magnification. The zoom factor ranges from 2 to 8 
in powers of 2. Use a higher zoom factor setting if your system 
has a lot of drift. The higher the zoom factor, the larger the area 
used for drift compensation and the lower the resolution used for 
the sample data. For example, when Zoom Factor is 1, the 
maximum resolution setting available for the sample data is 
4096. In the same way, when Zoom Factor is 2, 4, or 8, the 
maximum sample resolution is 2048, 1024 or 512 respectively.

Setting Description
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When Simple drift compensation is used, the software periodically acquires a new electron 
image and measures how far it has shifted from the original one. If the image has shifted at 
least one pixel, the software immediately uses beam control to correct it.

In Spectral Imaging mode, a concurrent gray level image is used for the simple drift correction 
if that option is selected in Spectral Image Setup. If the Concurrent Image option is not used, 
the Compensation Interval setting in Electron Image Setup determines when the drift 
correction is applied, as it does in Point ID and Linescan mode. When the Compensation 
Interval setting is used to trigger image tracking, the software pauses spectral acquisition while 
it acquires a new image and corrects for any shift that has occurred. Then spectral acquisition 
resumes. The frequency of image tracking affects the overall acquisition time.

The Zoom Factor setting in Electron Image Setup defines the boundaries of the area used to 
track image shift by adjusting the magnification. In the default configuration (Zoom Factor is 
set to 4), the image can drift off the screen at the top, bottom, left, or right and still be 
tracked. When the hardware reaches a boundary, drift compensation stops and the software 
displays a message that it can no longer correct for drift. To increase the boundaries, use a 
higher Zoom Factor setting.

The drift compensation status bar at the top of the Pathfinder Home screen indicates the 
amount of space remaining for drift correction. Here is an example:

Figure 18. Drift Compensation Status Bar Showing Available Space Remaining

Acquire Data Using Rectangular Drift Compensation
Rectangular drift compensation uses a user-defined (rectangular) area to track image drift, 
which is typically in a different location than the measured feature or area. This enhances drift 
compensation when the sampling location has low contrast. (The user can select an area with 
higher contrast to monitor and compensate for any drift.)

Total space available for image tracking

Solid bar shows 
amount of space used

Yellow area causes 
caution message

Red area causes 
warning message
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To enable rectangular drift compensation, click the Drift Compensation icon on the 
acquisitions toolbar and select Rect Drift On, then acquire an electron image and select the 
areas used for image tracking and sample analysis. See Set Up Rectangular Drift 
Compensation for step-by-step instructions.

Rect Drift compensation works the same as simple drift compensation except it does not use 
the gray level image in Spectral Imaging mode, even when the Concurrent Image option is 
selected in Spectral Image Setup.

Turn Off Drift Compensation
To turn off drift compensation (simple or rectangular), click the Drift Compensation icon on 
the acquisitions toolbar and select Drift Off.

Drift Compensation Diagnostics
The software provides diagnostic information for drift compensation to help you monitor its 
activity during sample acquisitions. The Drift Diagnostics display information about drift 
compensation, such as the amount the electron image has drifted over time, how much space 
is available for image tracking, and how the most recently acquired correction image compares 
with the original one.

Note  Do not use Rect Drift Compensation with Analysis Automation.

Note  If you combine Point ID or Linescan with Analysis Automation and Drift 
compensation, make sure Drift Compensation is enabled (set to Drift On) before you 
acquire the electron image at each stage location. You cannot mix stage locations that use 
drift compensation with stage locations that do not.
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 To view drift diagnostics

1. From the Pathfinder Home screen, choose View (menu) > Drift Diagnostics.

The Drift Diagnostics window is displayed.

Figure 19. Drift Diagnostics Window

The six labeled sections are explained below:

• Reference Image. Original (gray) electron image used for sample acquisition and 
analysis.

• Current Image. Most recently acquired (red) electron image used for image tracking.

• Reference + Current Image. Most recently acquired tracking (red) image overlaid on the 
original (gray) image. When drift compensation is working properly, there should be very 
little difference between the two images at any time.

• Correction Space. Provides a detailed history of every correction since drift 
compensation was enabled. It shows the time of each image tracking measurement, the 
movement that occurred along the X or Y-axis in m, and the correlation value. The 
correlation value indicates how well the current tracking image matches the reference 
(original) image, where 1.0 is a perfect match. If the two images are totally different, the 
reported correlation coefficient is 0.0 and Drift Compensation stops running.
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• Drift Data. Demonstrates how the image has moved over time. If the image has not 
moved, a white + appears in the center of the pane. If the image moves one or two pixels 
in any direction, the plus sign is extended with a small arrow indicating the direction of 
movement. Here is an example:

Figure 20. Drift Data Showing Movement Along the X- and Y-Axis

Drift Data also shows the remaining hardware space available for image tracking. For 
example, when the path reaches any edge, image tracking stops and the software displays a 
message that it can no longer correct for drift. To increase the boundaries, increase the 
Zoom Factor setting in Electron Image Setup and restart the analysis.

• Correlation Image. Shows the correlation between the current tracking image and the 
reference (original) image. When the two images are aligned perfectly, the brightest spot is 
in the center of the correlation image with no shift. Here is an example:

Figure 21. Correlation Image Showing Two Perfectly Aligned Images (brightest point is dead 
center)
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If the image shifts by one pixel to the right, the brightest pixel in the correlation image 
will be one pixel to the right of the center pixel. Here is an example:

Figure 22. Correlation Image Showing Movement Along the X-axis (brightest point has 
shifted right)
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